LICENSE AGREEMENT

LICENSOR: Chemstations Inc.
2901 Wilcrest Drive, Suite 305
Houston, Texas 77042
U.S.A.

ACCEPTANCE OF TERMS OF AGREEMENT BY THE USER

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS PACKAGE. USING THIS PACKAGE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS.

The enclosed proprietary encoded materials hereinafter referred to as the Licensed Program(s), are the property of Chemstations Inc. and are provided to you under the terms and conditions of this License Agreement. Included with some Chemstations Inc. Licensed Programs are copyrighted materials owned by the Microsoft Corporation, Rainbow Technologies Inc., and InstallShield Software Corporation. Where such materials are included, they are licensed by Microsoft Corporation, Rainbow Technologies Inc., and InstallShield Software Corporation to you under this License Agreement. You assume responsibility for the selection of the appropriate Licensed Program(s) to achieve the intended results, and for the installation, use and results obtained from the selected Licensed Program(s).

LICENSE GRANT

In return for the payment of the license fee associated with the acquisition of the Licensed Program(s) from Chemstations Inc., Chemstations Inc. hereby grants you the following non-exclusive rights with regard to the Licensed Program(s):

Use of the Licensed Program(s) on more than one machine. Under no circumstance is the Licensed Program to be executed without either a Chemstations Inc. dongle (hardware key) or system authorization code.

You agree to reproduce and include the copyright notice as it appears on the Licensed Program(s) on any copy, modification or merged portion of the Licensed Program(s).

THIS LICENSE DOES NOT CONVEY ANY RIGHT TO USE, COPY, MODIFY OR TRANSFER THE LICENSED PROGRAM(S) OR ANY COPY, MODIFICATION OR MERGED PORTION THEREOF, IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS LICENSE AGREEMENT.

TERM

This License Agreement is effective upon acceptance and use of the Licensed Program(s) until terminated in accordance with the terms of this License Agreement. You may terminate the License Agreement at any time by destroying the Licensed Program(s) together with all copies, modifications, and merged portions thereof in any form. This License Agreement will also terminate upon conditions set forth elsewhere in this Agreement or automatically in the event you fail to comply with any term or condition of this License Agreement. You hereby agree upon such termination to destroy the Licensed Program(s) together with all copies, modifications and merged portions thereof in any form.
LIMITED WARRANTY

The Licensed Program(s), i.e. the tangible proprietary software, is provided "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, AND EXPLICITLY EXCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. The entire risk as to the quality and performance of the Licensed Program(s) is with you.

Some jurisdictions do not allow the exclusion of limited warranties, and, in those jurisdictions the above exclusions may not apply. This Limited Warranty gives you specific legal rights, and you may also have other rights which vary from one jurisdiction to another.

Chemstations Inc. does not warrant that the functions contained in the Licensed Program(s) will meet your requirements or that the operation of the program will be uninterrupted or error free.

Chemstations Inc. does warrant, however, that the diskette(s), i.e. the tangible physical medium on which the Licensed Program(s) is furnished, to be free from defects in materials and workmanship under normal use for a period of ninety (90) days from the date of delivery to you as evidenced by a copy of your receipt.

Chemstations Inc. warrants that any program errors will be fixed by Chemstations Inc., at Chemstations' expense, as soon as possible after the problem is reported and verified. However, only those customers current on their update/maintenance contracts are eligible to receive the corrected version of the program.

ENTIRE AGREEMENT

This written Agreement constitutes the entire agreement between the parties concerning the Licensed Program(s). No agent, distributor, salesman or other person acting or representing themselves to act on behalf of Chemstations Inc. has the authority to modify or supplement the limited warranty contained herein, nor any of the other specific provisions of this Agreement, and no such modifications or supplements shall be effective unless agreed to in writing by an officer of Chemstations Inc. having authority to act on behalf of Chemstations Inc. in this regard.

LIMITATIONS OF REMEDIES

Chemstations' entire liability and your exclusive remedy shall be:

   a) The replacement of any diskette not meeting Chemstations' "Limited Warranty" as defined herein and which is returned to Chemstations Inc. or an authorized Chemstations dealer with copy of your receipt, or

   b) If Chemstations Inc. or the dealer is unable to deliver a replacement diskette which is free of defects in materials or workmanship, you may terminate this License Agreement by returning the Licensed Program(s) and associated documentation and you will be refunded all monies paid to Chemstations Inc. to acquire the Licensed Program(s).

IN NO EVENT WILL CHEMSTATIONS INC. BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, AND OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED PROGRAM(S) EVEN IF CHEMSTATIONS INC. OR AN AUTHORIZED CHEMSTATIONS DEALER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.

SOME JURISDICTIONS DO NOT PERMIT LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL AND CONSEQUENTIAL DAMAGES SO THAT THE ABOVE LIMITATION AND EXCLUSION MAY NOT APPLY IN THOSE JURISDICTIONS.
GENERAL

The initial license fee includes one (1) year of support, maintenance, and enhancements to the program. After the first one (1) year term, such updates and support are optional at the then current update fee.

Questions concerning this License Agreement and all notices required herein shall be made by contacting Chemstations Inc. in writing at Chemstations Inc., 2901 Wilcrest, Suite 305, Houston, Texas, 77042, by telephone, 713-978-7700, or by Fax, 713-978-7727.

DISCLAIMER: CC-STEADY STATE, CC-BATCH, CC-DYNAMICS, CC-THERM, CC-FLASH, CC-SAFETY NET, CC-LANPS

Copyright(c) Chemstations Inc., 2004, all rights reserved.

This proprietary software is the property of Chemstations, Inc. and is provided to the user pursuant to a Chemstations Inc. program license agreement containing restrictions on its use. It may not be copied or distributed in any form or medium, disclosed to third parties, or used in any manner except as expressly permitted by the Chemstations Inc. program license agreement.

THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED. NEITHER CHEMSTATIONS INC. NOR ITS AUTHORIZED REPRESENTATIVES SHALL HAVE ANY LIABILITY TO THE USER IN EXCESS OF THE TOTAL AMOUNT PAID TO CHEMSTATIONS INC. UNDER THE CHEMSTATIONS INC. PROGRAM LICENSE AGREEMENT FOR THIS SOFTWARE. IN NO EVENT WILL CHEMSTATIONS INC. BE LIABLE TO THE USER FOR ANY LOST PROFITS OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF USE OR INABILITY TO USE THE SOFTWARE EVEN IF CHEMSTATIONS INC. HAS BEEN ADVISED AS TO THE POSSIBILITY OF SUCH DAMAGES. IT IS THE USERS RESPONSIBILITY TO VERIFY THE RESULTS OF THE PROGRAM.
# CC-STEADY STATE VERSION 5.4

## TABLE OF CONTENTS

Getting Started CHEMCAD Suite .................................................................1
How to Install CHEMCAD for Windows .......................................................1
  The CHEMCAD Package ........................................................................1
  Basic Requirements .............................................................................2
  Installing CHEMCAD for Windows .......................................................2
  Licensing Issues ..................................................................................7
  Reprogramming the Dongle .................................................................7
Using This Manual with CHEMCAD .........................................................8
How to Use the Mouse .............................................................................9
How to Use the Keyboard in CHEMCAD .................................................9
Using Dialog Boxes ................................................................................10
  Moving Around the Dialog Box ............................................................10
  Making Choice Box Selections ............................................................10
  Making List Box Selections .................................................................10
  Character Fields in Dialog Boxes .......................................................11
  Closing a Dialog Box ..........................................................................11
  Exiting a Dialog Box Without Saving Its Contents ............................11
Selecting Objects ..................................................................................11
  Selecting Streams and UnitOps for Plotting, Viewing, and Sizing .........11
  Selecting More Than One Object at a Time .........................................12
Using Word and WordPad Documents Created by CHEMCAD .............12
An Overview of the Most Important CHEMCAD Windows ......................14
  The Top Level Window ......................................................................14
  The Simulation Flowsheet Window ....................................................15
  The Plot Window ...............................................................................18
Using the Tool Bar Buttons ....................................................................19
How to Print in CHEMCAD .................................................................21
How to Print Tabular Output .................................................................21
  Briefly ..............................................................................................21
  Details .............................................................................................21
How to Print Graphical Outputs and Displays .......................................22
  Briefly ..............................................................................................22
  Details .............................................................................................22
File Management in CHEMCAD ..........................................................23
  The CHEMCAD File Types ..............................................................23
  Where Files are Stored ......................................................................24
  Importing Jobs .................................................................................24
  Exporting Jobs ................................................................................25
  Save as Case ....................................................................................25
Using Help .........................................................................................25
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Description of the Problem</td>
<td>30</td>
</tr>
<tr>
<td>The Tool Bar Buttons</td>
<td>29</td>
</tr>
<tr>
<td>Using the Keyboard</td>
<td>29</td>
</tr>
<tr>
<td>How to Use Mouse</td>
<td>29</td>
</tr>
<tr>
<td>Basic Rules – General</td>
<td>28</td>
</tr>
<tr>
<td>Introduction</td>
<td>28</td>
</tr>
<tr>
<td>CC-STEADY STATE TUTORIAL</td>
<td>28</td>
</tr>
<tr>
<td>Getting Started</td>
<td>30</td>
</tr>
<tr>
<td>Starting a New Job – The Simulation Window</td>
<td>32</td>
</tr>
<tr>
<td>Selecting Engineering Units</td>
<td>34</td>
</tr>
<tr>
<td>Drawing the Flowsheet</td>
<td>35</td>
</tr>
<tr>
<td>Putting Streams on the Flowsheet</td>
<td>42</td>
</tr>
<tr>
<td>Selecting Components</td>
<td>44</td>
</tr>
<tr>
<td>Selecting Thermodynamic Options</td>
<td>47</td>
</tr>
<tr>
<td>Defining the Feed Streams</td>
<td>49</td>
</tr>
<tr>
<td>Inputting Equipment Parameters</td>
<td>50</td>
</tr>
<tr>
<td>Specifying the First Heat Exchanger</td>
<td>50</td>
</tr>
<tr>
<td>Specifying the Second Heat Exchanger</td>
<td>51</td>
</tr>
<tr>
<td>Specifying the Flash Drum</td>
<td>52</td>
</tr>
<tr>
<td>Specifying the Valve</td>
<td>52</td>
</tr>
<tr>
<td>Specifying the Stabilizer Tower</td>
<td>52</td>
</tr>
<tr>
<td>Running the Simulation</td>
<td>54</td>
</tr>
<tr>
<td>Reviewing the Results Interactively</td>
<td>54</td>
</tr>
<tr>
<td>Checking the Cricondentherm Dewpoint</td>
<td>54</td>
</tr>
<tr>
<td>Checking the Bottoms Stream Purity</td>
<td>57</td>
</tr>
<tr>
<td>Re-Running the Simulation</td>
<td>58</td>
</tr>
<tr>
<td>Producing a Report</td>
<td>59</td>
</tr>
<tr>
<td>Generating the Process Flow Diagram</td>
<td>63</td>
</tr>
<tr>
<td>Creating a Stream Databox</td>
<td>64</td>
</tr>
<tr>
<td>Placing Text on the PFD</td>
<td>66</td>
</tr>
<tr>
<td>Summary</td>
<td>67</td>
</tr>
<tr>
<td>CC-BATCH TUTORIAL</td>
<td>68</td>
</tr>
<tr>
<td>Introduction</td>
<td>68</td>
</tr>
<tr>
<td>Basic Rules – General</td>
<td>68</td>
</tr>
<tr>
<td>How to Use Mouse</td>
<td>68</td>
</tr>
<tr>
<td>Using the Keyboard</td>
<td>69</td>
</tr>
<tr>
<td>The Tool Bar Buttons</td>
<td>70</td>
</tr>
<tr>
<td>A Description of the Problem</td>
<td>70</td>
</tr>
</tbody>
</table>
Getting Started ..................................................................................................................... 116
How to Start a New Job ........................................................................................................ .............116
Getting Started  .............................................................................................................. .......114
Coach   .....................................................................................................................11 3
Step 10:  Producing Reports and PFD's...................................................................................113
Step 9:  Reviewing the Results................................................................................................ .112
Step 8:  Running the Simulation ............................................................................................... 112
Step 7:  Specifying Unit Operations..........................................................................................111
Step 5:  Selecting Thermodynamic Options .............................................................................110
Step 4:  Selecting Components................................................................................................109
Step 3:  Creating a Flowsheet ................................................................................................. .108
Step 2:  Selecting Engineering Units ........................................................................................108
Setting Up a Steady State Simulation – An Overview............................................................................. 107
CHEMCAD USER’S GUIDE...................................................................................................................107
Summary  .....................................................................................................................1 06
Generating a Full Report ...................................................................................................... ...............105
Reviewing Batch Results ....................................................................................................... ..............105
Plotting the Results .......................................................................................................... ...........102
Reviewing the Results Interactively ........................................................................................................102
Running the Simulation ........................................................................................................ .............100
Runtime Information ........................................................................................................... ........99
Operating Step 5 ............................................................................................................. ..........98
Operating Step 4 ............................................................................................................. ..........98
Operating Step 3 ............................................................................................................. ..........96
Operating Step 2 ............................................................................................................. ..........95
Operating Step 1 ............................................................................................................. ..........91
Defining the Operating Steps................................................................................................... .................91
Specifying the Column Configuration............................................................................................ ............90
Copy Operation Step Specifications...........................................................................................88
Set Screen Information Specifications........................................................................................87
Operation Parameters Specification.........................................................................................86
Batch Column Specifications................................................................................................85
Pot Charge Definition .........................................................................................................87
Inputting Equipment Parameters ..............................................................................................87
Defining the Operating Steps...................................................................................................87
Specifying the Pot Charge Composition and Condition .........................................................88
Specifying the Column Configuration........................................................................................90
Defining the Operating Steps...................................................................................................91
Reviewing the Results Interactively ........................................................................................................102
Plotting the Results .......................................................................................................... ...........102
Generating a Full Report ...................................................................................................... ...............105
Summary  .....................................................................................................................1 06

CHEMCAD USER’S GUIDE...................................................................................................................107
Setting Up a Steady State Simulation – An Overview.................................................................107
Step 1:  Starting a New Job.......................................................................................................108
Step 2:  Selecting Engineering Units .........................................................................................108
Step 3:  Creating a Flowsheet ..................................................................................................108
Step 4:  Selecting Components ...............................................................................................109
Step 5:  Selecting Thermodynamic Options .............................................................................110
Step 6:  Inputting Feed (and Cut) Stream Data .........................................................................111
Step 7:  Specifying Unit Operations .........................................................................................111
Step 8:  Running the Simulation .............................................................................................112
Step 9:  Reviewing the Results ..............................................................................................112
Step 10:  Producing Reports and PFD’s ..................................................................................113
Coach   .....................................................................................................................11 3
Getting Started ...................................................................................................................114
How to Start a New Job..........................................................................................................116
Briefly  ..........................................................................................................................116
<table>
<thead>
<tr>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to Select Flowsheet Engineering Units</td>
<td>117</td>
</tr>
<tr>
<td>Resetting Current Units to a Predefined Profile</td>
<td>118</td>
</tr>
<tr>
<td>Edit Current Engineering Units Profile</td>
<td>119</td>
</tr>
<tr>
<td>Create a Default Engineering Units Profile</td>
<td>119</td>
</tr>
<tr>
<td>Create a User Engineering Units Profile</td>
<td>120</td>
</tr>
<tr>
<td>Graphics Commands – An Overview</td>
<td>120</td>
</tr>
<tr>
<td>Drawing Flowsheets in the Edit Flowsheet Mode</td>
<td>120</td>
</tr>
<tr>
<td>Graphics Features of the Plot Window</td>
<td>121</td>
</tr>
<tr>
<td>Using the PFD Window</td>
<td>121</td>
</tr>
<tr>
<td>The Edit Flowsheet Mode</td>
<td>122</td>
</tr>
<tr>
<td>The Main Palette</td>
<td>122</td>
</tr>
<tr>
<td>Sub-Palettes</td>
<td>124</td>
</tr>
<tr>
<td>The Size and Shape of the Palette</td>
<td>125</td>
</tr>
<tr>
<td>Hiding and Calling the Palette</td>
<td>125</td>
</tr>
<tr>
<td>Moving the Palettes</td>
<td>126</td>
</tr>
<tr>
<td>Drawing With the Palette</td>
<td>126</td>
</tr>
<tr>
<td>Drawing Lines</td>
<td>126</td>
</tr>
<tr>
<td>Drawing Rectangles</td>
<td>126</td>
</tr>
<tr>
<td>Drawing Ellipses</td>
<td>127</td>
</tr>
<tr>
<td>Drawing Polylines</td>
<td>127</td>
</tr>
<tr>
<td>Drawing Polygons</td>
<td>127</td>
</tr>
<tr>
<td>Text</td>
<td>128</td>
</tr>
<tr>
<td>How to Put Text on a Drawing</td>
<td>128</td>
</tr>
<tr>
<td>The Format Command</td>
<td>128</td>
</tr>
<tr>
<td>Bring to Front</td>
<td>129</td>
</tr>
<tr>
<td>Send to Back</td>
<td>129</td>
</tr>
<tr>
<td>Fill Pattern</td>
<td>130</td>
</tr>
<tr>
<td>Pen Style</td>
<td>130</td>
</tr>
<tr>
<td>Arrowheads</td>
<td>130</td>
</tr>
<tr>
<td>Color</td>
<td>130</td>
</tr>
<tr>
<td>Font</td>
<td>131</td>
</tr>
<tr>
<td>Align</td>
<td>131</td>
</tr>
<tr>
<td>Import Bitmap</td>
<td>131</td>
</tr>
<tr>
<td>How to Rotate an Object Using the Palette</td>
<td>132</td>
</tr>
<tr>
<td>How to Move, Modify, Delete, or Flip Objects</td>
<td>132</td>
</tr>
<tr>
<td>Moving a Single Object</td>
<td>132</td>
</tr>
<tr>
<td>Moving Multiple Objects</td>
<td>132</td>
</tr>
<tr>
<td>Panning the Flowsheet</td>
<td>133</td>
</tr>
<tr>
<td>Resizing</td>
<td>133</td>
</tr>
<tr>
<td>Deleting</td>
<td>133</td>
</tr>
<tr>
<td>Flipping an Object’s Y-Axis</td>
<td>133</td>
</tr>
<tr>
<td>How to Copy to the Clipboard</td>
<td>133</td>
</tr>
<tr>
<td>Using the Metafile</td>
<td>133</td>
</tr>
<tr>
<td>Using the Copy Command</td>
<td>134</td>
</tr>
<tr>
<td>How to Generate a DXF File</td>
<td>134</td>
</tr>
</tbody>
</table>

iv
How to Draw a Flowsheet ........................................................................................................134
  Step 1: Enter the Edit Flowsheet Mode ..................................................................................134
  Step 2: Place Unitops on the Flowsheet ..............................................................................136
  Step 3: Connecting Unitops with Streams ..........................................................................137
  Step 4: Modifying and Adding to the Flowsheet .................................................................138
How to Add Unitops to the Flowsheet ..................................................................................138
  Briefly ...............................................................................................................................139
  Details ...............................................................................................................................139
Drawing Streams ..................................................................................................................140
  Drawing Simple Streams (One or Less Direction Change) ..............................................141
  Drawing Complex Streams (Multiple Direction Changes) ..................................................141
How to Select Components for the Component List ..............................................................141
Calling the Component List Dialog Box ............................................................................142
Using the Component List Dialog Box ..............................................................................142
  Briefly ...............................................................................................................................143
  Details ...............................................................................................................................143
How to Select K-Value Options ............................................................................................144
  Briefly ...............................................................................................................................145
  Details ...............................................................................................................................145
How to Select Enthalpy Options ..........................................................................................146
  Briefly ...............................................................................................................................146
  Details ...............................................................................................................................147
How to Define the Feed Streams ..........................................................................................148
  Briefly ...............................................................................................................................148
  Details ...............................................................................................................................149
How to Specify Unit Operations ...........................................................................................152
  Calling a Unitop Dialog Box ..............................................................................................152
  Rules for Completing the Unitop Dialog Boxes .................................................................152
  Degrees of Freedom and Unitop Dialog Boxes .................................................................152
How to Run Simulations in CHEMCAD Suite ......................................................................153
  Running Steady State Simulations ....................................................................................153
How to Review Stream Compositions ..................................................................................155
  Selecting Streams ............................................................................................................155
How to Set Flow Units for Results and Reports ..................................................................156
How to View Stream Properties Using the Results Command .............................................157
  Using the Properties Option Dialog Box .........................................................................157
How to Plot ...........................................................................................................................157
  Plot Menu Options .........................................................................................................158
How to Create Reports ........................................................................................................176
  Calculate and Give Results .............................................................................................177
  Report Formats .................................................................................................................177
  Select Streams ................................................................................................................178
  Select Stream Properties .................................................................................................180
  Stream Flowrate/Composition .........................................................................................181
  Distillation Summaries .....................................................................................................181
  Heating Curves .................................................................................................................182
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch/Dynamic Results</td>
<td>182</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>183</td>
</tr>
<tr>
<td>End Report</td>
<td>183</td>
</tr>
<tr>
<td>How to Create PFD’s</td>
<td>184</td>
</tr>
<tr>
<td>Creating the Main PFD</td>
<td>184</td>
</tr>
<tr>
<td>Creating Secondary PFD’s</td>
<td>185</td>
</tr>
<tr>
<td>Opening and Editing Secondary PFD’s</td>
<td>185</td>
</tr>
<tr>
<td>Adding a Stream Databox to the PFD</td>
<td>186</td>
</tr>
<tr>
<td>Step 1: Select the Streams to be Included in the Databox</td>
<td>187</td>
</tr>
<tr>
<td>Step 2: Complete the PFD Properties Options Dialog Box</td>
<td>187</td>
</tr>
<tr>
<td>Step 3: Complete the Databox Settings Dialog Box</td>
<td>189</td>
</tr>
<tr>
<td>Step 4: Move and Stretch the Databox</td>
<td>189</td>
</tr>
<tr>
<td>Adding a Unitop Databox to a PFD</td>
<td>189</td>
</tr>
<tr>
<td>Step 1: Select the Unitops for Databox Generation</td>
<td>190</td>
</tr>
<tr>
<td>Step 2: Complete the Databox Settings Dialog Box</td>
<td>190</td>
</tr>
<tr>
<td>Step 3: Move and Stretch the Databox</td>
<td>190</td>
</tr>
<tr>
<td>Adding a TP Box to a PFD</td>
<td>191</td>
</tr>
<tr>
<td>Select the Options to be Displayed</td>
<td>192</td>
</tr>
<tr>
<td>Select Streams from Flowsheet</td>
<td>193</td>
</tr>
<tr>
<td>Move the TP Boxes as Desired</td>
<td>193</td>
</tr>
<tr>
<td>Running a Dynamics Simulation</td>
<td>193</td>
</tr>
<tr>
<td>The Steps for Setting Up a Dynamic Flowsheet</td>
<td>193</td>
</tr>
<tr>
<td>Starting a New Job</td>
<td>194</td>
</tr>
<tr>
<td>Selecting Engineering Units</td>
<td>194</td>
</tr>
<tr>
<td>Draw the Flowsheet</td>
<td>194</td>
</tr>
<tr>
<td>Make Sure the Dynamics Mode is Turned On</td>
<td>195</td>
</tr>
<tr>
<td>Select Components</td>
<td>196</td>
</tr>
<tr>
<td>Select Thermodynamic Options</td>
<td>196</td>
</tr>
<tr>
<td>Specify Feed Streams and Stream Initial Conditions</td>
<td>196</td>
</tr>
<tr>
<td>Specifying UnitOps</td>
<td>196</td>
</tr>
<tr>
<td>Specifying Runtimes, Time Steps, and/or Stop Criteria</td>
<td>196</td>
</tr>
<tr>
<td>Running the Dynamic Simulation</td>
<td>197</td>
</tr>
<tr>
<td>Re-Running and Extending the Run</td>
<td>200</td>
</tr>
<tr>
<td>How to Run a Sensitivity Analysis</td>
<td>201</td>
</tr>
<tr>
<td>Completing the Independent Variable Dialog Box</td>
<td>203</td>
</tr>
<tr>
<td>Completing the Dependent Variable Dialog Box</td>
<td>204</td>
</tr>
<tr>
<td>Using Optimization in CHEMCAD</td>
<td>204</td>
</tr>
<tr>
<td>How to Build User Added Symbols and Icons</td>
<td>209</td>
</tr>
<tr>
<td>Symbol Builder Palette</td>
<td>210</td>
</tr>
<tr>
<td>Procedure for Building and Saving Unitop Icons</td>
<td>211</td>
</tr>
<tr>
<td>User Added Palette Names</td>
<td>213</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

Getting Started CHEMCAD Suite ................................................................. 1
How to Install CHEMCAD for Windows ................................................... 1
  The CHEMCAD Package ........................................................................ 1
  Basic Requirements .............................................................................. 2
  Installing CHEMCAD for Windows ...................................................... 2
  Licensing Issues ..................................................................................... 7
  Reprogramming the Dongle ................................................................. 7
Using This Manual with CHEMCAD .......................................................... 8
How to Use the Mouse ............................................................................. 9
How to Use the Keyboard in CHEMCAD ................................................ 9
Using Dialog Boxes .................................................................................. 10
  Moving Around the Dialog Box ........................................................... 10
  Making Choice Box Selections ............................................................. 10
  Making List Box Selections ................................................................. 10
  Character Fields in Dialog Boxes ........................................................ 11
  Clos ing a Dialog Box .......................................................................... 11
Selecting Objects ...................................................................................... 11
  Selecting Streams and UnitOps for Plotting, Viewing, and Sizing .......... 11
  Selecting More Than One Object at a Time .......................................... 12
Using Word and WordPad Documents Created by CHEMCAD ................. 12
An Overview of the Most Important CHEMCAD Windows ....................... 14
  The Top Level Window ...................................................................... 14
  The Simulation Flowsheet Window ...................................................... 15
  The Plot Window ................................................................................ 18
Using the Tool Bar Buttons ....................................................................... 19
How to Print in CHEMCAD ...................................................................... 21
How to Print Tabular Output ..................................................................... 21
  Briefly ................................................................................................. 21
  Details ............................................................................................... 21
How to Print Graphical Outputs and Displays ........................................ 22
  Briefly ................................................................................................. 22
  Details ............................................................................................... 22
File Management in CHEMCAD .............................................................. 23
  The CHEMCAD File Types ................................................................ 23
  Where Files are Stored ....................................................................... 24
Importing Jobs ......................................................................................... 24
Exporting Jobs ......................................................................................... 25
Save as Case ............................................................................................ 25
Using Help ............................................................................................... 25
Getting Started ..................................................................................................................... 71
Starting A New Job – The Simulate Flowsheet Window................................................................. 73
Selecting Engineering Units ....................................................................................................... 75
Drawing the Flowsheet .............................................................................................................. 76
Putting Streams on the Flowsheet ............................................................................................. 80
Selecting Components ............................................................................................................. 82
Selecting Thermodynamic Options .......................................................................................... 85
Defining the Feed Streams ....................................................................................................... 87
Inputting Equipment Parameters .............................................................................................. 87
   Pot Charge Definition .......................................................................................................... 87
   Batch Column Specifications ............................................................................................... 87
   Operation Parameters Specification .................................................................................... 87
   Set Screen Information Specifications ................................................................................ 87
   Copy Operation Step Specifications .................................................................................... 88
Specifying the Pot Charge Composition and Condition ............................................................ 88
Specifying the Column Configuration ....................................................................................... 90
Defining the Operating Steps .................................................................................................... 91
   Operating Step 1 .................................................................................................................. 91
   Operating Step 2 .................................................................................................................. 95
   Operating Step 3 .................................................................................................................. 96
   Operating Step 4 .................................................................................................................. 98
   Operating Step 5 .................................................................................................................. 98
   Runtime Information .......................................................................................................... 99
Running the Simulation ............................................................................................................ 100
Reviewing the Results Interactively .......................................................................................... 102
Plotting the Results .................................................................................................................. 102
Reviewing Batch Results ......................................................................................................... 105
Generating a Full Report .......................................................................................................... 105
Summary ................................................................................................................................... 106

CHEMCAD USER’S GUIDE..................................................................................................... 107
Setting Up a Steady State Simulation – An Overview................................................................. 107
   Step 1: Starting a New Job ................................................................................................. 108
   Step 2: Selecting Engineering Units .................................................................................. 108
   Step 3: Creating a Flowsheet ............................................................................................ 108
   Step 4: Selecting Components ........................................................................................ 109
   Step 5: Selecting Thermodynamic Options ...................................................................... 110
   Step 6: Inputting Feed (and Cut) Stream Data ................................................................. 111
   Step 7: Specifying Unit Operations .................................................................................. 111
   Step 8: Running the Simulation ....................................................................................... 112
   Step 9: Reviewing the Results ......................................................................................... 112
   Step 10: Producing Reports and PFD’s ........................................................................... 113
Coach ..................................................................................................................................... 113
Getting Started ....................................................................................................................... 114
How to Start a New Job .......................................................................................................... 116
Briefly ..................................................................................................................................... 116
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch/Dynamic Results</td>
<td>182</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>183</td>
</tr>
<tr>
<td>End Report</td>
<td>183</td>
</tr>
<tr>
<td>How to Create PFD’s</td>
<td>184</td>
</tr>
<tr>
<td>Creating the Main PFD</td>
<td>184</td>
</tr>
<tr>
<td>Creating Secondary PFD’s</td>
<td>185</td>
</tr>
<tr>
<td>Opening and Editing Secondary PFD’s</td>
<td>185</td>
</tr>
<tr>
<td>Adding a Stream Databox to the PFD</td>
<td>186</td>
</tr>
<tr>
<td>Step 1: Select the Streams to be Included in the Databox</td>
<td>187</td>
</tr>
<tr>
<td>Step 2: Complete the PFD Properties Options Dialog Box</td>
<td>187</td>
</tr>
<tr>
<td>Step 3: Complete the Databox Settings Dialog Box</td>
<td>189</td>
</tr>
<tr>
<td>Step 4: Move and Stretch the Databox</td>
<td>189</td>
</tr>
<tr>
<td>Adding a Unitop Databox to a PFD</td>
<td>189</td>
</tr>
<tr>
<td>Step 1: Select the Unitops for Databox Generation</td>
<td>190</td>
</tr>
<tr>
<td>Step 2: Complete the Databox Settings Dialog Box</td>
<td>190</td>
</tr>
<tr>
<td>Step 3: Move and Stretch the Databox</td>
<td>190</td>
</tr>
<tr>
<td>Adding a TP Box to a PFD</td>
<td>191</td>
</tr>
<tr>
<td>Select the Options to be Displayed</td>
<td>192</td>
</tr>
<tr>
<td>Select Streams from Flowsheet</td>
<td>193</td>
</tr>
<tr>
<td>Move the TP Boxes as Desired</td>
<td>193</td>
</tr>
<tr>
<td>Running a Dynamics Simulation</td>
<td>193</td>
</tr>
<tr>
<td>The Steps for Setting Up a Dynamic Flowsheet</td>
<td>193</td>
</tr>
<tr>
<td>Starting a New Job</td>
<td>194</td>
</tr>
<tr>
<td>Selecting Engineering Units</td>
<td>194</td>
</tr>
<tr>
<td>Draw the Flowsheet</td>
<td>194</td>
</tr>
<tr>
<td>Make Sure the Dynamics Mode is Turned On</td>
<td>195</td>
</tr>
<tr>
<td>Select Components</td>
<td>196</td>
</tr>
<tr>
<td>Select Thermodynamic Options</td>
<td>196</td>
</tr>
<tr>
<td>Specify Feed Streams and Stream Initial Conditions</td>
<td>196</td>
</tr>
<tr>
<td>Specifying UnitOps</td>
<td>196</td>
</tr>
<tr>
<td>Specifying Runtimes, Time Steps, and/or Stop Criteria</td>
<td>196</td>
</tr>
<tr>
<td>Running the Dynamic Simulation</td>
<td>197</td>
</tr>
<tr>
<td>Re-Running and Extending the Run</td>
<td>200</td>
</tr>
<tr>
<td>How to Run a Sensitivity Analysis</td>
<td>201</td>
</tr>
<tr>
<td>Completing the Independent Variable Dialog Box</td>
<td>203</td>
</tr>
<tr>
<td>Completing the Dependent Variable Dialog Box</td>
<td>204</td>
</tr>
<tr>
<td>Using Optimization in CHEMCAD</td>
<td>204</td>
</tr>
<tr>
<td>How to Build User Added Symbols and Icons</td>
<td>209</td>
</tr>
<tr>
<td>Symbol Builder Palette</td>
<td>210</td>
</tr>
<tr>
<td>Procedure for Building and Saving Unitop Icons</td>
<td>211</td>
</tr>
<tr>
<td>User Added Palette Names</td>
<td>213</td>
</tr>
</tbody>
</table>
The **Menu Bar** contains the commands for displaying menus that provide the user with access to specific functions. These commands are:

- **File**  
  For printer page setup, opening jobs, and job management.

- **License**  
  For license configuration, dongle updates and special license authorization.

- **View**  
  For toggling the tool bar and the status bar on and off.

- **Help**  
  For using the on-line help system.

---

**THE SIMULATE FLOWSHEET WINDOW…**

The **Simulate Flowsheet Window** is where a user creates, specifies, runs, and reviews a process flowsheet. It is, therefore, where users spend most of their time. When you enter the **Simulate Flowsheet Window by creating a new job**, your screen will look something like this:
This screen is organized similar to the Top Level screen described earlier, however, the active area is now "active", (available to draw flowsheets), and a graphics palette has been added.

When you open an existing job, your screen will look something like this:

Notice that in the latter case, not only is a flowsheet present but the graphics palette is not present. This is because the Simulate Flowsheet Window has two modes: the graphics mode and the simulation mode. When you start a new job or flowsheet, CHEMCAD automatically starts you in Edit Flowsheet (graphics) mode, which is only for drawing/editing flowsheets. When you open an existing job, CHEMCAD automatically puts you in simulation mode, which is for specifying and running flowsheet simulations. The window organization for both modes is the same, but some of the available commands are different.
The top line, called the **Title Bar**, now contains the CHEMCAD logo, the current version number, and the current job name, as well as, the *minimize*, *title*, and *close* buttons which are always present on the left side.

The **Menu Bar** follows the **Title Bar** as usual, but now there are fourteen commands in addition to the **Help** command. These commands are:

- **File**: For file management and print control.
- **View**: For switching the toolbar, status bar, and palette on and off. Also enables the user to make grid and palette settings.
- **Format**: For selecting engineering units and making graphics formatting specifications.
- **Run Simulation/ Edit Flowsheet**: For switching between graphics and simulation mode.
- **ThermoPhysical**: For selecting components, making K-value, enthalpy and transport property method selections, editing the databank, specifying solids and editing BIPs.
- **Specifications**: For entering, editing, and manipulating stream and unit operations input data. This may also be done by double clicking the stream or **UnitOp** on the flowsheet directly.
- **Run**: For running the simulation and sensitivity studies, as well as for defining numerical controls.
- **Results**: For viewing calculated results.
- **Plot**: For displaying calculated results graphically.
- **Output**: For preparing reports and Process Flow Diagrams (PFD’s).
- **Sizing**: For performing rating and sizing calculations for various types of equipment.
- **Tools**: For performing various activities associated with simulation. These include data regression, CO₂ – solids and hydrates prediction, TOD/COD calculations, and others.
- **Window**: For arranging windows and icons display.
- **Help**: For invoking the CHEMCAD **Help** and/or **Coach** system.

The **Menu Bar** is followed by the **Tool Bar**. The toolbar functions are explained in a later section of this manual.
Below the **Main Tool Bar** is the **Active Area**. Notice that this area is accompanied by elevator bars for scrolling the active area display up and down, and left and right.

If you are in **Edit Flowsheet** (graphics) mode, the **Active Area** will contain the **Main Palette**. The **Main Palette** provides the primary tools for drawing the flowsheet. Its use is described in detail in later sections of this Users Guide.

The bottom line of the current display is the **Help line** previously described.

**THE PLOT WINDOW**

CHEMCAD allows the user to create a wide range of plots. When a plot is created, CHEMCAD displays it inside a **Plot Window**. The purpose of the **Plot Window** is to enable the user to embellish and/or edit the plot before it is printed or filed. A **Plot Window** looks something like the window shown below. Obviously the type and content of the plot varies with each situation, but the window is the same.

This window is similar to other graphics windows in CHEMCAD, and has the following commands available:

- **File** For printing, and opening and closing other jobs.
- **Edit** Contains the Undo, Cut, Copy and Paste commands. Cut, copy and paste to the clipboard.
- **View** To toggle the Tool bar and Status bar on and off.
- **Graph** To edit the plot display (text, color, pattern, etc.) and/or export the plot data to Excel.
- **Window** For managing the various open windows.
- **Help** To provide access to the graphics help system.
Each plot automatically contains a program generated Title and Legend. The title is located at the top of the plot and the legend is located at the bottom. Each may be edited using the Chart Explorer. Selecting the Edit option on the Graph Menu accesses the Chart Explorer.

**USING THE TOOL BAR BUTTONS**

A brief description of the function and operation of each toolbar button of the Simulate Flowsheet Window follows the button graphic:

- **New Flowsheet** button: Opens a window to begin a new flowsheet.
- **Open Flowsheet** button: Opens an existing flowsheet within the existing working directory.
- **Save Flowsheet** button: Saves the currently open flowsheet to the currently specified jobname.
- **Cut** button: Removes selected portions of the flowsheet and copies them to the clipboard.
- **Copy** button: Copies selected portions of the flowsheet to the clipboard.
- **Paste** button: Pastes portions of a flowsheet or symbol from the clipboard.
- **Print** button: Prints (or plots) the current display or output.
- **Zoom percentage** button: Selects the percentage to be used when zooming in and out.
- **Zoom In** button: Zooms in a specified percentage on the center of the flowsheet.
- **Zoom Out** button: Zooms out a specified percentage from the center of the flowsheet.
- **Zoom to fit** button: Zooms out to view the entire flowsheet.
- **Zoom in at a point** button: Zooms in a specified percentage on a user specified point of the flowsheet.
- **Zoom out at a point** button: Zooms out a specified percentage on a user specified point of the flowsheet.
- **Zoom rectangle** button: Zooms in on an area of the flowsheet indicated by a user drawn rectangle.
- **Pan overview** button: Opens and closes the Pan Overview window which enables the user to pan the entire flowsheet.
**Graphics palettes** button: Opens and closes the main palette and all open sub-palettes while the user is in the edit flowsheet mode.

**Simulation/Graphics** button: Switches back and forth between the edit flowsheet mode and the simulation mode.

**Define components** button: Clicking this button calls forth the **Component Selection** dialog box. This dialog box may be used to add, insert, or delete components from the current component list.

**K-Value options** button: Selecting this option takes you directly into the **K-value Options** dialog box. From there the user may select the K-value models and options to be used in the simulation.

**Enthalpy options** button: Selecting this option takes you directly into the **Enthalpy Options** dialog box. From there the user may select the enthalpy models and options to be used in the simulation.

**Edit feed streams** button: Clicking this button will take the user directly into the **View or Edit Streams** dialog box with the feed streams automatically selected. There the user can specify or edit the feed stream(s) compositions and thermodynamic properties, as well as, perform quick flash calculations.

**Run All** button: Clicking the **Run All** button will cause the program to simulate the entire flowsheet.

**Set run time** button: Enables the user to specify the “simulated time” and the integration time steps for a dynamic simulation.

**Reset to Initial state** button: To restore the original time zero conditions for a dynamic flowsheet.

**Run dynamic simulation** button: Start a dynamics simulation from the initial state (time zero).

**Plot dynamic streams** button: Plot results of a dynamics simulation for a specified stream.

**Plot dynamic UnitOp** button: Plot results of a dynamics simulation for a specified UnitOp.

**View all stream compositions** button: View the results of all streams in the flowsheet (for a steady state simulation).

**View all stream properties** button: View the properties of all streams in the flowsheet (for a steady state simulation).

**Component list** button: Displays a list of the components currently selected for this flowsheet.
HOW TO PRINT IN CHEMCAD

To print in CHEMCAD, the user must display the report, plot, PFD, or flowsheet that he or she wants a hardcopy of, then call the Print dialog box. Once the print parameters are accepted in this dialog box, the print will be executed.

It should be noted that CHEMCAD displays all tabular output in Wordpad (if it is generated using the Results command) or in Word (if it is generated using the Output command). As a result, to print output of this nature, you must execute the Print command from within the active Word or Wordpad window. Only graphical results or presentations are printed from within an active CHEMCAD window. Obviously, the Print and the Print Preview dialog boxes are the same in CHEMCAD as they are in Word and Wordpad.

HOW TO PRINT TABULAR OUTPUT

BRIEFLY

1. Use the Results, Output, or Plot commands to produce a tabular report. Results output is displayed in Wordpad; Output is displayed in Word; the tabular portion of Plot output is displayed in Wordpad. CHEMCAD will leave the Word or Wordpad window active.

2. Click the Word or Wordpad Print button with the mouse.

3. The Print dialog box will appear. Check and edit the current print selections (if necessary) using this dialog box. Then click [OK].

4. The report will print.

5. Close the Word or Wordpad window containing the report.

DETAILS

There are several ways to print in any Windows program. These are:

- Using the Print and Print Preview commands under the File menu.
- Using the Print button.
- Using the [CTRL + P] keys.

Method 1: Using the Print and Print Preview commands under the File menu.

The File menu contains the Print and Print Preview commands in its menu. To use these commands follow the procedure given below.

Step 1: Use the Results, Output, or Plot commands to produce a report. Results output is displayed in Wordpad; Output is displayed in Wordpad; the tabular portion of Plot output is displayed in Wordpad. CHEMCAD will leave the Word or Wordpad window active.

Step 2: Click the File menu.
Step 3: Select the **Print** option (from within Word or Wordpad) by clicking on it, or by pressing the `[P]` key. The **Print** dialog box will appear.

Step 4: Review and edit the default selections as necessary. Then click **[OK]**.

Step 5: After printing is complete, close the window containing the report.

The **Print Preview** command is selected in the same manner as the **Print** command. The **Print Preview** command is used to preview the print job on the computer monitor in a WYSIWYG (**What You See Is What You Get**) format.

Method 2: Using the **Print** button.

The **Print** button is a shortcut for selecting the **Print** command from the **File** menu.

Method 3: Using the **[CTRL + P]** keys.

**[CTRL + P]** works the same way as the **Print** button. The user presses the **[CTRL]** key and the **[P]** key simultaneously.

---

**HOW TO PRINT GRAPHICAL OUTPUTS AND DISPLAYS**

Graphic output is printed using procedures very similar to those outlined above for tabular output. The only difference is that the **Print** command is executed from within CHEMCAD itself.

**BRIEFLY**

1. Make sure that the window containing the graphical output or display that you want to print is active. If you want to print the flowsheet, the Simulation Window should be active; if you want to print a PFD, the PFD Window should be active; and if you want to print a plot, the Plot Window should be active. (Note: When the Plot command is executed, it opens one or more plot windows and it usually opens a Wordpad window containing a tabulation of the information plotted. CHEMCAD will leave the Word or Wordpad window active.)

2. Click the CHEMCAD **Print** button with the mouse.

3. The **Print** dialog box will appear. Check and edit the current print selections (if necessary) using this dialog box. Then click **[OK]**.

4. The report will print.

**DETAILS**

There are several ways to print in any Windows program. These are:

- Using the **Print** and **Print Preview** commands under the **File** menu.
- Using the **Print** button.
- Using the **[CTRL + P]** keys.
Method 1: Using the Print and Print Preview commands under the File menu.

The File menu contains the Print and Print Preview commands in its menu. To use these commands follow the procedure given below.

Step 1: Make sure that the window containing the graphical output or display that you want to print is active. If you want to print the flowsheet, the Simulation Window should be active; if you want to print a PFD, the PFD Window should be active; and if you want to print a plot, the Plot Window should be active. (Note: When the Plot command is executed, it opens one or more plot windows and it usually opens a Wordpad window containing a tabulation of the information plotted. CHEMCAD will leave the Word or Wordpad window active.)

Step 2: Click the File command on the CHEMCAD menu bar.

Step 3: Select the Print option by clicking on it, or by pressing the [P] key. The Print dialog box will appear.

Step 4: Review and edit the default selections as necessary. Then click [OK].

Step 5: After printing is complete, close the window containing the report.

Method 2: Using the Print button.

The Print button is a shortcut for selecting the Print command from the File menu.


[CTRL + P] works the same way as the Print button. The user presses the [CTRL] key and the [P] key simultaneously.

FILE MANAGEMENT IN CHEMCAD

During the course of their work, CHEMCAD users may need to create, load, copy, delete and/or rename various types of files associated with a particular job or project.

THE CHEMCAD FILE TYPES

CHEMCAD generates the following types of files:

- Job Files
- User Files (for user added components and icons)
- Output Files
- Transfer files (such as .DXF, .XLS, .DOC, .CSU, and delimited files)

CHEMCAD will read ASCII files containing certain kinds of information. These files include:

1. Engineering data – Examples include partial pressures, integral heats of solution, calorimetry data, concentration data, etc. This data is for regression or for interpolation during the simulation.
2. **Neutral file data** – Neutral file data is physical properties data which is being imported into CHEMCAD from some outside database. This is accomplished through use of a neutral file where format is described in the on-line help manual.

These files must be stored in the subdirectory of the job for which they are being used.

**WHERE FILES ARE STORED**

CHEMCAD keeps all files in three kinds of directories. These are:

1. **The CHEMCAD Directory** – This is where all program files are kept. This includes all standard program data files, such as our component library.
   a) Pool databank directory stores pool data files.

2. **CHEMCAD Work Directory** – When the CHEMCAD Suite is installed, it will create a work directory called **CC5DATA**, but users can create their own job directories if they like.

   Job directories contain all of the subdirectories for the various flowsheets or jobs. They also contain certain .UF files, which are common to all the various jobs.

3. **Job Subdirectories** – Data for each flowsheet or job is stored in a series of files as described above. All jobfiles are for a specific flowsheet or job saved in a job subdirectory bearing the jobname. These job subdirectories are located in one of the CHEMCAD job directories – normally **CC5DATA**. For install, if a user is running from the job directory **CC5DATA** and creates the job **DISTILL1**, then all files associated with **DISTILL1** will be located in the subdirectory **DISTILL1** which is located in the directory **CC5DATA** which is off the root directory.

**IMPORTING JOBS**

Importing jobs is the process of copying a job directory from some location (normally a floppy device) to the working directory.

The procedure for importing jobs is:

1. Select the **File** command from the menu bar. The **File menu** will open.

2. Click on the **Import job** option of the **File menu**.

   CHEMCAD will be expecting to import the job from drive A:, so it will look there first. If the job is on drive A:, the **Select Job for Import dialog box** will appear with drive A: as the current directory.

   If the job is not there, or if there is no floppy in drive A:, the program will issue an appropriate message and ask if the user wants to **Cancel** or **Retry**.

   Clicking **Retry** will cause the program to look to drive A: again.

   Clicking **Cancel** will open the Select Job for **Import dialog box** with the Windows Desktop as the current directory.

3. Identify the job to be imported by clicking through the directory tree until the file **<Jobname>.CCX** is displayed in the dialog box window. Then double click on **<Jobname>.CCX**. **The SaveAs dialog box** will open.

4. Identify the name and location you want for this job by:
(i) clicking through the directory tree until the destination directory is displayed in the **Save in:** field of the **SaveAs dialog box.** The default working directory will already be entered in this field, so no action may be required to complete this step.

(ii) typing the desired jobname in the **File name:** field of the **SaveAs** dialog box; then

(iii) clicking on the **Save button.**

All files associated with the imported job will be transferred to the specified location and directory.

**EXPORTING JOBS**

Exporting jobs is the process of copying a job directory from the default working directory to some other location. Exporting is similar to the process importing jobs except that the direction (and therefore the default locations) are different.

The procedure for exporting jobs is:

1. Select the **File** command from the menu bar. Click on the **Export Job** command on the **File menu.** The **Export Job** dialog box will open.

2. Click the **Find Job for copying** button. The **Select Job for Export** dialog box will open. The browser window opens to the current work directory (c:\cc5data by default).

3. Identify the job to be exported by scrolling through the browser window until the folder for the job is found.

4. Double click on the folder for the job, and then double click on the index file <jobname>.ccx. The **Select Job** dialog closes, and returns the user to the **Export Job** dialog.

5. Click the Locate Target Directory button. The **Browse for Folder** dialog box appears.

6. Select the location that the job is to be exported to using the **Browse for Folder** dialog box. When the destination folder is highlighted, click **[OK]**. The job will be copied to that folder (directory) under the same name.

**SAVE AS CASE**

The **Save As Case** command makes a copy of the current job and saves it under a new name in the current job directory. This function enables the user to keep track of separate case studies of the same basic job.

The **Save As Case** command is located on the **File menu.**

**USING HELP**

**TO FIND A TOPIC IN HELP**

1. Click the **Contents** tab to browse through topics by category.

   Click the **Index** tab to see a list of index entries: either type the word you’re looking for or scroll through the list.
Click the **Find** tab to search for words or phrases that may be contained in a Help topic.

2. If your Help file doesn’t have a Contents tab, click the **Contents** button to see a list of topics.

   **Tip:** For more information about the items on each tab, click on the dialog box, and then click the item.

To get Help in a dialog box…

1. Click on the field for which you want help, and then press the `[F1]` key.
2. To close the pop-up window, click inside it.

   **Tip:** If you want to print or copy the information in a pop-up window, use the right mouse button to click inside it, and then click **Print topic**.

   Another way to get Help on an item on the screen is to use your right mouse button to click the area you want help on, and then click the **What’ This?** command.

**TO COPY INFORMATION FROM A HELP TOPIC**

1. In the **Help topic** window, click the **Edit** menu or the **Options** button, and then click **Copy**. You can also use the right mouse button to click inside the topic or pop-up window.
2. In the document where you want the information to appear, click the place where you want to put the information.
3. On the **Edit** menu, click **Paste**.

   **Tip:** If you want to copy only part of a topic, select the part you want to copy before you click the **Copy** command.

**TO PRINT A HELP TOPIC**

1. In the **Help** topic you want to print, click the **Print** button or the **Option** button, and then click **Print Topic**. You can also use your right mouse button to click inside the **Help** window, and then click **Print Topic**.

   **Tip:** You can print a group of related topics by clicking a book in the **Help Contents** and then click **Print**.

   To print the **Help** in a pop-up window, use your right mouse button to click inside the pop-up window, and then click **Print Topic**.
TO VIEW A LIST OF TOPICS YOU’VE SEEN

1. In the Help Topic window, click Options, and then click Display History window.
2. If your Help Topic does not have a Display History window command, you cannot view the History window.

Tip: If your Help window has a Back button, you can click it to view topics you’ve seen before.

SEARCH FOR WORDS OR PHRASES

1. In Help, click the Search tab to find words or phrases in the Help topics.
2. Type the word or phrase that you wish to find in the first field.
3. The second field displays additional words to help you narrow your search.
4. The third field displays the list of topics that were found in the search.

Tip: For Help on an item, click on the field containing that item and press the [F1] key. If you decide you want different features, you can recreate the word list by clicking Rebuild.

TO CUSTOMIZE THE SEARCH FOR WORDS OR PHRASES

1. In Help, click the Find tab, and then click the Search menu’s Options command.
2. Select the search options that you prefer to use.
3. If an option is unavailable, use the Search menu’s Rebuild command.

Note: The text of each topic found contains the word(s) you looked for, even if the word(s) are not in the topic title.

Tip: If you want to look for more than one word, separate them with spaces in the first text box.
When you look for hyphenated words, be sure to type the hyphen.
To set specific search criteria, click Options.
CC-STEADY STATE TUTORIAL

INTRODUCTION

CHEMCAD is a very easy program to learn, and the best way to master it is by using it. This tutorial provides basic input skills for operating CC-STEADY STATE. The CHEMCAD input convention and rules apply to CC-STEADY STATE. Since CC-STEADY STATE is a module of CHEMCAD, the names will be used interchangeably in this tutorial. Here we provide a step-by-step description of how to solve the condensate stabilizer problem given below. The input procedure is simple and straightforward. It is designed to be intuitive for a chemical engineer familiar with the Windows environment. However, for the sake of clarity and for those new to Windows, a review of some of the basic rules for using CHEMCAD is given.

BASIC RULES – GENERAL

The following ten basic steps are used to run a flowsheet simulation in CHEMCAD.

- Starting a new job
- Selecting engineering units
- Creating a flowsheet
- Selecting components
- Selecting thermodynamics options
- Defining the feed streams
- Input equipment parameters
- Running the simulation
- Reviewing the results
- Generating hardcopy output

The steps do not have to be performed in this order nor do all of them have to be done for each flowsheet. All should be considered for each problem.

There are a series of Help facilities available throughout the program. The bottom line of the screen provides a one-sentence description of the current highlighted item. The Help command provides access to the On-line Manual which contains comprehensive technical information. The [F1] key provides context sensitive help (place the cursor in a specific field and press the [F1] key). The Coach facility will provide instructions on how to perform selected tasks. Use of these help facilities will ease your way through the program.

CHEMCAD is object oriented. Therefore, most input and editing can be done by double clicking or right clicking the object of the operation, as well as by using the menu commands.
All stream and unit operations specifications (input) are accomplished using dialog boxes. These dialog boxes are context specific and employ some combination of character fields, combo boxes, choice boxes and check boxes.

**HOW TO USE THE MOUSE**

The mouse is a very easy to use way to get the computer to do what you want. CHEMCAD, like many Windows program, requires the use of a mouse, trackball, or similar pointing device with both a primary and secondary button (i.e. a standard Microsoft 2-button mouse). The basic Mouse techniques are summarized below:

- **Click** To press and release the primary mouse button (normally the left button).
- **Right-click** To press and release the secondary mouse button (normally the right button).
- **Double-click** To press the primary button twice in rapid succession.
- **Drag** To press and hold down the primary mouse button while moving the mouse.
- **Point** To move the mouse arrow until it touches the item of choice.
- **Right-click hold** Point to a specific area, then click and hold the secondary mouse button.

**USING THE KEYBOARD**

- The [TAB] key is used to move to the next field on a data entry dialog box.
- The [PgUp] and [PgDn] keys may be used to “page” or scroll through lists.
- Holding down the [SHIFT + TAB] will cause the program to move back or up one field.
- The [F1] key is used to call context specific help.
- The [F5] key is used to display the current job’s component list from within a dialog box.
- The [F6] key is used for engineering units conversion.
- The [F7] key calls a simple calculator.

**THE TOOL BAR BUTTONS**

The “Standard” way of executing commands in CHEMCAD is to click a command on the Menu Bar and follow that command down through the subsequent menus until the desired function is reached. Thus, to
select components from the databank, one would first click the command **ThermoPhysical** on the **Simulation Menu Bar**; click the option **Component List** from the **ThermoPhysical Menu** and finally select components from the **Component Selection dialog box**.

There is a shorter way of reaching this and other frequently used functions. This is to use the **CHEMCAD Power buttons**, which are located on the tool bar. This tool bar is toggled on and off using the **View/Toolbar** command.

---

**A DESCRIPTION OF THE PROBLEM**

The problem to be solved in this tutorial is illustrated in Figure 1 below. It is a condensate stabilizer plant. Gas enters the system with the feed conditions shown. It is our job to take this existing unit and determine new operating conditions and any necessary modifications. The design requirements are as follows:

1. The cricondentherm (highest possible) dewpoint of the product gas must be **20° F** or less.
2. The stabilized condensate (Stream 9) must have maximum propane content of **1%**.

---

**Figure 1**

**Condensate Stabilizer**

- **HX-1**
  - P drop 1 = 5 psi
  - P drop 2 = 5 psi
  - Vap. Frac. (1) = 1.0

- **HX-2**
  - P drop = 5 psi
  - T out = -5° F

- **Valve**
  - P out = 125 psia

- **Stabilizer**
  - 12 stages
  - Feed stage = 1
  - Bottom draw = 30 lb-moles/hr
  - Column P drop = 5 psi

**Feed:**

- T = 75. F
- P = 200. psia
- N2 = 100.19 lb-mol/hr
- C1 = 4505.48
- C2 = 514.00
- C3 = 214.00
- IC4 = 19.20
- IC5 = 26.40
- IC6 = 14.00
- NC4 = 18.18
- NC5 = 14.00
- NC6 = 14.00

**1% propane**

**Cricondentherm dewpoint = 20 °F**

---

**GETTING STARTED**

The first time you run CHEMCAD the Top Level Window will appear on your screen. Please maximize this window (that is, zoom it to fill in the screen) by clicking the **Maximize** button in the upper right hand
corner of the CHEMCAD window. This will cause CHEMCAD to fill your screen and your display should look something like this:

The top line is called the **Title Bar**. It contains the CHEMCAD logo and name on the left side, and the WINDOWS *minimize*, *tile*, and *close buttons* on the right side.

The next line is called the **Menu Bar**. This bar contains the top-level commands for CHEMCAD. They are:

- **File**
  - This command is used to define output formats, open jobs, print, and obtain general information about CHEMCAD.

- **License**
  - This command is used to configure license, update dongles, and authorize special licenses.

- **View**
  - This command enables the user to toggle the Tool bar and Status bar on and off.

- **Help**
  - This function allows the user to call the on-line Help facility.

The third line (or bar) is called the **Tool Bar**. It contains the symbols to directly invoke short cuts to various file functions that would otherwise be accessed through the menus.

The remainder of the window is inactive at this level.

The current window displays only the top-level of CHEMCAD. CHEMCAD also has other windows for setting up and running a simulation, generating PFD’s, creating and editing plots, etc. In the course of this tutorial, you will be introduced to these windows and their use.
Let's start by opening a new job and giving it a job name. The **File** command is used for this. To open the **File** menu, click on the word **File** on the menu bar.

Now choose the **New Job** option by clicking on it.

The following dialog box will open:

This dialog box is prompting you to enter a name and folder for the new job. Let's use the name **TUTOR1**. Please enter this name in the field labeled **File Name**. Then close the dialog box by clicking the **[Save]** button. You will be taken into the main working window of CHEMCAD.

The major features of this window are labeled above as described below:
The top line, called the Title Bar, now contains the CHEMCAD logo and the current job name, as well as, the minimize, title, and close buttons which are always present on the left side.

The Menu Bar follows the Title Bar and consists of fifteen commands. These commands are:

- **File**
  - For file management and print control.

- **Edit**
  - For modifying various aspects of the flowsheet and its presentation. Edit functions include Redraw, Undo, Redo, Cut, Copy, Paste, Delete, Flip, and Rotate 90° among others.

- **View**
  - For controlling various display and drawing options.

- **Format**
  - For selecting engineering units, setting graphics options, and importing bit maps.

- **Run Simulation/Edit Flowsheet**
  - To switch back and forth between the Edit Flowsheet mode and the Run Simulation mode.

- **ThermoPhysical**
  - For selecting components, K-Value method(s), and enthalpy method(s) for the current job, as well as, viewing and editing the CHEMCAD databanks; setting up distillation curves and defining solids.
**Specifications**

For entering, editing, and manipulating stream and unit operations data. This may also be done by double clicking the stream or UnitOp directly on the flowsheet.

**Run**

For running the simulations, as well as for defining numerical controls and parameters.

**Results**

For reviewing calculated results.

**Plot**

For displaying calculated results graphically.

**Output**

For preparing reports and Process Flow Diagrams (PFD’s).

**Sizing**

For performing sizing and rating calculations for various types of equipment.

**Tools**

For performing various activities associated with simulation. These include data regression, CO2 – solids and hydrates prediction, TOD/COD calculations, and others.

**Window**

For arranging windows and icons display.

**Help**

For invoking the CHEMCAD help system or Coach.

The **Menu Bar** is followed by the **Tool Bar**. The toolbar contains “power buttons” or short cuts to specific frequently used functions. These toolbar functions are explained in an earlier section of this guide.

Below the **Tool Bar** is the **Active Area**. Notice that this area is accompanied by elevator bars for scrolling the active area display up and down, and left and right. Because we have not yet drawn our flowsheet, the **Active Area** is now blank except for the **Main Palette**.

The **Main Palette** provides access to the graphics functions and symbols that are necessary for the creation of the flowsheet.

**SELECTING ENGINEERING UNITS**

To select engineering units for this flowsheet, select the **Format** command by clicking it with the mouse. The following menu will appear:
Now select the **Eng Units** option by clicking on it with the mouse. The following dialog box will appear:

![Engineering Unit Selection Dialog Box]

The ENGLISH units option is the default and is currently highlighted. You may change the engineering units system by clicking any one of the four buttons **English**, **Alt SI**, **SI**, or **Metric**, or you can change any unit individually by clicking on the individual item and then selecting from the list presented. For this tutorial we will use **English** engineering units, therefore just exit the dialog box by clicking the **Cancel** button.

---

**DRAWING THE FLOWSHEET**

To draw the flowsheet you will be working with the flowsheet palette, which looks like this:
Please note the following about the flowsheet palette:

- The first box re-invokes the arrow cursor when needed.
- The second box enables the user to rotate objects on the flowsheet.
- The next five boxes (reading horizontally) enable the user to draw the indicated primitive on the flowsheet.
- Box number eight, the “ab” box, is used to put text on the drawing.
- Box number nine is for drawing process streams (streams must connect unit operations).
- The remaining boxes each represent one of the unit operations in the CHEMCAD library, or a user added module.
- Pointing to a box with the cursor will cause a small descriptive label to appear which will indicate what each box represents.
- Pointing to a box and clicking with the left button of the mouse will activate the corresponding function.
- Pointing to a box and clicking with the right button of the mouse will cause a sub-palette of icon options to be displayed. Right clicking again (on the same master palette box) will cause the sub-palette to disappear also, selecting a UnitOp icon from the sub-palette and placing it on the flowsheet will cause the subpalette to disappear.
- Multiple sub-palettes may be displayed simultaneously.
- The main palette may be switched on and off using the View/Main Palette command, by clicking on the Run Simulation command, or by clicking the S/G Power button.
The size and shape of the main palette can be controlled using the View\Palette Settings commands.

On the icon display, inlets are indicated by small blue squares and outlets by small red squares.

Our purpose now is to set up the flowsheet topology. Creating a flowsheet is the process of placing unit operations icons on the screen, connecting them with streams, and then adding various graphical objects to enhance the drawing. All of these things may be done using the palette.

We will start by placing unit operations icons on the flowsheet. By convention, CHEMCAD requires that every stream come from a unit operation and go to a unit operation. Therefore, we must place a Feed icon on the flowsheet to serve as the “source” unit for the feed stream. This is a good place to start by pointing to the Feed box:

Please follow the procedure given below:

1. Right click the feed icon box. The Feed sub-palette will appear. Now right click the feed icon box on the main palette again. The sub-palette will disappear. This is how you call and close UnitOp icon sub-palettes.

2. Now left click on the feed icon (on the main palette). The palette will disappear and a small, square box will appear on the screen. This is the cursor used to position and place UnitOp icons on the flowsheet.

3. Move the cursor to a position which is approximately on the left center of the screen. Then left click the mouse. The feed icon will appear on the flowsheet and the palette will reappear. Notice that since we selected our feed icon from the main palette, the icon displayed is the same one displayed on the main palette. To choose a different feed icon we would have had to select from the feed icon sub-palette.
This completes the placement of the UnitOp Feed.

For purposes of instruction, let’s explore some of the options associated with the Feed icon.

a. To move the symbol:
   - Place the mouse arrow on the icon.
   - Hold down the left button on the mouse. The four windows object boxes will appear.
   - With the left mouse button held down, drag the icon up about one-inch, then release the left button of the mouse. The icon position has been changed.

b. It may be necessary to move the palette out of the way in order to have access to the icon. You can do this by clicking and dragging on the red bar at the top of the palette.

c. To view the object editing options: place the mouse arrow on the icon (on the flowsheet, not on the palette) and press the right button on the mouse.

d. To move or stretch an object: left click on the icon so that the four object boxes are displayed around the icon. Then click and drag on one of these boxes. The icon will grow or shrink according to the mouse movements.

Now let’s place the two heat exchangers on the flowsheet. Please follow the procedure given below:

1. Point to the heat exchanger tile and let the cursor stay there until the message label appears. Using this label, make sure you are pointing to the heat exchanger box.

2. Right click the box. The heat exchanger icon sub-palette should appear.

3. Now point to the two sided heat exchanger icon as indicated below:

4. Left click on this icon. The palettes will disappear and the small, square cursor will reappear.

5. Locate the cursor about one inch directly to the right of the feed icon. Then left click again. The heat exchanger icon will be displayed on the flowsheet and the main palette (only) will reappear.

6. Now point to the heat exchanger tile again. This time we want a single sided heat exchanger such as the one shown on the main palette. Therefore, we do not need to call the sub-palette again.

7. Left click on this icon. The palette will disappear and the small, square cursor will reappear.
8. Locate the cursor about one inch directly to the right of the first heat exchanger icon. Then left click again. The heat exchanger icon will be displayed on the flowsheet and the palette will reappear.

Your flowsheet should now look similar to this:

For convenience, move the palette to one side by clicking and dragging on the brown bar at the top of the palette. Now follow the procedure outlined above to place the flash tank and the valve unit operations on the screen:
For the condensate stabilizer itself we want to use a distillation column module. You might notice from the palette that there are multiple distillation modules available in CC-STEADY STATE. An explanation of each of these options is given in the on-line Help manual. You can access this manual at any time by clicking the Help command on the menu bar. For now however, let's accept that the module we want to use is the rigorous distillation model called \textit{Tower}. This UnitOp is found on your palette as shown below:

Since we want to use a Tower icon that has a reboiler but no condenser we must use the sub-palette to select the desired icon. Therefore, right click on the Tower icon box. The sub-palette will appear. Select the Tower icon indicated below by left clicking on it.

Now add it to the flowsheet:
Finally, we must put three *Product* icons on the flowsheet, one for each product stream. The *Product* icon is located slightly to the right and down from the center of the palette as shown:
When you are finished, you screen should look similar to this:

PUTTING STREAMS ON THE FLOWSHEET

It’s now time to connect the UnitOps with streams. To do this, click the Streams icon box on the main palette.
There are a few general rules to remember when we are drawing streams on the flowsheet:

1. Each stream goes from a source unit to a destination unit.
2. Each unit has inlet and outlet positions. These are established when the symbol is created. The program always snaps streams to these positions. During the simulation, a process stream always flows from an outlet position on a source unit to an inlet position on a destination unit, but when drawing the flowsheet a stream may be drawn in any direction; that is; from an inlet position to an outlet position as well as from an outlet position to an inlet position.
3. When starting a stream, the cursor will be a small cross. When the cursor gets near an inlet or outlet position, it will convert to a black arrow. When this occurs you should left click the mouse to start the stream if that is the starting position you desire.
4. When completing the stream to a unit, the cursor will remain as a black arrow. When the cursor is near an inlet or outlet position, a label will appear indicating the location and number of the position.
5. Once the desired position has been located (as indicated by the appearance of the label), you should left click the mouse to complete the stream.
6. While drawing a stream, the palette will disappear. It will reappear only when you left click somewhere on the flowsheet which is not a UnitOp inlet or outlet point. You are not required to click the stream (link) icon tile each time you begin a stream.
7. You can alternate between placing UnitOps on the screen and connecting them with streams as long as the above rules are followed.
8. The first time you change directions of a stream, CHEMCAD will let you do so without any problem. Every additional time you change directions, you must first press the left button on the mouse to identify the longitude or latitude through which you want the stream to pass. Doing this will create an anchor point to fix the longitude or latitude on the screen.
9. You may cancel the stream drawing action by double clicking the left button during the stream drawing process.

With these rules in mind, let us now connect the UnitOps with streams.

Click the Streams icon box on the palette. The palette will disappear and the crosshairs cursor will appear. Move the cursor close to the tip of the feed arrow. When the cursor switches to a black arrow, press the left button on the mouse. Draw the stream over to the right with your mouse. When the label for left-most inlet arrow on the first heat exchanger appears, press the left button on the mouse. CHEMCAD will draw the stream directly to that point and will place a stream ID number on the flowsheet. CHEMCAD issues ID numbers sequentially, so this ID will be Number 1. You may change it using the EDIT STREAM menu (invoked by right clicking the stream) if you would like to do so.

Let's draw the second stream. Move the cursor to the right-most point of the first heat exchanger. When you are close enough to the unit outlet point, the cursor will switch over to the black arrow again. Press the left button on the mouse. Draw the stream over to the inlet position on the second heat exchanger and, when the label appears, press the left button on the mouse again. This should complete Stream 2.

Next, let's draw the stream from the second heat exchanger to the flash tank. Locate the right most outlet point on the Heat Exchanger unit. When the black arrow appears, click the left mouse button.
Now, draw the stream over to the flash tank until the first inlet label appears. Press the left button on the mouse to complete Stream 3.

Let’s draw Stream 4 from the top of the flash tank. Move the cursor near the top of the flash tank until the black arrow appears. Press the left button on the mouse. Now, draw the stream up about an inch and over to the left until it is directly over the first heat exchanger, then try to draw the stream down. You will notice you cannot do it; the entire line moves down with you. What we need to do is fix horizontal latitude to which that line is pegged before we make our turn. To do this, select your horizontal elevation for your cross-stream and press the left button on the mouse. Now, draw the steam down to the top of the heat exchanger. When that inlet label appears, press the left button on the mouse.

Using this procedure, complete the rest of the streams until your flowsheet looks like this:

If you need to delete or reroute a stream, right click on the stream to call the *Edit Stream* menu. Use the Delete and Re-draw commands as needed.

When all streams are satisfactorily drawn, click on a vacant spot on the flowsheet, and the palette will reappear.

We are now finished drawing our flowsheet. To move on we need to activate the Simulation mode. Therefore, at this time click on the *Run Simulation* command on the menu bar (or the S/G power button). The palette will close, and the input functions will become available.

### SELECTING COMPONENTS

Next let’s identify which components are to be used in this simulation. Selecting the *ThermoPhysical* command does this. This may be done by pressing [ALT + L] or by clicking with the mouse. Do this now please. The following menu will open up:
To choose components from the standard CHEMCAD databank, click the **Component List** option with the mouse. The following Component Selection dialog box will appear. This dialog box is organized as indicated below:

**"Selected Components" area:** The current list of selected components will be displayed in this area.

**"Component Databank" area:** All components stored in the databank(s) are listed here. Components are listed in order of their ID numbers. When this area is active, a blue highlight will identify one of the components.

**Insert button:** This button is used to insert a component somewhere in the component list, rather than appending to the end of the list.

**Add button:** Clicking on the **Add button** will add the currently highlighted component to the end of the flowsheet component list. Components may also be selected by double clicking on them. The selected component will appear in the list displayed in the **Selected Components Area.**
Clear button: The *Clear button* is used to delete the entire component list. When this button is clicked, all of the components listed in the *Selected Components Area* will be erased.

Delete button: The *Delete button* is used to delete individual components from the component list. To use this option, highlight the component in the *Selected Components Area* and click the *Delete button*.

Selection string field: This field is used to locate a component in the databank. Once the desired component has been located, it is added to the flowsheet component list by double clicking on it or by highlighting it and then clicking on the *Add button*. The program locates components by matching the string entered in this field. The string can be any alphanumeric combination. The string will be matched to any part of an ID numbers, formula, or synonym (component name) listed in the databank.

As you type in the string, the program automatically finds and highlights the closest match. As the string changes, the highlighted component changes.

Next button: If the current match is not the component you are looking for, click the *Next button* to find the next matching string.

Copy Components from another job: The *Copy Components button* is used to import the component list from another CHEMCAD job. When this button is clicked, the user is prompted to browse for the location of the CHEMCAD job from which the components will be imported. These components are the added to the *Selected Components Area*.

To show how a component is selected, let’s select Nitrogen. First, click on the *Selection String Field*, then type in the string "Nitrogen". As you build the string, the program will locate and highlight the component nitrogen. To add it to the component list, double click on it or click on the *Add button*. The component will appear in the *Selected Components Area*.

Nitrogen could just as easily been located by entering the string "N2" in the field. The same thing could have been done with the string "46" which is the ID number for nitrogen. Strings, which comprise only part of the word, number, or formula, can also be used. It is also possible to highlight the desired component by clicking on it directly and then clicking the *Add button*.

Now select the remaining components in the component list. Remember, if the first search does not locate the desired component, click the *Next button* to find the next matching string. Now find the following components and add them to the component list:

- 2 Methane
- 3 Ethane
- 4 Propane
- 5 I-butane
- 6 N-butane
- 7 I-pentane
- 8 N-pentane
- 10 N-hexane
The dialog box should now look like this:

Let's now save our list by clicking the [OK] button. The *ThermoWizard* will appear.

---

**SELECTING THERMODYNAMIC OPTIONS**

After the user first selects components the *ThermoWizard* will appear. The *ThermoWizard* is a system available in the CHEMCAD Suite to assist the user in making K-value and enthalpy choices.

The system works like this:

1. First, it looks at the component list and decides what general type of model is required, i.e., equation-of-state, activity model, etc.
2. Next, it looks at the temperature and pressure ranges input by the user and decides which equation within a given category is best at the limits of those ranges.
3. If the method is an activity model, the program then looks at the BIP database to see which model has the most data sets for the current problem. It then calculates the fractional completeness of the BIP matrix. If that fraction is greater than the BIP threshold parameter, it uses the chosen activity method; if not, it uses UNIFAC.

The K-Value Wizard is no replacement for engineering judgment. The Wizard makes uses an algorithm based on general rules and may not always be correct. The suggested model may not be the ‘best’ model for the system.

Selecting thermodynamic options basically means selecting a model or method for calculating vapor-liquid (or vapor-liquid-liquid) phase equilibrium (called the K-value option) and selecting a method or model for calculating the heat balance (called the enthalpy option). You do this using the *ThermoPhysical* command located on the menu bar. This is the same command you used to access the *Component List* above. Please click this option now. The *ThermoPhysical* menu should appear as before.
CHEMCAD has a library of about 50 K-value models with a variety of options, and about twelve enthalpy models. Making the proper selection from these libraries can sometimes be difficult. The issues involved and the proper techniques for selection are described in the Thermodynamics section of the on-line manual.

Because the issues involved in making thermodynamic selections and in using the Thermo Wizard are beyond the scope of this tutorial, let’s assume we know that we want to use the Peng-Robinson method for both the K-value and enthalpy calculations. In this case, we would proceed as given below.

First, we need to accept the default temperature/pressure values for the Thermo Wizard. The Wizard will recommend using SRK, please accept this message box. Then let us now make our own selection in the K-value Options dialog box. In the upper-left corner of this screen will be a combo box labeled Global K-value Option, which is currently highlighted. Please open this window by clicking on it.

You will notice the presence of a Scroll Bar at the right of this list indicating that all of the available options could not fit into this area. Therefore, the user may scroll through them using any of the methods previously described in this tutorial. We would like to use the Peng-Robinson method. To make this choice, please scroll up through list; point the arrow to the Peng-Robinson option; and click the left button on the mouse. The box will close and Peng-Robinson will now be displayed in the field. Your screen should look like this:

![K-value Options dialog box]

The other options on this screen are not important to us at this time. Therefore, let’s save our selection by pointing and clicking the [OK] button in the lower right corner. This will return you to the Simulation Menu Bar.

Now, let’s select our enthalpy model. Do this by again clicking the ThermoPhysical command, then clicking the Enthalpy option. The Enthalpy Options dialog box will be displayed. You will notice on this screen that the Peng-Robinson method has already been chosen. The program automatically makes this the enthalpy model when you choose the Peng-Robinson K-value method. If this assumption is erroneous, you may override it at any time. In our case, we would like to use the Peng-Robinson model, so let’s point and click on the [OK] button in the lower right portion of the screen. This will close the Enthalpy Options dialog box, saving the currently displayed options.

For the purpose of our tutorial, the thermodynamic selections are now complete.
DEFINING THE FEED STREAMS

We are now in a position to define the feed streams. This can be done by using the Specifications command on the menu bar or by double clicking directly on the stream we wish to specify. Double clicking directly on the stream is obviously simpler, so let’s do that now. Double click stream 1. The Edit Streams dialog box will appear like this:

Please note the following points about this dialog box.

- The first field, called Stream Name allows you to enter a stream label or name. This name may be up to 16 alphanumeric characters.

  **Note:** Entering and/or editing such steam labels can also be done a number of other ways.

- The next four fields; temperature, pressure, vapor fraction, and enthalpy are the thermodynamic properties of the stream. According to the Gibbs Phase Rule, once the composition is given, specifying any two of the four thermodynamic properties of a mixture will define the other two. Thus, defining the composition, temperature, and pressure uniquely defines the vapor fraction and enthalpy as well (again this is for a mixture only). Alternately, defining the composition, pressure, and enthalpy will uniquely define temperature and vapor fraction.

CHEMCAD, however, by convention, does not permit this much freedom. Since enthalpies are calculated relative to a datum, the calculation of any given stream enthalpy is an involved process which is prone to errors. For this reason, CHEMCAD does not permit you to enter stream enthalpy. (There is one exception to this rule; when the total component flowrate of a stream is zero, entering an enthalpy in a stream may serve as an alternative way of adding a heat duty to a unit.) Therefore, to uniquely define any stream in CHEMCAD, the user must define the composition of that stream, and any two of temperature, pressure, and vapor fraction. This is for a mixture. For pure component, all three thermodynamic properties are sometimes required.
The fields *Total Flow Units* and *Comp Units* work together to provide the user with a variety of ways to define stream compositions. If the *Comp Units* are set to mole, mass, or volume fraction (which can be done globally or locally) then the *Total Flow Units* combo box will become available. If *Comp Units* is set as a flow or amount option, then the total flowrate becomes the sum of the component flowrates and the *Total Flow Units* combo box will not be available for editing.

If the *Comp Units* is set to an amount flow unit (as opposed to mole, mass, or volume fractions), then as the component flowrate values are entered, they are automatically summed and the current sum is displayed in the field labeled *Total Flow*.

In the upper left hand corner of the dialog box is the *Flash* button. Clicking this button at anytime will cause the program to perform a flash calculation using the currently specified composition and thermodynamic properties. This allows quick flash calculations to be made without exiting the dialog box.

Fractions that do not sum to 1.0 are automatically normalized upon flashing or exiting the dialog box.

Now, let’s enter the data. Let’s start with temperature. Please move to the temperature field by clicking on it.

Once the highlight is on the proper field, type 75 [down arrow]. When you press the [down arrow] key, the highlight will move down to the pressure field. Please enter 200 in this field.

Next, let’s move down to the *Nitrogen* field. Please move the cursor down until it points to the field to the right of *Nitrogen*, and click the left button on the mouse. Please enter 100.19 in this field.

In a similar fashion, please enter the following numbers in their corresponding fields:

- Methane 4505.48
- Ethane 514
- Propane 214
- l-butane 19.2
- N-butane 18.18
- l-pentane 26.4
- N-pentane 14
- N-hexane 14

Save this stream information by pointing to the [OK] button in the upper-left corner of the dialog box. We are now ready to input the equipment parameters.

**INPUTTING EQUIPMENT PARAMETERS**

*Specifying the first heat exchanger...*

In a fashion similar to streams, equipment parameters may be input using either the *Specifications* command on the menu bar or by double clicking directly on the UnitOp we wish to specify. Again, the
latter is easier, therefore, please point and double click on the first heat exchanger now. An equipment-specific input dialog box will appear:

![Heat Exchanger Dialog Box](image)

Data entry screens can be more than one page long. The buttons called Specifications, Misc. Settings, and Cost Estimations indicate the pages for this dialog box. You may browse through them by clicking on the tab.

**Now, let’s fill in the screen**

Pressure drop for both sides of the exchanger is 5 psi; therefore, click on the “Stream 1” pressure drop field and press the 5 key, then click on the other pressure drop field which is labeled Stream 4. Likewise, enter 5 in this field.

We need to specify the first stream outlet to be at its dewpoint. We do this by specifying an outlet vapor fraction of 1. Therefore, move to the Vapor Fraction stream 2 field either by tabbing down to it or by clicking on it. Then enter 1.

This completes the input for this unit. We now need to save this information and close the dialog box. You do this by clicking on the [OK] button.

**Specifying the second heat exchanger…**

We can now select the next unit for data input. Move the cursor to the second heat exchanger and double click. The menu for a single-sided heat exchanger will appear.
The outlet temperature from this heat exchanger will determine how much of the liquid is removed in the flash drum. This, in turn, will determine the cricondentherm dewpoint of the product gas. Therefore, this specification is one of the key parameters of our design. As a first attempt, let’s estimate an outlet temperature of \(-5^\circ F\). Therefore, please enter 5 in the Pressure Drop field and a \(-5\) in the Temperature of Stream 3 field. Point and click on the [OK] button to save the data and close the dialog box.

**Specifying the flash drum...**

In our example, the flash drum is a vapor liquid separator and requires no specification. Therefore, we do not need to enter any input for this unit.

**Specifying the valve...**

Let’s enter the outlet pressure for the valve. Please move the cursor to the valve and double click. The Valve dialog box will appear. Since our outlet pressure for this unit is 125 psia, please enter 125 in the Pressure Out field, then point and click on the [OK] button. This completes the input for the valve unit.

**Specifying the stabilizer tower...**

Now double click the tower unit. The TOWR Distillation Column dialog box will appear. There are five pages to this screen as indicated by the tabs.

On the first page, we need to enter the top pressure, which is 125 psia; the column pressure drop, which is 5 psi; the number of stages, which is 12, and the feed stage location, which is stage number 1. Therefore, please complete your screen as shown below:
Let’s continue our data input on the next page. Please click on the Specifications tab. We make our specifications for the column on this screen. We have no condenser or side streams on this column so we will only be making specifications for the reboiler.

First, we need to specify our reboiler mode. In order to determine what our options are, please point the arrow to the field below the label Select Reboiler Mode and click the left button on the mouse. A list should open displaying the available options.

We need to specify the bottom flowrate for this unit, which is Mode No. 4. Therefore, please point the cursor to 4 Bottom mole flowrate and click the left button on the mouse. The list will close and the field should now read 4 Bottom mole flowrate.

Now we need to specify the numeric value of that flowrate. This is done in the field immediately to the right, which opens after we make our mode selection. Please point the arrow to that field, and click the left button on the mouse. This field should be highlighted and we can enter a value of 30.

Now, let’s move to the next page of this dialogue box by clicking the Convergence tab. As you can see from the screen, all of the entries on this page are optional. However, for the purpose of demonstration, let’s enter an estimate of 50°F for the top temperature and 150°F for the bottom temperature. Please point and click on the T top field and enter a value of 50 in this field. Now move to the field labeled T bottom immediately below. Enter a value of 150 in this field.

Now we have completed the data input for the tower unit. Let’s save this data by pointing and clicking on the [OK] button. When you do this, you will get a warning message saying you have not entered an estimate for the distillate rate. The program will ask you if you want to ignore this warning. Warning messages are for your information and can normally be ignored; therefore, please click [YES] now. This will return you to the Simulation Window. All of the data entry for the flowsheet is now complete.
RUNNING THE SIMULATION

To run the simulation, point and click on the RUN command on the menu bar. This will cause the RUN Menu to open up like this:

We want to run a steady state analysis, so select the Run All option.

The program will first recheck the data and list any errors and/or warnings on the screen. In this case, we should have no errors, although we will have warnings saying we have not given certain estimates. We can ignore these warnings and proceed by clicking the [YES] button. The calculation will then proceed.

Upon finishing, the CC5 Message Box will appear with the message “Recycle calculation has converged”. To close this dialog box and clear the screen, you must click on the [OK] button.

REVIEWING THE RESULTS INTERACTIVELY

Now that the simulation is complete, we will want to review the results before printing a hardcopy. We do this using the Results and Plot commands on the menu bar. With these commands, let’s check whether we have met our design criteria.

Checking the cricondentherm dewpoint...

If we have chosen the proper outlet temperature for heat exchanger number 2, the cricondentherm dewpoint for the product gas stream (Stream 5) will be 20º F or less. The cricondentherm dewpoint, you will remember, is the highest dewpoint temperature a mixture will ever see at any pressure. The simplest way for us to identify the highest dewpoint temperature of the product gas is to plot all of the dewpoint temperatures of the product gas, i.e., to plot a phase envelope. Let’s do that now.

To plot anything inside CHEMCAD, we must start with the Plot command on the menu bar. Please select this option by clicking on it. When you do this, the PLOT MENU will appear. On this menu, you will see a list of the general categories of plots available within CHEMCAD. Please select Envelopes by clicking on it.
The **Select streams** dialog box will appear. Move the cursor to stream 5 (the product gas stream leaving the bottom of heat exchanger number 1) and click it once. The number 5 will appear in the dialog box field. Now click **[OK]** to close the streams selection process. The **Phase Envelope Options** dialog box will appear.

![Phase Envelope Options](image)

No entries on this screen are required since we only need to look at the dew point line. However, to make the plot more interesting, let’s display the 0.25 and the 0.5 vapor fraction lines in addition to the normal phase envelope boundaries. Therefore, complete the dialog box as shown:

![Phase Envelope Options](image)

Now click the **[OK]** button to confirm these entries.
CHEMCAD will perform the required flash calculations necessary to generate the phase envelope as specified above. Phase envelope results are produced in two formats:

1. A numerical tabulation (table) of the temperature, pressure, vapor fraction, vapor compressibility factor, and the liquid compressibility factor.

2. A plot of temperature and pressure for each vapor fraction line requested.

The former is displayed in a *WordPad Window*; the latter in a *Plot Window*.

Since we are not going to use the tabulated results, please close the *WordPad Window* now. Your screen will then look like this:

![Plot Window](image)

You are now in a plot window, and your available commands have changed. Actually, this window can be thought of as a plot edit window because it is the same for every plot. It has the following commands:

- **File**: This command is for file management and print control as it is in every CHEMCAD window.
- **Edit**: Contains the undo, cut, copy and paste commands.
- **View**: Controls the Toolbar and Status Bar display status.
- **Graph**: Provides access to zoom, edit and plot data transfer facilities.
- **Window**: For arranging windows and icons.
- **Help**: Provides access to the on-line help facility.

At this point, let’s make note of a few important items regarding CHEMCAD plots.

1. To zoom in on a certain section of the plot, point to one corner of the area that you want to zoom in on, then click-and-drag (i.e., hold down the left mouse button while you are moving the cursor) to the opposite corner of that area. When you release the mouse button, the program will zoom in on the
boxed in area. To restore the original size, click on the Graph command (on the menu bar); then click on the Zoom Out command.

2. The plot title text (in this case, Phase Envelope for Stream 5) can be edited using the Graph/Edit titles command.

3. The color, size, layout and various other aspects of the plot presentation can be edited using the Chart Explorer function.

4. A hardcopy of this plot can be obtained by clicking the Print button.

Let’s use some of these features to see how they work. First, remembering that we are trying to determine if the cricondentherm dewpoint of Stream 5 is 20º F or less, let’s zoom in on the graph around the right most area of the curve.

a. Point the cursor to a point around the 1000 psia, 0 F coordinate on the graph.

b. Now, push down the left button of the mouse and hold it down while you drag the cursor to the approximate location of the 400 psia, 30 F coordinate.

c. Release the left button. The program will zoom in on the selected area, and you screen should look something like this:

From this, we can see the highest dewpoint of this mixture is a little less that 20º F. Therefore, the cricondentherm dewpoint of this mixture is indeed at or less than our product gas specification.

Our plot is now finished. To print the display, click the Print button.

This finishes our plot exercise. Please return to the main window by closing the current window. Therefore, please click the close button (×) on the right hand side of the second bar. This will return you to the main CHEMCAD window.

Checking the bottoms stream purity…

Our second specification requires that the percent of propane in Stream 9 is to be 1%. We can check and see if we have achieved this specification by using the Results command. Please point and click on the Results command or press [ALT + U] now. When you do this, the Results menu will appear.
We want to check stream compositions, and we want to do it in mole percent. Therefore, we must first set our flow units. Please point and click on the Set Flow Units option now. The View Flow Rate Units dialog box will appear. Please scroll down to and point and click on the option, which says Mole %. Then click [OK]. You will be returned to the Main CHEMCAD Window.

Now click Results again. On the Results Menu, highlight Stream Compositions. On the STREAM COMPOSITIONS MENU, which appears, click on Select Streams. The Select Streams dialog box will appear. As before, use the mouse to point to stream 9 and click once. Now click [OK]. The following display will appear:

We can see from this display that propane is greater than the 1% specification. This means our design is too conservative. To correct this, let's go back and re-specify the column to produce precisely 1% propane in the bottom.

Please click the close button once.

**RE-RUNNING THE SIMULATION**

Let's re-run the stabilizer specifying that we want 1% propane in the bottom. To do this, please double click on the Tower UnitOp.

The TOWR Distillation Column data entry dialog box for the stabilizer should reappear.

Now, let's click on the Specifications page of the dialog box. We want to change our specification from Bottom mole flowrate to a purity specification. Therefore, we must start by changing the mode of the specification. To do this, please point and click on the field below the Select reboiler mode option and select Mode 6. This field should now read 6 Bottom component mole fraction. To complete our specifications, we must identify what that purity is and for which component it is being specified. In the
Specification field to the right, we want to enter .01 instead of the present 30. Please do this now. Next, we must identify the component for which we are making a purity specification. To do this, click on the component field. A list of all of the components in the component list will open. Click on propane. The list will close.

Please click on the third page of the screen. Since we have run this condensate stabilizer before, we want to instruct the program to pick up where it left off at the end of the last simulation. We do this by making the proper selection in the field labeled Initial flag under Convergence parameters. Please click on this option. A list will open displaying the available options. The option we want is option number one, Reload column profile.

We have now made all the changes required to rerun the condensate stabilizer. Let’s save them by pointing and clicking on the [OK] button.

Please point and click on the Run option on the menu bar. This will cause the Run Menu to reappear. Please note at this point that since the only unit affected by our changes is the condensate stabilizer itself, it is not necessary to rerun the entire flowsheet. Therefore, let’s only rerun Unit 5, the condensate stabilizer. We do this by pointing and clicking on the Run selected Units option. Please do this now.

When we opened the Tower dialog box, we “selected” the Tower UnitOp (UnitOp No. 5). When we closed that dialog box, UnitOp No. 5 remained selected even though its dialog box was closed. Therefore, when we told the program to “Run selected units”, it immediately ran UnitOp No. 5 because it was “selected”. Selected objects are indicated by the four corner boxes which surround them.

When the calculation is finished, the message “Calc Unit 5 TOWR” will appear to the left on the bottom line of the CHEMCAD window. This should happen almost immediately since the stabilizer runs very fast.

We now want to insure that we have 1% propane in the bottom stream. We will again do this with the Results command. Please point and click on the Results command on the menu bar. This will cause the Results Menu to appear.

Now, highlight the Stream Compositions option and display Stream 9 using the following steps:

1. Point and click on the Select Streams option.
2. Move the cursor to Stream 9, then press the left mouse button.
3. Click [OK].

Stream 9 should now be displayed in a WordPad Window. We can see that propane is now 1%, as desired.

Now click the WordPad close box to close the stream composition display.

PRODUCING A REPORT

To produce a hardcopy output of any kind, use the Output option on the menu bar. Click Output or press [ALT + O]. The OUTPUT MENU will appear, and you will have the following options:
Report  For generating tabular hardcopy outputs.
Main PFD  For producing and editing the primary (first) process flow diagram.
New PFD  For producing additional process flow diagrams.
Open PFD  For editing process flow diagrams other than the main PFD.

Let’s choose the Report option by pressing the [R] key. This will cause the Report Menu to appear.

For the purpose of this demonstration, let’s assume we want to print out the following information:

1. For Streams 1, 5, 8 and 9, let’s print the stream composition in mass flowrates and mole fractions, as well as the default stream properties.
2. The equipment summaries for every piece of equipment in the flowsheet.
3. Tower profiles for the condensate stabilizer.

We will begin with the first item above. We must first specify which streams we want to print out. To do this, use the Select Streams option on the Report Menu. Please point and click on this option now. The Select Streams dialog box will appear and will permit you to identify the desired streams either with the use of the mouse, or by entering the stream ID numbers in the boxes provided. Let’s type in the desired stream numbers this time. Deselect the check box next to the field labeled Print ALL streams?

1. Deselect the check box next to the field labeled Select from flowsheet?
2. Now we need to identify streams 1, 5, 8, and 9 as the selected streams. First, click on the stream ID box in the upper left-hand corner under the label Enter the stream ID’s.
3. Type the number 1 into the field.
4. Now, click on another field and type the number 5. It does not matter which box you select. Any box will do, even if it is not contiguous to the first box. Also note that the TAB key may be used to move from one field to another.
5. Select boxes for the other streams, and enter the numbers 8 and 9
6. To close the Select Streams dialog box, click on the [OK] button.
We should now be back on the Report Menu.

Let's select which pieces of equipment or unit operations we want to include in our output report. To do this, select the Select Unit Operations option on the menu. Please do this now. The Select Unit Operations data dialog box will appear. As you can see, this dialog box is very similar to the Select Streams dialog box, which we encountered earlier. In the default condition, all unit operations are output. If the user chooses to override this default, he/she may do so by either using the keyboard or by clicking on the Select from flowsheet graphics option on the screen. In our case, we are going to print all the unit operations. Since this is the default, we will make no changes. Please point and click on [OK].

Now, let's select stream properties. Please select the Stream Properties option on the Report Menu. The Property Options dialog box will appear. Please note this dialog box has two pages. You will also notice this is an on/off selection screen. Whichever options have a checkmark in the box next to them will be printed. Whichever options do not have a checkmark in the box next to them will not be printed. The user may turn these options on/off by pointing and clicking with the arrow. For the purpose of this demonstration, we will use the default settings for stream properties output. Therefore, please exit this menu by pointing and clicking on [CANCEL] in the bottom-right portion of the screen. This will return you to the Report Menu.

Our next step will be to select the flow units for the stream compositions print out. To do this, we use the Stream Flowrate/Composition option on the Report Menu. Please select this option now. Your screen should look like this:

![Stream Flowrate/Composition Options]

You will notice that in the default condition the stream compositions will be printed out in units of molar flowrate. For Tutor1, we do not want mole flowrates; we want mass flowrates and mole fractions. Therefore, we first need to turn the Mole flow rate off. You can do this by pointing and clicking on the box to the left of the label. This box currently contains a checkmark indicating that, at this time, mole flowrates is an active selection. Please point and click this box now.

Now, let's turn the mass flowrate option on. Please point and click on the Mass flowrate box now. Finally, let's turn the Mole Fractions option on by pointing and clicking on that option. Your screen should look like this:
Please save these entries by pointing and clicking on [OK] in the bottom-right corner of the dialog box. This will return you to the Report Menu.

For our final selection, we are going to specify which information is going to be printed for the condensate stabilizer distillation column. To do this, please select the Distillation Summaries option on the menu. The Distillation Options dialog box will appear and will permit you to do the following things:

1. **Tray profile** – Print a tabular summary of the tray profiles for the column, i.e., for each stage the program will print the temperature, pressure, vapor flowrate, liquid flowrate, and any feeds and products going to or from the stage.

2. **Tray properties** – A tabular summary of the transport properties of the vapor and the liquid on each stage of the column.

3. **Tray sizing** – Results of tray sizing calculations for each stage of the column. The user may select from valve, sieve, or bubble cap trays.

4. **Packed column sizing** – Packed column sizing and pressure drop calculation results.

5. **Tray compositions** – Tray compositions may be printed in mole or mass flowrates as well as mole or mass fractions. Only one may be selected.

We are going to print only the tray profiles described in Item 1 above. As you can see from the checkmark on the dialog box, this is the default option. Therefore, please click [OK] to return to the Report Menu.

We are now ready to generate our report. Please point and click on the option which says Calculate and Give Results. When you do this, the report will be displayed in a Word window. It will be formatted exactly as it would on paper.

All WORD commands are now available for editing, saving and printing.

Once we are finished with the report, close the Word window by clicking the close button. The Report Menu will reappear. You can now generate more reports if you like. In our case, we want to close the Report Menu by clicking End Report. You will be returned to the main Simulation window.
Another way to obtain a hardcopy output is to create a process flow diagram (PFD). Select the **Main PFD** option on the **Output Menu**.

The program will go into “PFD mode”, which means it will open up certain commands and features that up to now have been unavailable. These are:

**Add Stream Box** – The **Add Stream Box** command is used to create stream data boxes. Stream data boxes can be used to display the heat and material balance and stream properties. As many stream data boxes as desired can be placed on a PFD. This command is located on the **Format menu**.

**Add UnitOp Box** - The **Add UnitOp Box** command is used to create unit operation data boxes. Unit operation data boxes can be used to display the input and/or output of UnitOps on the flowsheet. As many UnitOp data boxes as desired can be placed on a PFD. This command is located on the **Format menu**.

**Add TP Box** – The **Add TP Box** command is used to display the temperature, pressure, and/or flowrate of a stream in small boxes attached to the relevant stream. This command is located on the **Format Menu**.

**Refresh Data Boxes** – The **Refresh Data Boxes** command is used to update the stream and UnitOp data boxes after a new run has been made. It is located on the **View menu**.

**The PFD palette** – The **PFD palette** is a small palette which contains only those graphics functions which are relevant to creating a PFD. They are the **select, rotate, rectangle, ellipse, line, multiline, text, and Job box** functions. These are described below and in the “Drawing with the Palette” and “How to put text on a drawing” sections of this User’s Guide.

Other commands not consistent with the creation of PFD will “gray out” or become unavailable until we switch back into simulation mode.

The process of creating PFD’s consist of the following activities:

1. Creating and placing **Stream Databases** on the drawing. Stream databases are framed tabulations of the heat and material balance and stream properties. The content and style of these databases is within the user’s control.

2. Creating and placing **Unit Operation Databases** on the drawing. Unit Operations databases are framed tabulations of selected input and output values for each unit operation on the flowsheet. Again, the style but not the content of these databases is within the user’s control.

3. Adding **text** to the drawing. Using the text facility on the PFD palette, titles, notes, and various other text can be placed on the PFD.

4. Placing symbols in the PFD. The user can create and store symbols, such as company logos, in a symbols library for later retrieval and placement on CHEMCAD drawings.

Drawing primitive (i.e., simple) objects. A variety of 2D objects are available to the user for freehand object creation.

To see how these work, let’s draw the PFD.
In order to have adequate space to place additional information on the PFD, the first thing we need to do is reduce the size of the flowsheet. Please click on the **Zoom Out** option located on the tool bar.

Creating a stream databox...

Now, let's place the heat and material balance for the flowsheet on the screen. This information is contained in a Stream Databox. A stream databox is created using the following process.

1. Click the **Format** command on the menu bar. The **Format Menu** will appear.

2. Click the **Add Stream Box** option on the **Format Menu**. The **Select Streams dialog box** will appear.

Normally this dialog box would be used to list the streams which are to be included in the streams databox. In our case however we will include all the streams in the databox, so we don’t have to list the streams. The default is to include all streams. Therefore, click the **[OK]** button to close the dialog box.

The **PFD Property Options dialog box** will open.

3. The PFD Property Options dialog box looks like this:
This dialog box is used to select which items (for each stream) are to be included in the databox. Items are selected by clicking the small box next to them. A checkmark indicates that the item will be included. An empty box indicates that the box will not be included in the databox.

For the purposes of this demonstration, let’s accept the default settings. Therefore, please click the [OK] button to close this dialog box and save its’ current settings.

4. You will now see the **Data Box Settings dialog box**. This dialog box looks like this:

![Data Box Settings dialog box]

 Obviously this dialog box is used to make format settings for the databox. For simplicity’s sake let’s accept the default settings. Therefore, please click the [OK] button now. The stream databox will appear in the upper left-hand corner of the PFD.

5. Now let’s move the databox so that it fits along the bottom of our PFD. To do this, move the cursor until it is over the databox. Then, while holding down the left button, move the mouse around until the databox is in the bottom center of the PFD.
6. Now let’s resize the databox. Point the cursor to one of the small, black squares at the corners or the databox. Then, while holding down the left mouse button, roll the mouse around. As you do so the databox will change size. Move the mouse until the databox is the correct size, and then release the mouse.

Our stream databox has been successfully completed. You can put as many stream databoxes on a PFD as you desire. Thus one databox might contain the heat and material balance, while another contains the stream transport properties. Alternately, one databox might contain stream one through twenty, while another contains streams thirty through fifty. The system is extremely flexible.

UnitOp databoxes can be created using the same process outlined above. These databoxes can contain input and/or output information for any selected UnitOp on the flowsheet.

**Placing text on the PFD…**

Text and other symbols and objects can be put on the PFD also using the PFD palette. The PFD palette will appear automatically when you enter PFD mode. It’s functions are as shown below:
Text can be created and placed on the PFD using the “ab” square. Please click on this square now. The palette will disappear and the text cursor will appear. Locate the cursor towards the top left of the PFD in a position appropriate for a title, then press the left mouse button. Now type the PFD title, “Condensate Stabilizer PFD”. When finished double click on some vacant spot. The palette will reappear.

We now have a complete process flow diagram. We can generate a hardcopy of this PFD by clicking the Print button.

To close CHEMCAD, click on the Close in the upper right hand corner of the window. When you do this CHEMCAD will ask you if you want to save the changes to the PFD. Please answer “yes”. The top-level window of CHEMCAD will open. Close this window to exit to the operating system.

We are now finished with our demonstration.

### SUMMARY

During this tutorial we have accomplished the following things:

1. Set up a new problem.
2. Drawn our flowsheet.
3. Interactively prepared our input.
4. Run the simulation.
5. Interactively changed our input.
6. Rerun the simulation.
7. Plotted and viewed the results interactively.
8. Produced a tabulated report of results.
9. Produced a process flow diagram.

These are the major functions within the process simulation portion of CHEMCAD.
CHEMCAD-BATCH TUTORIAL

INTRODUCTION

This tutorial provides basic input skills for operation of CC-BATCH. The CHEMCAD input convention and rules apply to CC-BATCH as it does to all other modules. Since CC-BATCH is a module of CHEMCAD, the names will be used interchangeably in this tutorial. The input procedure for CHEMCAD is simple and straightforward, designed to be intuitive for a chemical engineer familiar with the Windows environment. However, for the sake of clarity and for those new to this environment, a review of some of the basic rules for using CHEMCAD is given. These rules are demonstrated as we apply them to solving this batch distillation problem.

BASIC RULES – GENERAL

The following ten basic steps are used to run a flowsheet simulation in CC-BATCH:

- Start a new job
- Select engineering units
- Create a flowsheet
- Select components
- Select thermodynamics options
- Input initial change and/or feed stream data
- Specify the batch column (configuration and operations)
- Run the simulation
- Review the results
- Generate hardcopy output

The steps do not have to be performed in this order nor do all of them have to be done for every CC-BATCH flowsheet since defaults exist for some of them. All should be considered for each problem.

There are a series of Help facilities available throughout the program. The bottom line of the screen provides a one-sentence description of the current highlighted item. The Help command provides access to the On-line Manual, which contains comprehensive technical information. The [F1] key provides context sensitive help (place the cursor in a specific field and press the [F1] key). The Coach facility will provide instructions on how to perform selected tasks. Use of these help facilities will ease your way through the program.

CHEMCAD is object oriented. Therefore, most input and editing can be done by double clicking or right clicking the object of the operation, as well as by using the menu commands.
All stream and unit operations specifications (input) are accomplished using dialog boxes. These dialog boxes are context specific and employ some combination of character fields, combo boxes, choice boxes and check boxes.

**HOW TO USE THE MOUSE**

The mouse is a very easy to use way to get the computer to do what you want. CHEMCAD, like many windows programs, requires the use of a mouse, trackball, or similar pointing device with both a primary and secondary button (i.e. a standard Microsoft 2-button mouse). The basic Mouse techniques are summarized below:

- **Click** To quickly press and release the primary mouse button. For most right-handed mice, this is the left button.
- **Right-click** To quickly press the secondary mouse button. For most right-handed mice, this is the right button.
- **Double-click** To press the primary button twice in rapid succession.
- **Drag** To press and hold down the mouse button while moving the mouse.
- **Point** To move the mouse arrow until it points at the item of choice.
- **Right-click hold** A technique used mainly in Windows 95 and NT. Point the mouse to a specific area, then click and hold the secondary mouse button.

**USING THE KEYBOARD**

- The **[TAB]** key is used to move to the next field on a data entry dialog box.
- The **[PgUp]** and **[PgDn]** keys may be used to “page” or scroll through lists.
- Holding down the **[SHIFT + TAB]** will cause the program to move back or up one field.
- The **[F1]** key is used to call context specific help.
- **[F5]** key is used to display the current job’s component list from within a dialog box.
- **[F6]** key is used for engineering units conversion.
- **[F7]** key calls a simple calculator.
THE TOOL BAR BUTTONS

The “Standard” way of executing commands in CHEMCAD is to click a command on the Menu Bar and follow that command down through the subsequent menus until the desired function is reached. Thus, to select components from the databank, one would first click the command ThermoPhysical on the Simulation Menu Bar; click the option Component List from the ThermoPhysical Menu and finally select components from the Component Selection dialog box.

There is a shorter way of reaching this and other frequently used functions. This is to use the CHEMCAD Power buttons, which are located on the tool bar. This tool bar is toggled on and off using the View/Toolbar command.

A DESCRIPTION OF THE PROBLEM

This tutorial walks the user through the input and simulation of a simple five-step batch distillation problem. This problem is illustrated below in Figure 1 and all input data are given in Table 1.

8 stages with condenser and reboiler.
5 operating steps.

Charge:

P = 16.7 psia
T = bubble point
100 lb-moles
C3 = 0.1 mole frac.
nC4 = 0.3
nC5 = 0.1
nC6 = 0.5

Switch accumulators at start of steps 3 and 4.

Add material at start of step 3:
P = 16.7 psia
T = bubble point
20 lb-moles
nC4 = 0.4 mole frac.
nC6 = 0.6

Figure 1
Table 1 - Input Summary for CC-BATCH Tutorial

Initial Charge Composition and Conditions:

<table>
<thead>
<tr>
<th>Component</th>
<th>ID</th>
<th>Mole Fraction</th>
</tr>
</thead>
<tbody>
<tr>
<td>propane</td>
<td>4</td>
<td>0.1</td>
</tr>
<tr>
<td>butane</td>
<td>6</td>
<td>0.3</td>
</tr>
<tr>
<td>pentane</td>
<td>8</td>
<td>0.1</td>
</tr>
<tr>
<td>hexane</td>
<td>10</td>
<td>0.5</td>
</tr>
</tbody>
</table>

Temperature = will be calculated
Pressure = 16.7 Psia
Vapor Fraction = 0 (at bubble point)
Total Amount = 100 lb-moles

Materials to be added at start of Operation 3

<table>
<thead>
<tr>
<th>Operation Step No.</th>
<th>Purpose</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Propane Removal</td>
<td>Propane Removal</td>
<td>Butane Production</td>
<td>Pentane Removal</td>
<td>Pentane Removal</td>
</tr>
<tr>
<td>Reflux ratio</td>
<td></td>
<td>5</td>
<td>20</td>
<td>25</td>
<td>15</td>
<td>25</td>
</tr>
<tr>
<td>Distillate molar flowrate</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Stop option location</td>
<td></td>
<td>Distillate</td>
<td>Distillate</td>
<td>Accumulator</td>
<td>Distillate</td>
<td>Bottom</td>
</tr>
<tr>
<td>Stop mod</td>
<td>Mole Fraction</td>
<td>Mole Fraction</td>
<td>Mole Fraction</td>
<td>Mole Fraction</td>
<td>Mole Fraction</td>
<td></td>
</tr>
<tr>
<td>Stop value</td>
<td>.2</td>
<td>.985</td>
<td>.99</td>
<td>.2</td>
<td>.9998</td>
<td></td>
</tr>
<tr>
<td>Comp. Posit</td>
<td>2 Butane</td>
<td>2 Butane</td>
<td>2 Butane</td>
<td>4 Hexane</td>
<td>4 Hexane</td>
<td></td>
</tr>
<tr>
<td>Materials to be added at start</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

Operating Steps Specifications:

<table>
<thead>
<tr>
<th>Operating Step No.</th>
<th>Purpose</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Propane Removal</td>
<td>Propane Removal</td>
<td>Butane Production</td>
<td>Pentane Removal</td>
<td>Pentane Removal</td>
</tr>
<tr>
<td>Reflux ratio</td>
<td></td>
<td>5</td>
<td>20</td>
<td>25</td>
<td>15</td>
<td>25</td>
</tr>
<tr>
<td>Distillate molar flowrate</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Stop option location</td>
<td></td>
<td>Distillate</td>
<td>Distillate</td>
<td>Accumulator</td>
<td>Distillate</td>
<td>Bottom</td>
</tr>
<tr>
<td>Stop mod</td>
<td>Mole Fraction</td>
<td>Mole Fraction</td>
<td>Mole Fraction</td>
<td>Mole Fraction</td>
<td>Mole Fraction</td>
<td></td>
</tr>
<tr>
<td>Stop value</td>
<td>.2</td>
<td>.985</td>
<td>.99</td>
<td>.2</td>
<td>.9998</td>
<td></td>
</tr>
<tr>
<td>Comp. Posit</td>
<td>2 Butane</td>
<td>2 Butane</td>
<td>2 Butane</td>
<td>4 Hexane</td>
<td>4 Hexane</td>
<td></td>
</tr>
<tr>
<td>Materials to be added at start</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

Materials to be added at start of Operation 3

<table>
<thead>
<tr>
<th>T</th>
<th>Will be calculated</th>
</tr>
</thead>
<tbody>
<tr>
<td>P</td>
<td>16.7 Psia</td>
</tr>
<tr>
<td>VF</td>
<td>.0001</td>
</tr>
<tr>
<td>Total lb./moles</td>
<td>20</td>
</tr>
<tr>
<td>Total flow unit</td>
<td>lbmol</td>
</tr>
<tr>
<td>Comp flow unit</td>
<td>mole frac</td>
</tr>
<tr>
<td>Butane</td>
<td>.4</td>
</tr>
<tr>
<td>Hexane</td>
<td>.6</td>
</tr>
</tbody>
</table>

GETTING STARTED

The first time you run CHEMCAD the Top Level Window will appear on your screen. Please maximize this window (that is, zoom it to fill in the screen) by clicking the Maximize button in the upper right hand corner of the CHEMCAD window. This will cause CHEMCAD to fill your screen and your display should look something like this:
The top line is called the **Title Bar**. It contains the CHEMCAD logo and name on the left side, and the WINDOWS *minimize, tile, and close buttons* on the right side.

The next line is called the **Menu Bar**. This bar contains the top-level commands for CHEMCAD. They are:

- **File**
  This command is used to define output formats, open jobs, print, and obtain general information about CHEMCAD.

- **License**
  This command is used to configure license, update dongles and authorize special licenses.

- **View**
  This command enables the user to toggle the Tool bar and Status bar on and off.

- **Help**
  This function allows the user to call the on-line Help facility.

The third line (or bar) is called the **Tool Bar**. It contains the symbols to directly invoke short cuts to various file functions that would otherwise be accessed through the menus.

The remainder of the window is inactive at this level.

The current window displays only the top-level of CHEMCAD. CHEMCAD also has other levels for drawing the flowsheet, setting up and running a simulation, and generating PFD’s and reports. In the course of this tutorial, you will be introduced to the most important of these levels and their use.
STARTING A NEW JOB – THE SIMULATE FLOWSHEET WINDOW

Let’s start by opening a new job and giving it a job name. The File command is used for this. To open the File menu, click on the word File on the menu bar.

Now choose the New Job option by clicking on it.

The following dialog box will open:

![Save As Dialog Box]

This dialog box is prompting you to enter a name and folder for the new job. Let’s use the name BATCHDIS. Please enter this name in the field labeled File Name. Then close the dialog box by clicking the [Save] button. You will be taken into the main working window of CHEMCAD.

![Main Working Window]

The major features of this window are labeled above as described below:

The top line, called the Title Bar, now contains the CHEMCAD logo and the current job name, as well as, the minimize, title, and close buttons which are always present on the left side.
The **Menu Bar** follows the **Title Bar** and consists of fifteen commands in addition to the **Help** command. These commands are:

**File**
- For file management and print control.

**Edit**
- For modifying various aspects of the flowsheet and its presentation.
  - Edit functions include *Redraw, Undo, Redo, Cut, Copy, Paste, Delete, Flip, and Rotate 90°* among others.

**View**
- For controlling various display and drawing options.

**Format**
- For selecting engineering units, setting graphics options, and importing bit maps.

**Run Simulation/Edit Flowsheet**
- To switch back and forth between the **Edit Flowsheet** mode and the **Run Simulation** mode.

**ThermoPhysical**
- For selecting components, K-value method(s), and enthalpy method(s) for the current job, as well as, viewing and editing the CHEMCAD databanks; setting up distillation curves and defining solids.

**Specifications**
- For entering, editing, and manipulating stream and unit operations data. This may also be done by double clicking the stream or UnitOp directly on the flowsheet.

**Run**
- For running the simulations, as well as for defining calculation numerical controls.

**Results**
- For reviewing calculated results.

**Plot**
- For displaying calculated results graphically.

**Output**
- For preparing reports and Process Flow Diagrams (PFD’s).

**Sizing**
- For performing sizing and rating calculations for various types of equipment.

**Tools**
- For performing various activities associated with simulation. These include data regression, CO$_2$ – solids and hydrates prediction, TOD/COD calculations, and others.

**Window**
- For arranging windows and icons display.

**Help**
- For invoking the CHEMCAD help system and/or Coach.

The **Menu Bar** is followed by the **Tool Bar**. The toolbar contains “power buttons” or short cuts to specific frequently used functions. These toolbar functions are explained in an earlier section of this guide.

Below the **Tool Bar** is the **Active Area**. Notice that this area is accompanied by elevator bars for scrolling the active area display up and down, and left and right. Because we have not yet drawn our flowsheet, the **Active Area** is now blank except for the **Main Palette**.
The **Main Palette** provides access to the graphics functions, which are necessary for the creation of the flowsheet.

### SELECTING ENGINEERING UNITS

To select engineering units for this flowsheet, select the **Format** command either by pressing `[ALT + M]` or by clicking it with the mouse. The following menu will appear:

![Format menu](image)

Now select the **Eng Units** option by clicking on it with the mouse. The following dialog box will appear:

![Eng Units dialog box](image)
The ENGLISH units option is the default and is currently highlighted. You may change the engineering units system by clicking any one of the four buttons English, Alt SI, SI, or Metric, or you can change any unit individually by clicking on the individual item and then selecting from the list presented. For this tutorial we will use English engineering units, therefore just exit the dialog box by clicking the Cancel button.

**DRAWING THE FLOWSHEET**

To draw the flowsheet you will be working with the flowsheet palette which looks like this:

Please note the following about the flowsheet palette:

- The first box re-invokes the arrow cursor when needed.
- The second box enables the user to rotate objects on the flowsheet.
- The next five boxes (reading horizontally) enable the user to draw the indicated primitive on the flowsheet.
- Box number eight, the “ab” box, is used to put text on the drawing.
- Box number nine is for drawing process streams (streams must connect unit operations).
- The remaining boxes each represent one of the unit operations in the CHEMCAD library.
- Pointing to a box with the cursor will cause a small descriptive label to appear which will indicate what each box represents.
- Pointing to a box and clicking with the left button of the mouse will activate the corresponding function.
• Pointing to a box and clicking with the right button of the mouse will cause a sub-palette of icon options to be displayed. Right clicking again (on the same master palette box) will cause the sub-palette to disappear.

• Multiple sub-palettes may be displayed simultaneously.

• The main palette may be switched on and off using the View\Main Palette command, by clicking on the Run Simulation command, or by clicking the S/G Power button.

• The size and shape of the main palette can be controlled using the View\Palette Settings commands.

• On the icon display, inlets are indicated by small blue circles and outlets by small red circles.

Our purpose now is to set up the flowsheet topology. Creating a flowsheet is the process of placing unit operations icons on the screen, connecting them with streams, and then adding various graphical objects to enhance the drawing. All of these things may be done using the palette.

Let’s begin our flowsheet by placing the Batch Column Unit on the screen. Please follow the procedure given below:

1. The first task is to locate the Batch Column UnitOp icon on the Palette. The icons are arranged alphabetically and whenever you point to an icon tile with the cursor, a label appears describing the tile. Therefore, move your cursor around the palette until you locate the Batch Column tile.

2. Click on this tile to select the Batch Column icon. The palette will close and the UnitOps placement cursor (a small square) will appear on your screen.

   Note that the one-line help on the bottom information bar is now giving you instructions as to how to proceed. It should currently say; “Select location for: Batch Column”

3. Move the cursor to the middle left of the screen and click again. The Batch Column icon will appear:
Note: A UnitOp ID (the number "1" in the circle) has automatically been assigned to this icon. This can be changed if desired.

This completes the placement of the UnitOp Batch Column. Notice that the palette has reappeared and is available for placing additional unitops on the flowsheet.

For purposes of instruction, let's explore some of the options associated with this icon:

a. To move the symbol:
   
   • Place the mouse arrow on the icon.
   
   • Hold down the left button on the mouse. The four windows object boxes will appear.
   
   • With the left mouse button held down, drag the icon up about one-inch, then release the left button of the mouse. The icon position has been changed.

b. It may be necessary to move the palette out of the way in order to have access to the icon. You can do this by clicking and dragging on the red bar at the top of the palette.

c. To view the object editing options: place the mouse arrow on the icon (on the flowsheet, not on the palette) and press the right button on the mouse.

d. To move or stretch an object: left click on the icon so that the four object boxes are displayed around the icon. Then click and drag on one of these boxes. The icon will grow or shrink according to the mouse movements.

Now let's place the time switch on the flowsheet. Please follow the procedure given below:
• Locate the Time Switch icon on the palette:

![Time Switch Icon]

• Click the *Time switch* icon. The palette will disappear and the UnitOps cursor will reappear.

• Move the UnitOps cursor to about one inch directly to the right of the Batch Column top outlet.

• Place the time switch here by pressing the left mouse button. Your screen should look something like this:

![Time Switch Placement]

79
We still have to place the *Tank* units on the flowsheet. Since we have three product streams (see Figure 1), we must have three Tank UnitOps. Use the above procedure to place them on your flowsheet something like this:

![flowsheet diagram](image)

**PUTTING STREAMS ON THE FLOWSHEET**

It’s now time to connect the UnitOps with streams. To do this, click the *Streams* icon box on the main palette.

![Streams icon](image)

There are a few general rules to remember when we are drawing streams on the flowsheet:

1. Each stream goes from a source unit to a destination unit.
2. Each unit has inlet and outlet positions. These are established when the symbol is created. The program always snaps streams to these positions. During the simulation, a process stream always flows from an outlet position on a source unit to an inlet position on a destination unit, but when drawing the flowsheet a stream may be drawn in any direction; that is; from an inlet position to an outlet position as well as from an outlet position to an inlet position.

3. When starting a stream, the cursor will be a small cross. When the cursor gets near an outlet position, it will convert to a black arrow. When this occurs you should left click the mouse to start the stream if that is the starting position you desire.

4. When completing the stream to a unit, the cursor will remain as a black arrow. When the cursor is near an inlet or outlet position, a label will appear indicating the location and number of the position.

5. Once the desired position has been located (as indicated by the appearance of the label), you should left click the mouse to complete the stream.

6. While drawing a stream, the palette will disappear. It will reappear only when you left click somewhere on the flowsheet which is not a UnitOp inlet or outlet point. You are not required to click the stream (link) icon tile each time you begin a stream.

7. You can alternate between placing UnitOps on the screen and connecting them with streams as long as the above rules are followed.

8. The first time you change directions of a stream, CHEMCAD will let you do so without any problem. Every additional time you change directions, you must first press the left button on the mouse to identify the longitude or latitude through which you want the stream to pass. Doing this will create an anchor point to fix the longitude or latitude on the screen.

9. You may cancel the stream drawing action by double clicking the left button during the stream drawing process.

With these rules in mind let’s place the streams on our flowsheet. First, click on the streams square: Move the cursor close to the top most outlet arrow of the batch distillation icon. When the correct outlet position is identified, press the left button on the mouse. Draw the stream over to the right with your mouse. When the left-most inlet on the time switch is identified by its label, press the left button on the mouse. CC-BATCH will draw the stream directly to that point and will place a stream ID number on the flowsheet. CC-BATCH issues ID numbers sequentially, so this ID will be Number 1. You may change it using the EDIT STREAM menu (invoked by right clicking the stream) if you would like to do so.

Let’s draw the second stream. Move the cursor around until the right-most outlet position on the time switch is located and press the left button on the mouse. Draw the stream over to the first Tank when an outlet position is identified; press the left button on the mouse again. This should complete Stream 2.

Next, let’s draw the stream from the time switch to the second Tank. Move your mouse close to the outlet on rightmost available outlet on the time switch until the black cursor arrow appears. Press the left button on the mouse. Next, draw the stream over to the second tank until the first inlet position label appears. Press the left button on the mouse to complete Stream 3.
Let’s draw Stream 4. Move the cursor near the time switch until the next outlet position is identified and press the left button on the mouse. Now, draw the stream over to the last Tank. When that inlet position label appears, press the left button on the mouse again to complete Stream 4.

Your screen should now look something like this:

![Diagram of flowsheet](image)

We are now finished drawing our flowsheet. To move on we need to close the *Edit Flowsheet* mode by clicking the *Run Simulation* command on the menu bar or by clicking the S/G button on the tool bar.

### SELECTING COMPONENTS

Next let’s identify which components are to be used in this simulation. Selecting the *Component List* command in the ThermoPhysical Menu does this. This may be done by pressing *ALT + L* or by clicking with the mouse. Do this now please. The following menu will open up:

![Component List menu](image)
To choose components from the standard CHEMCAD databank, click the Component List option with the mouse. The following Component Selection dialog box will appear. This dialog box is organized as indicated below:

"Selected Components" area: The current list of selected components will be displayed in this area.

"Component Databank" area: All components stored in the databank(s) are listed here. Components are listed in order of their ID numbers. When this area is active, a blue highlight will identify one of the components.

Insert button: This button is used to insert a component somewhere in the component list, rather than appending to the end of the list.

Add button: Clicking on the Add button will add the currently highlighted component to the end of the flowsheet component list. Components may also be selected by double clicking on them. The selected component will appear in the list displayed in the Selected Components Area.

Clear button: The Clear button is used to delete the entire component list. When this button is clicked, all of the components listed in the Selected Components Area will be erased.

Delete button: The Delete button is used to delete individual components from the component list. To use this option, highlight the component in the Selected Components Area and click the Delete button.

Selection string field: This field is used to locate a component in the databank. Once the desired component has been located, it is added to the flowsheet component list by double clicking on it or by highlighting it and then clicking on the Add button. The program locates components by
matching the string entered in this field. The string can be any alphanumeric combination. The string will be matched to any part of an ID numbers, formula, or synonym (component name) listed in the databank.

As you type in the string, the program automatically finds and highlights the closest match. As the string changes, the highlighted component changes.

**Next button:** If the current match is not the component you are looking for, click the *Next button* to find the next matching string.

**Copy Components from another job:** The *Copy Components button* is used to import the component list from another CHEMCAD job. When this button is clicked, the user is prompted to browse for the location of the CHEMCAD job from which the components will be imported. These components are the added to the *Selected Components Area*.

To show how a component is selected, let’s select propane. First, click on the *Selection String Field*, and then type in the string “propane”. As you build the string, the program will locate and highlight the component propane. To add it to the component list, click on the *Add button* or double click on “propane” in the *Component Databank Area*. The selected component will appear in the *Selected Components Area*.

Propane could just as easily been located by entering the string “C3H8” in the field. The same thing could have been done with the number “4” which is the ID number for propane. Strings, which comprise only part of the word, number, or formula, can also be used. It is also possible to highlight the desired component by clicking on it directly.

Now select the remaining components in the component list. If the first search does not locate the desired component, click the *Next button* to find the next matching string. Find the following components and add them to the component list:

- **4** Propane
- **6** N-butane
- **8** I-pentane
- **10** N-hexane

Your dialog box should now look like this:
Let's now save our list by clicking the [OK] button. The ThermoWizard will appear.

SELECTING THERMODYNAMIC OPTIONS

After the user first selects components the ThermoWizard will appear. The ThermoWizard is a system available in the CHEMCAD Suite to assist the user in making K-value and enthalpy choices.

The system works like this:

1. First, it looks at the component list and decides what general type of model is required, i.e., equation-of-state, activity model, etc.

2. Next, it looks at the temperature and pressure ranges input by the user and decides which equation within a given category is best at the limits of those ranges.

3. If the method is an activity model, the program then looks at the BIP database to see which model has the most data sets for the current problem. It then calculates the fractional completeness of the BIP matrix. If that fraction is greater than the BIP threshold parameter, it uses the chosen activity method; if not, it uses UNIFAC.

The K-Value Wizard is no replacement for engineering judgment. The Wizard makes uses an algorithm based on general rules and may not always be correct. The suggested model may not be the ‘best’ model for the system.

Selecting thermodynamic options basically means selecting a model or method for calculating vapor-liquid (or vapor-liquid-liquid) phase equilibrium (called the K-value option) and selecting a method or model for calculating the heat balance (called the enthalpy option). You do this using the ThermoPhysical command located on the menu bar (This is the same command you used to access the Component List above). Please click this option now. The ThermoPhysical menu should appear as before.
CHEMCAD has a library of about 50 K-value models with a variety of options, and about twelve enthalpy models. Making the proper selection from these libraries can sometimes be difficult. The issues involved and the proper techniques for selection are described in the Thermodynamics section of the online manual.

Because the issues involved in making thermodynamic selections and in using the ThermoWizard are beyond the scope of this tutorial, let’s assume we know that we want to use the Peng-Robinson method for both the K-value and enthalpy calculations. In this case, we would proceed as given below.

First, we need to accept the default temperature/pressure values for the ThermoWizard. The Wizard will recommend using SRK, please accept this message box. Then let us now make our own selection in the K-value Options dialog box. In the upper-left corner of this screen will be a combo box labeled Global K-value Option, which is currently highlighted. Please open this window by clicking on it.

You will notice the presence of a Scroll Bar at the right of this list indicating that all of the available options could not fit into this area. Therefore, the user may scroll through them using any of the methods previously described in this tutorial. We would like to use the Peng-Robinson method. To make this choice, please scroll up through list; point the arrow to the Peng-Robinson option; and click the left button on the mouse. The box will close and Peng-Robinson will now be displayed in the field. Your screen should now look like this:

![K-Value Options dialog box](image)

The other options on this screen are not important to us at this time. Therefore, let’s save our selection by pointing and clicking the [OK] button in the lower right corner. This will return you to the Simulation Menu Bar.

Now, let’s select our enthalpy model. Do this by again clicking the ThermoPhysical command, then clicking the Enthalpy option. The Enthalpy Options dialog box will be displayed. You will notice on this screen that the Peng-Robinson method has already been chosen. The program automatically makes this the enthalpy model when you choose the Peng-Robinson K-value method. If this assumption is erroneous, you may override it at this time. In our case, we would like to use the Peng-Robinson model, so let’s point and click on the [OK] button in the lower right portion of the screen. This will close the Enthalpy Options dialog box, saving the currently displayed options.

For the purpose of our tutorial, the thermodynamic selections are now complete.
DEFINING THE FEED STREAMS

Feed streams are input on a batch flowsheet only when the column is operating in semi-batch mode or the batch column is to be used with steady state units in a combined flowsheet. Neither of these conditions exists in this tutorial. The initial charge for the column is input in the equipment data entry screen described below.

INPUTTING EQUIPMENT PARAMETERS

Equipment parameters may be input using either the Specifications command on the menu bar or by clicking directly on the UnitOp we wish to specify. The latter is easier. Therefore, please point and double-click on the batch distillation column now. The first time through, CC-BATCH will sequentially display the necessary input dialog boxes for complete specification of the batch column configuration and operations.

The kinds of data input to the system by a user are divided into four groups. These groups are explained below.

POT CHARGE DEFINITION

This data defines the thermodynamic conditions, amount, and composition of the pot charge. It is treated similarly to a stream except that there is no rate data. Masses and enthalpy are treated as static amounts.

BATCH COLUMN SPECIFICATIONS

This data defines the column but not its operation. It includes number of stages, holdups, pressures, feed tray locations for reservoir, side product draw locations, heater/cooler locations, and the overall U, area, and ambient temperature for the heat loss calculation. Also provided here are any initial estimates the user may wish to provide.

OPERATION PARAMETERS SPECIFICATION

This data defines the operation of the column during an operation step. It includes specifications such as reflux ratio, distillate rate, total reflux boilup rate, etc., as well as the stopping criterion. It also includes startup options and receiver tank assignments.

SET SCREEN INFORMATION SPECIFICATIONS

This data defines the variables displayed dynamically as the batch run proceeds.

When entering UnitOp data for a batch column for the first time, CC-BATCH will walk you through the data entry by successively displaying dialog boxes for each of the above types of input. It will then save this input. When the user wants to return to these dialog boxes for review or editing, the Batch Column Input menu will be displayed. This menu is a gateway to the data entry dialog boxes.
INSERT OPERATION STEP SPECIFICATIONS

This dialog box allows the user to insert new operation steps. This option is very convenient and allows a very flexible handling of operation steps. If the user wants to insert a new step between step \( N \) and step \( N+1 \), he/she should input ‘\( N+1 \)’ to let CC-BATCH know that an additional new step after step \( N \) has to be added. The old step \( N+1 \) will be now identified as step \( N+2 \).

DELETE OPERATION STEP SPECIFICATIONS

This dialog box allows the user to delete operation steps. If the user wants to delete a new step \( n \) and then he/she should input ‘\( n \)’ in this field. The old step \( n+1 \) will be now identified as step \( n \).

COPY OPERATION STEP SPECIFICATIONS

This dialog box allows the user to copy all specifications from a step to another. If the user wants to copy parameters of a step to another step, he/she should input the numbers of the step source and the recipient step. The previous recipient parameters (if any) will be erased and replaced by those of the source step.

SPECIFYING THE POT CHARGE COMPOSITION AND CONDITION

We are now ready to define the Pot Charge. The Pot Charge dialog box is the first screen to appear when you select the batch column for equipment specification. Therefore, the following input dialog box should now be displayed:

Now let’s complete the pot charge input:

In the Pot Charge dialog box, you are seeking to define the thermodynamic conditions of the charge in the bottom of the distillation column. The charge is at its bubble point. Since the bottom of the column is going to see a pressure of 16.7 psia (\( PD = PT + DP = 14.7 + 2 \)), let’s have the program calculate the bubble point temperature at this pressure. Therefore, leave the temperature field blank. The program will then do a bubble point calculation to determine the temperature and enthalpy of the charge.
Now we will define the amount and composition of the initial pot charge. The user may define the amount of each component present or the fractional composition of each component present and the total charge. In our case, we want to do the latter. Specifically we want to set the total initial charge equal to 100 lb.-moles and want to define the mole fraction of each component.

The Pot Charge is 100 lb.-moles of the following composition:

- 0.1 mole fraction propane
- 0.3 mole fraction n-butane
- 0.1 mole fraction n-pentane
- 0.5 mole fraction n-hexane

You will notice that the Total Flowrate field is grayed out. This is because the Component Flow Units are lb.-moles. In any situation where the component flow units are not fractions (mole, mass, or volume), the total flowrate will always be equal to the sum of the component flowrate. CHEMCAD sums the entries as they are entered. Entering a value for total flowrate would be superfluous and therefore the field is grayed out.

To enter the composition in the desired units, we must first change the component flow units to mole fractions. Please click the Component Flow Units field now. The highlight will move to this field and a small triangle in a box will appear to the right of it. Now click on this small triangle. A list will open displaying all the available options. Scroll down this list to mole fractions (To scroll you may use the elevator bar, the arrow keys, or the [PgUp] and [PgDn] keys). When the option mole frac is displayed, click it once.

The Total Flowrate field and the Total Flowrate Units field should now be open. Therefore, please do the following:

1. Click the Total Flowrate field and enter 100.
2. Tab down to the propane field and enter 0.1. Then press the [Tab] key.
3. Your cursor should now be on the n-butane field, so enter 0.3, [Tab].
4. Enter 0.1 in the n-pentane field.
5. Enter 0.5 in the n-Hexane field.
Your dialog box should now look like this:

![Image of dialog box]

In order to exit this menu and save the data, you should click the [OK] button in the upper right-hand corner of the dialog box. This will save the data and automatically display the **Batch Distillation Column dialog box**.

**SPECIFYING THE COLUMN CONFIGURATION**

After specifying the charge composition and conditions, the program will prompt you to establish the column configuration. This is done by displaying the **Batch Distillation Column dialog box**.

In this example problem, we have 8 stages, five operating steps, internal stage holdup is 0.01 cubic feet, the condenser holdup is 1 cubic foot, pressure at the top of the column is 14.7 psia, and the pressure drop across the column is 2. It is okay to assume that the condenser has essentially no pressure drop. The column configuration menu should be completed like so:
You will notice page tabs, labeled **General** and **Misc.** in the upper part of the dialog box. We are currently on the **General tab**. The **Misc. tab** provides additional options. These options are not used for this simple example so we will not look into them now.

Once the input has been entered, click the **[OK]** button with the mouse. This will save the data and automatically display the first **Batch Operating Parameters dialog box**, which is used to define the operating steps of the column.

### DEFINING THE OPERATING STEPS

For this simulation there are to be five operating steps, sequentially one after the other. It is now time to define what the operating parameters are for each step.

#### OPERATING STEP 1

The **Batch Operating Parameters dialog box** data input screen must be completed for each of the five operating steps. Let’s go through the input fields item by item to learn how they are to be completed.

1. **Start-Up Option** – Please click on this field to list available options.

   The first step starts from total reflux. Therefore, please click the **Total Reflux** option. The list will then close.

2. **Product Assignment** – The product assignment fields identify which accumulator a product or decant stream is to be sent to. It is not necessary to actually place accumulation tanks on the flowsheet to use this option (although we did); simply designating a unit ID number will be sufficient. Obviously, you must be careful not to designate a unit ID number that is being used by some other unit in the flowsheet (which is not a tank). These ID numbers may be chosen arbitrarily and...
switched as often as desired. In this way, the user may keep track of output from individual operating steps or combinations of operating steps if desired.

Since CC-BATCH permits vapor-liquid-liquid distillation, there may be two liquid phases in the condenser, possibly giving rise to decanting of one phase or the other. The need for multiple overhead accumulators thus arises and is permitted in the program.

**Distillate Tank #** - The overhead tank accumulates the distillate.

**Decanter Tank #** – The decanter tank accumulates the decanted liquid (if any).

In this particular example, no decanting takes place, so only the Distillate Tank # field is filled in. Enter a [3] (indicating the Tank with Unit ID 3) here and strike the [Tab] key #. Now move to the **First Spec Mode** field.

3. **First Spec Mode** – When a batch column is refluxed, you must make two operating specifications for each operating step. Click the field with the mouse to open the combo box:

As Table 1 explains, the first specification for operating step number 1 is to set the reflux ratio equal to 5. Therefore, select *Reflux ratio* for this mode. You may do this by clicking on it with the mouse or by using the arrow keys to highlight this selection and then pressing the [ENTER] key. Since *Reflux ratio* is the default for the first mode, the highlight will already be on this selection.

4. **First Spec Value** – Now move to the First Spec Value field by clicking on it with the mouse (if you are using the [Tab] key you will already be there). In the First Spec Value field we will enter the numerical value of the reflux ratio, i.e., 5. Therefore, please enter [5] in this field and then press the [Tab] key.

**Component** – Component not shown on screen unless it is needed.
5. **Second Spec Mode** – Now click the **Second Spec Mode** field display the list of the available options. The mode we want to select (Distillate Mole Flowrate), is the first (default) mode. Therefore, strike the [Tab] key to make this selection and move to the next field.

6. **Second Spec Value** – Just as in mode 1 above, we will now define the numerical value for the second specification. This is 2 lb.-mole/hour, therefore, enter [2] in this field.

7. **For Subcooled Condenser Only** – If a subcooled condenser is present, the actual subcooled temperature or the degrees of subcooling may be specified. There is no subcooling in this example so these fields may be ignored.

8. **Integration Time Step Size in Hours** –

   **Step Size (HR)** – This field provides the integration time step size in hours. The default value is 0.05 hours. The user may override this value if he/she so desires. In this case, we will not do so. Therefore, please move on to the next field.

9. **Record Frequency** – CC-BATCH generates a lot of output data. It is generally not necessary to record all of the information calculated at each time step on the hard disk. Therefore, in the default condition, CC-BATCH only records the information at every third step. If the user should wish to record the information more or less frequently than that, he/she may do so by entering the desired frequency in this field. In our case, we will leave the default value of 3. Therefore, please move to the next field.

10. **Operation Stop Option** – The user may select from a variety of criteria to establish when an operating step is to be stopped. Three fields, **Stop When**, **Stop Value** and **Measured Value**, define the criteria for stopping this operation. To see how this works, click on the **Stop When** field and open the window (click on the field with the mouse).
Stop When – As you can see from the screen, the Stop When field allows the user to define whether the operating step is to be stopped based upon time or whether it is to be stopped based on some condition existing in either the accumulator, the distillate, or the residual charge in the bottom of the column. We want to stop step 1 when the mole fraction of butane in the distillate reaches 20%. Therefore, our Stop When criteria is the distillate. Therefore, please select Distillate.

Stop Value – This is the numerical value of our stop criteria, 20% in our case. Therefore, enter a [0.2] in this field and move to the Measured Value field.

Measured Value – This field allows us to identify what value of the distillate 0.2 represents. Please click on the choice box and view the options.

In this example, 0.2 represents the mole fraction of n-butane. Therefore, select mole fraction here. When you do this three additional fields will open: the Use multiple components field, the First component field, and the Last component field. Cued by our identification of the Measured Value as a mole fraction spec, the program opened these fields knowing them to be what we need to complete our specification. Different Measured Value selections will produce different fields.

Use multiple components – Purity specifications can be made for a single component or for a range of components. A checkmark in the Use multiple components field indicates that the specification is for a range of components. In this event the first and the last component in the range must be identified. Obviously then the components in a multiple components specification must be contiguous within the component list for the flowsheet. This is the default condition.

The specification we want to make however is for a single component. Therefore, we need to click the Use multiple components box to remove the checkmark. When we do this, the Last component field will disappear and the First component label will change to Component.

Component - We will use this field to identify n-butane as the component which to have a mole fraction of 0.2 in the distillate. The operating step is to stop when this condition is met.

11. Stop Tolerance – This field defines how close to the specification made above we must be before stopping. The default stop tolerance is 0.001. That is generally an adequate value and we will leave it alone for this case. Therefore, please move on to the next field.

12. Minimum Run Time – Some specification values will go through maximums during the simulation. This situation can cause the program to stop earlier than intended. To prevent this, the user is asked to specify a minimum runtime. Let’s use half an hour here, so please enter [0.5] in this field.

The remaining fields on this data entry screen are not necessary for the input of this operating step and therefore will not be explained here.
Your screen should now be filled in as shown:

![Batch Operation Parameters](image)

Now click the [OK] button with the mouse to move on to Operating Step 2.

**OPERATING STEP 2**

In Operating Step 2, we want to change the reflux ratio to 20, keep the distillate rate at 2 lb.-moles per hour, and stop the operation when the mole fraction of butane in the distillate is equal to 0.985. Therefore, you should complete the menu for Operation Number 2 as follows:

![Batch Operation Parameters](image)
Now click the [OK] button with the mouse.

**OPERATING STEP 3**

In Operating Step 3, we are going to switch the distillate to UnitOp 4 (the second tank), increase the reflux ratio to 25, keep the distillate flow rate 2 lb.-moles per hour, and stop the operation when the mole fraction of butane in the accumulator is equal to 0.99. The **General tab** of this dialog box is therefore completed as shown below:

![Batch Operation Parameters dialog box](image)

In addition, at the beginning of the operating step, we want to add 20 moles to the pot of a mixture which is 40% butane and 60% hexane. To do this we need to use the **Add material to pot** option on the **Additional Settings tab** of the dialog box. Please click on this tab now and click on the **Add material to pot** field. A check mark should appear in this field as follows:
This time when you click the [OK] button to exit the Batch Operation Parameters dialog box, an Edit Batch Change/Add dialog box will appear. This dialog box is to permit the user to define the thermodynamic conditions and composition of the material being added to the pot. In our case, let’s set the temperature equal to the bubble point at 16.7 psia. Therefore, please enter a 16.7 in the pressure field, 0.0 for vapor fraction, and leave the temperature and enthalpy fields blank. We must also set the composition and amount added to 0.6 mole fraction n-butane, 0.4 mole fraction n-hexane, and 20 lbmoles total. To do this click on the Comp Unit field and open the units options list. Select mole fractions. Enter 0.6 for n-butane and 0.4 for n-hexane. Then enter 20 in the Total flow field.

Your screen should look as shown below:
Then click the [OK] button to save the data and move on.

**OPERATING STEP 4**

In Operating Step 4, we are going to switch the distillate to UnitOp 5 (the third tank) reduce the reflux ratio to 15, maintain the distillate rate at 2 lb moles per hour, and stop the operation when the mole fraction of hexane in the distillate equals 0.2. We will also enter 0.5 for the minimum runtime to make sure the step runs at least 30 minutes. Therefore, your menu should be completed as follows:

![Batch Operation Parameters](image)

Now click [OK].

**OPERATING STEP 5**

In Operating Step 5, we are going to increase the reflux ratio to 25, maintain the distillate rate at 2 lb moles per hour, and stop the operation when the mole fraction of hexane in the residual charge in the bottom of the column is equal to 0.9998. We will also enter 0.5 for the minimum runtime to make sure the step runs at least 30 minutes. There are no other special operating features in this step. Therefore, you should complete the operation 5 dialog box as follows:
Now, click [OK] to enter the data. CC-BATCH will now display the RunTime Information menu.

**RUNTIME INFORMATION**

The **Runtime Information** menu allows the user to choose which variables are plotted on the screen during calculation. A wide variety of options are available as the screen shows. For this example, let’s display the distillate mole fractions of all four components during runtime. This is the default output for the batch distillation column.

Your screen should now look like this:
After completing this dialog box, click the **OK** button. The **Runtime Information** dialog box will close and the **Batch Distillation menu** will appear. This menu allows the user to return to any of the above screens by clicking the appropriate choice.

All the input data has been entered now and we are ready to run the simulation. But first we must exit the current menu. Please click the **Exit** button on the **Batch Distillation menu**.

### RUNNING THE SIMULATION

To run the simulation, point and click on the **RUN** command on the top-level menu or press the **[ALT + R]** keys. This will cause the **RUN menu** to open up like this:
Even though batch distillation is a dynamic process, CC-BATCH is run from the Run All command. When this command is executed, CC-BATCH will first check the input data for errors or omissions. If any are found, messages will be sent to the screen indicating the error(s). Two types of messages may be issued:

- **Error Messages** – These are errors or omissions, which must be fixed before the simulation can proceed. Under specification of the batch column would be an example of this type of error.

- **Warning Messages** – These are usually input omissions, which may or may not cause problems upon execution. These are non-fatal and therefore do not need to be dealt with or corrected prior to simulation. They are for the users information and based upon these messages the user may choose to make changes or not.

In this example, if all input has been done correctly, there should be no messages of any kind and the program will proceed directly to the calculation. Please click on the Run All command now.

You will notice during the simulation that the mole fractions in the distillate are plotted on the screen in a plot window. This is because we requested this in the Runtime Information dialog box during the batch column input. In addition, you will notice that each time the program proceeds to a succeeding operating step a new plot window will open. This new plot window will be maximized (will fill the screen) and you will be able to see only those results from the current operating step. You can change this by tiling or cascading the open windows using the Window\Cascade or the Window\Tile commands.

When the simulation is finished, the dynamic plot will quit scrolling.

If you have not done so already, click the Window command on the menu bar and then click the Tile command on the menu that opens up. The open windows will tile and your screen should look something like this:
To proceed, let’s close all the plot windows and take a look at the review features of the program.

**REVIEWING THE RESULTS INTERACTIVELY**

Once the simulation is complete, we will want to review the results interactively before printing a hardcopy. We do this using the *Results* and *Plot* commands on the menu bar.

**PLOTTING THE RESULTS**

For batch calculations the most convenient way to examine the output is to plot the results. To do this, you would use the *Plot* command. Therefore, click the *Plot* command on the menu bar. The *Plot Menu* will open.
We want to plot the results of a batch distillation simulation, so we want to plot a \textit{Batch Column History}. Therefore, please select this option now. The \textit{Select UnitOp(s)} dialog box will appear. Click the batch column icon. The UnitOp ID number (1) will appear in the dialog box field. Now click [OK]. The \textit{Select UnitOp} dialog box will close and the \textit{Batch Column Options} dialog box will appear like so:

![Batch Column Options Dialog Box]

This dialog box is similar to the \textit{Runtime Information} dialog box that was used before running the simulation. To plot the distillate mole fractions we need to do the following:

- Select mole fractions
- Select the distillate
- Select components (enter their position numbers)

Leave the \textit{Operating Step} field blank so that all operating steps will be plotted in the same window.

Now click the [OK] button and the following plot will appear:
You are now in a plot window and your available commands have changed. These commands are the same for every plot (except for the title). This window is similar to other graphics windows in CHEMCAD, and the following commands are available:

- **File** For printing and print management, job management, window opening and closing
- **Edit** The Undo, Cut, Copy and Paste commands
- **View** To turn the tool bar and the status bar on and off
- **Graph** For performing various plot editing and data transfer functions
- **Window** For windows management (tiling, cascading, etc.)
- **Help** For help with the plot edit functions

At this point, let’s make note of a few important items regarding CHEMCAD plots.

1. To zoom in on a certain section of the plot, point to one corner of the area that you want to zoom in on, and then click-and-drag (i.e., hold down the left mouse button while you are moving the cursor) to the opposite corner of that area. When you release the mouse button, the program will zoom in on the boxed in area. To restore the original size, click on the **Graph** command (on the menu bar); then click on the **Zoom Out** command.

2. The plot title text (in this case, *Batch Column 1, Distillate*) can be edited using the **Graph\Edit titles** command.

3. The color, size, layout and various other aspects of the plot presentation can be edited using the **Chart Explorer** function.

4. A hardcopy of this plot can be obtained by clicking the **Print button**.

This finishes our plot exercise. Please return to the **Simulation** window by closing the current window.
REVIEWING BATCH RESULTS

Certain batch results can also be viewed in tabular format. To do this, please point and click on the Results command or press [ALT + U] now. When you do this, the Results menu will appear. Please point and click on the Batch Results option now. A summary of the results of this simulation will be displayed in tabular format inside a Wordpad window like so:

![Batch Results Table](image)

This display provides a summary of the batch simulation at the end of each operating step. You may browse, edit, or output this display using any of the Wordpad commands. The WordPad commands can be used to edit and/or print the results. After browsing, return to the main CHEMCAD window by closing the Wordpad window.

GENERATING A FULL REPORT

In order to generate complete tabulated reports you use the Output/Report command:

1. Click the Output option on the menu bar. A menu will open.
2. Click the Reports option on the menu. A Reports menu will open.
3. Click the Batch/Dynamic Results option on the Reports menu. The following dialog box will appear:
Complete this screen as desired then click the [OK] button. You will be returned to the Reports Menu. Then select Calculate and Give Results. The report will be generated and displayed in a Word window. You are now in a position to browse, edit, and print the report as desired using any of the available Word commands.

We are now finished with our tutorial. To leave CHEMCAD, close the Word window, and then close the Simulation window. You will be asked if you want to save the work you have done on this job, answer yes. The input and output will then be saved in a file called Batchdis.ccx which will be stored in a subdirectory called Batchdis located within the main directory CC5DATA. You will then be returned to the Top Level Window. Close this window as well and you will be returned to the operating system.

**SUMMARY**

During this tutorial we have accomplished the following things:

1. Set up a new problem.
2. Drawn our flowsheet.
3. Selected components and specified thermodynamic options.
4. Prepared our batch column input.
5. Run the simulation.
6. Plotted and viewed the results interactively.
7. Produced a tabulated report of results.

These are the major functions within the process simulation portion of CC-BATCH.
CHEMCAD USER’S GUIDE

SETTING UP A STEADY STATE SIMULATION – AN OVERVIEW

There are ten basic steps involved in preparing, running, and documenting a process simulation in CC-STEADY STATE. These are:

1. Starting a new job
2. Selecting engineering units
3. Creating a flowsheet
4. Selecting components
5. Selecting thermodynamic options
6. Inputting feed (and cut) stream data
7. Specifying unit operations
8. Running the simulation
9. Reviewing the results
10. Producing reports and PFD’s

These steps do not have to be performed in this order nor do all of them have to be completed for each flowsheet. All should be considered for each problem.

There are a series of Help facilities available throughout the program. The bottom line of the screen provides a one-sentence description of the current highlighted item. The Help command provides access to the On-line Manual, which contains comprehensive technical information. The [F1] key provides context sensitive help (place the cursor in a specific field and press the [F1] key). The Coach facility will provide instructions on how to perform selected tasks. Use of these help facilities will ease your way through the program.

CHEMCAD is object oriented. Therefore, most input and editing can be done by left or right clicking the object of the operation, as well as by using the menu commands.

All stream and unit operations specifications (input) are accomplished using dialog boxes. These dialog boxes are context specific and employ some combination of character fields, combo boxes, choice boxes and check boxes.

Major program activities are organized around the following features:

- The Menu Bar
- The Graphics Palette
- The Toolbar
- Microsoft Word (reports are displayed in Word)
- Microsoft Wordpad (View command results are displayed in Wordpad)
- The Plot Window(s)

See also:
STEP 1: STARTING A NEW JOB

CHEMCAD keeps track of flowsheet data by storing it in a set of files named (Jobname).xxx. The extension is a function of the type of information stored in the file. These files are stored in a subdirectory called (Jobname) under the working directory. When a new job is started, CHEMCAD opens this subdirectory and uses it as the current directory. See “How to Start a New Job” for procedural details.

Note: In the default condition the working directory is a folder called CC5DATA off the root directory. The user can change this by giving a different name at installation or by using the File\Switch Work Folder command in the Top Level Window.

A new job is started from the Top Level window using the File command on the Top-Level menu bar. Standard Windows file naming and management conventions are used. CHEMCAD creates the new subdirectory (mentioned above), and opens the job by moving into the Simulation window. This is the main working window of the program.

STEP 2: SELECTING ENGINEERING UNITS

The default set of engineering units used in CHEMCAD is the English system (°F, psia, lb-moles, etc.). The user may change the engineering units using the Engineering Units option under the Format command on the main menu bar. The standard engineering system English, SI, Alternate SI, and Metric are available or units selections may be made item by item.

Internal units used inside CHEMCAD are °R, psia, Btu, lb-moles, feet and hours. All internal CHEMCAD functions use these units. However, CHEMCAD automatically converts all displayed units to the current profile.

For a detailed description of the procedure for changing engineering units see “How to Select Flowsheet Engineering Units”.

Tip: If user input/output data is not in the same engineering format (i.e. temperatures must be input in °C and °F for the same job), the CHEMCAD Suite has a very convenient online unit converter. This tool is activated when the user presses the [F6] key in fields of UnitOp dialog boxes and stream edit screens. To use this feature the user should:

- Place the cursor in the input field, press the [F6] key and the appropriate list of units will appear.
- Input the value in the desired engineering unit field.
- Press [Enter]. The program will convert the value in the different units available.
- Press [OK]. The value input by the user will be input into the field in the current engineering unit profile.
STEP 3: CREATING A FLOWSHEET

To simulate a flowsheet it is, of course, necessary to define the flowsheet. In CHEMCAD, this is done graphically by selecting unit operations models (called UnitOps) from the library, placing these on the flowsheet, then connecting them with streams. This creates an object-oriented drawing around which the flowsheet specification is organized.

Flowsheet creation can only be done in the Edit Flowsheet mode. The presence of the graphics palette indicates that you are in this mode. Whenever you start a new job, CHEMCAD automatically places you in this mode. To switch out of it (into the Simulation mode) click the Run Simulation command on the menu bar or the S/G power button on the Toolbar.

All graphics functions are performed using the palette. For a full description of these commands and their use, see “How to Draw a Flowsheet”.

STEP 4: SELECTING COMPONENTS

CHEMCAD is supplied with a physical properties database of about 2000 components. These components range from hydrocarbons, to chemicals, to ions, to solids. The data is gathered from a variety of literature sources. All components have enough data stored to model the types of applications for which they were intended, but no component stores data for every physical properties item in the database. The user may review the data stored for each component using ThermoPhysical\Databank\View-Edit command.

The user cannot change data in the CHEMCAD physical properties database. If the user wishes to edit the CHEMCAD supplied component data, he/she must first copy the data into a local user database where it will be assigned a new ID number. Data stored under the new ID numbers can be edited using the View-Edit Properties option mentioned above.

If data for a given component is not available in the CHEMCAD database, the user has the following options:

1. Look up and enter the data manually using the View-Edit Properties option mentioned above.
2. Instruct CHEMCAD to estimate the properties using either the pseudo-component (hydrocarbon) or the group contribution (chemicals) methods. These options can be exercised using the New Component option on the Databank menu under the ThermoPhysical command on the menu bar.
3. Regress raw data using the Pure Regression option under the Tools command.

The physical properties data supplied in this fashion will always be stored in one of the user databanks.

To facilitate physical properties data management on the organizational level, the CHEMCAD Suite recognizes three types of physical properties databanks: the CHEMCAD databank, the local user databank, and the organizational (central) pool databank. The CHEMCAD databank is located in the CC5 directory.

User databanks are located either in the CC5DATA directory or in the flowsheet subdirectory. The pool databank is located in the CC5 (CHEMCAD program) directory on the LAN server. Components stored in the CHEMCAD databank have ID numbers from 1 – 5,000. Those in the pool databank have ID numbers from 6,001 – 8,000. Those in the local user databanks have ID numbers from 8,001 - 9,999. The ID numbers 5,001 – 6,000 are reserved for pseudo-components generated from distillation curves.
Components are selected for a particular job using the Component List dialog box. By selecting the Component List option under the ThermoPhysical command on the menu bar.

See “How to Select Components for the Component List” for details.

STEP 5: SELECTING THERMODYNAMIC OPTIONS

The phase equilibrium behavior of mixtures is simulated using K-value and enthalpy (H) models. The proper K-value and H models for a given application depend upon the nature of the solutions (both vapor and liquid) formed at the system temperature and pressure. This in turn depends upon the components in those solutions. CHEMCAD offers a variety of K and H models to handle a wide range of mixtures. Applications include ideal and regular solutions, polar solutions, electrolytes, polymer-solvent mixtures, vapor phase association, miscibility gaps, crystallization, and supercritical extraction among others.

K-value models include:

- Equations-of-state
- Activity coefficient models
- Vapor pressure models
- Electrolyte models
- Empirical models
- Special models for polymers, sour water, amines, glycol’s, etc.

Enthalpy models include:

- Equations-of state
- Latent heat
- Electrolyte
- Heat of mixing
- Empirical methods
- Special systems

The user may add his/her own K and/or H models if desired.

To assist the user in making K and H model selections, CHEMCAD provides the ThermoWizard option, which is automatically launched when the user first selects the components for the job but can also be found under the ThermoPhysical command on the menu bar.

K-value and enthalpy model selections are made using the K-value Options dialog box and the Enthalpy Options dialog box respectively. These dialog boxes are called by selecting the K-value and Enthalpy options under the ThermoPhysical command on the menu bar. Please see “How to Select K-value Options” and “How to Select Enthalpy Options” for details.

Many K-value methods require the use of fitting parameters called BIPs (binary interaction parameters) to achieve adequate accuracy. BIPs quantify the interactions between two different compounds. These must be correlated with experimental data using a regression facility. For certain equations (NRTL, UNIQUAC, Wilson, SRK, Peng-Robinson, BWRS, ESD, SAFT, MNRTL and Pitzer) CHEMCAD maintains a database of BIP’s. It is not practical, however, for this database to support the universe of
possible combinations of molecules. Therefore, CHEMCAD provides two facilities for handling gaps in BIP data:

1. Equilibrium data regression facilities. These are found under the BIP Regression and Electrolyte (Regression) options under the **Tools** command on the menu bar.

2. Activity coefficient estimation using the UNIFAC group contribution method.

### STEP 6: INPUTTING FEED (AND CUT) STREAM DATA

In any simulation problem, all feed streams must be completely defined before the calculation can begin. For a stream to be completely defined there must be enough information present to calculate the enthalpy. For mixtures, this requires the composition plus any two of the temperature, pressure, or vapor fraction. For pure components that are superheated or subcooled, temperature and pressure must be specified. For pure components that are saturated or two phases, it is necessary to define the composition and the vapor fraction plus either the temperature or the pressure. By convention, CHEMCAD does not permit the user to input the enthalpy of a stream.*

Total stream flowrates are defined in one of two ways.

1. If the composition is given in mole fractions, mass fractions, or volume fractions, then the user must enter the total flowrate.

2. If the composition is given in any other units, then the total flowrate is the sum of the component flowrates.

In certain simulation problems the cut streams must be defined or convergence cannot be achieved. This normally occurs when the cut stream (or some stream down stream of it) feeds a unit operation, which cannot converge if its inlet is empty. For example, if the top stream to a reboiled absorber is a recycle cut stream, then the absorber will not be able to converge during the first recycle iteration unless an estimate of this stream is given. This in turn leads to convergence failure for the recycle loop itself.

Feed streams and cut streams are both entered using the **Edit Streams** dialog box. This dialog box is called by double clicking on the stream while in the **Simulation Mode**.

See also: “How to Define Feed Streams”.

*There is one exception to this rule. If all other fields are blank (i.e., composition, T, P, and V/F are not given), then the enthalpy may be specified. This is useful for defining heat duties in certain situations.*

### STEP 7: SPECIFYING UNIT OPERATIONS

Unit operations models (or UnitOps) represent process equipment. These UnitOps receive feed or materials data from their inlet streams, operate on those streams by executing their equations, and then write the results to their outlet streams and, in the case of non-stream results, to its UnitOps parameter list. Since CHEMCAD UnitOps are flexible in their capabilities, the user must tell the program exactly how each is to operate by defining certain input parameters. These parameters are entered using a dialog box specific to the UnitOp, and are saved by the program in the same parameter list mentioned above. This parameter list, together with its inlet and outlet streams contains all of the information, both input and output, associated with a particular UnitOp.
With a few exceptions, each unit operation adds one or more degrees of freedom to the calculation when it is placed on the flowsheet. Each degree of freedom requires the user to make one (non-pressure) specification in order for a unique solution to exist. Since CHEMCAD is a modular sequential simulator, it requires that specifications be made in the UnitOp, which added the degree-of-freedom. For example, an HTXR (heat exchanger) unit adds one degree-of-freedom to the flowsheet, so one specification must be made in the HTXR dialog box.

Some UnitOps create a different number of degrees of freedom in different situations. CHEMCAD knows how many specifications are required for each UnitOp in all situations. It will tell you if you are under or over specified when you try to save the UnitOp data.

The complete CHEMCAD process simulation suite provides a library of about 60 unit operations. The user may add his/her own UnitOps to the library as desired.

For the details of UnitOps input, see “How to Specify Unit Operations”.

STEP 8: RUNNING THE SIMULATION

These are two ways to run a simulation in CHEMCAD:

- One is to click on the **RUN** command on the Menu Bar. The Run Menu will appear enabling you to run all or part of the flowsheet.
- Another is to click on the **RUN power button** on the Tool Bar. This will execute the entire flowsheet.

It is also possible to run one unit at a time by right clicking on the desired UnitOp. A menu will appear and one of the options will be to **Run this unit**.

CC-STEADY STATE and CC-BATCH applications are executed using the steady state command(s).

See also:

- “Running Simulations - An Overview”
- “Running Steady State Simulations”

STEP 9: REVIEWING THE RESULTS

Simulation results are reviewed interactively using the **Results** and **Plot** commands on the menu bar. The **Results** command displays results in tabular text format. All **Results** displays are in Wordpad. The **Plot** command displays results in graphical format in a graphics-editing window. The available types of information and the basic layout of that information are determined by CHEMCAD. The specific information and its specific format are user specified.

**Results** outputs are displayed in Wordpad and can be printed from that program. **Plot** results are sent to a plot window and may be printed to available printers using the CHEMCAD print facilities.

See also:

- “How to View Stream Compositions”
- “How to View Stream Properties”
- “How to Plot”
STEP 10: PRODUCING REPORTS AND PFD’S

For the purposes of formal documentation, the CHEMCAD Suite offers two facilities: the Report and the PFD. The Report is for tabulated results. The PFD (Process Flow Diagram) is a drawing, which displays the flowsheet heat and material balance, and any additional information the user desires.

See also:
- “How to Create Reports”
- “How to Create PFDs”

COACH

In order to make the use of the program easier, besides Help, CHEMCAD provides the user with an online assistant called “Coach”. Coach is accessed by using the Help command. When this is done the screen splits as shown:

Selecting one of the options at the right will display a set of instructions for performing the desired operations. If the first level of instructions is not detailed enough, the user may click on any of the instructions listed and a more detailed explanation of how to perform that step will appear. It is also easy to move back and forth through the display hierarchy.

Coach facilities are provided for all of the major features of CHEMCAD.
GETTING STARTED

The first time you run CHEMCAD, a “Report Viewer Setting” screen will appear as shown below:

This screen allows you to specify where reports are sent. You must locate the programs on your machine using the **Browse** buttons. For reports, you may use either Microsoft Word or WordPad. For viewing smaller data output (like stream data, tower profiles, etc.), you may only use Microsoft WordPad.

First, click the **Browse** button for the report viewer. This will bring up a dialog box similar to this one:

From this screen, you can navigate (by clicking on the appropriate drive/folder) until you reach the correct directory. For Microsoft Word, this is typically \Program Files\Microsoft Office\. For Microsoft Wordpad, this is typically \Program Files\Accessories\. Once you see the Microsoft Word or Wordpad shortcut, double click it to select it. You will return to the **Report Viewer Setting** dialog box. Repeat the procedure for the simple file viewer and you are finished.
The CHEMCAD main window will appear like this:

Title Bar
Menu Bar
Toolbar
Status Bar

The top line is called the **Title Bar**. It contains the CHEMCAD logo and name on the left side, and the WINDOWS minimize, tile, and close buttons on the right side.

The next line is called the **Menu Bar**. This bar contains the top-level commands for CHEMCAD. They are:

- **File**
  This command is used to open jobs, create new jobs, access print and report setup, and manage the license configuration.

- **License**
  This command is used to configure license, update dongles, authorize special licenses.

- **View**
  This command is used to turn on and off the tool and status bars.

- **Help**
  This command is used to access CHEMCAD’s help system.

The third line (or bar) is called the **Tool Bar**. It contains the symbols to directly invoke short cuts to various file functions that would otherwise be accessed through the menus.

The white area, which constitutes most of the screen space, is inactive at this level, but contains the license agreement for CHEMCAD. It is important that you read and understand this agreement.

The last line of the CHEMCAD window is called the **Status Bar**.

The **Top Level Window** is only one of the windows available in the program. CHEMCAD’s menu structure changes when you load or create a job. In the course of this tutorial, you will be introduced to the most important of these menu functions and their use.
HOW TO START A NEW JOB

To start a new job you must select the **New Job** function on the **File** menu (or click the New Job button on the toolbar), specify a name to save the job under, and click the **Save** button. When this is done, you are ready to begin working in your new job and its flowsheet.

**BRIEFLY**

1. Click the **New Job** button on the **Top Level** toolbar.

   ![New Job Button](image)

   The **Save As** dialog box will appear.

   ![Save As Dialog Box](image)

   2. Type the job name in the field provided.

   3. Click the **Save** button.

   4. The Unit Operation palette appears and you are ready to begin building the flowsheet.

**DETAILS**

1. Call the **New Job** dialog box. There are two ways to do this:
   a. From the **Top Level Window** menu bar. The **File** command is used for this. To open the **File** menu, you may:
      - Click the **File** command, or
      - Push **[ALT + F]**
The following menu will appear:

Now choose the **New Job** option by:

- Clicking **New Job**, or
- Pressing the [N] key.
- Pressing Ctrl+N

The **Save As** dialog box will open (see above).

b. From the **Top Level** toolbar click the **New Job** button on the **Top Level** toolbar. The **Save As** dialog box will appear.

2. Type the new job name in the field provided.

The **Save As** dialog box prompts you to enter a new job name. The job name may be any alphanumeric name.

Once the name has been entered, close the dialog box by clicking the **Save** button.

The Unit Operation Palette will appear and you may begin working with your new job.

---

**HOW TO SELECT FLOWSHEET ENGINEERING UNITS**

To select engineering units for a flowsheet, you must select the menu option **Format** and then select the option **Engineering Units**. This will bring up the following dialog box:
RESETTING CURRENT UNITS TO A PREDEFINED PROFILE

To select an engineering units profile for a flowsheet:

1. The \textbf{Format} command on the menu bar. The following menu will appear.

2. Select the \textbf{Engineering Units} option from this menu. The \textbf{Engineering Units Selection dialog box} will open.

3. Press one of the four buttons, \textbf{English}, \textbf{ALT SI}, \textbf{SI}, or \textbf{Metric}. Any of these buttons will automatically reset all of the options on the page to the selected profile.
The ENGLISH system is the default profile.

EDIT CURRENT ENGINEERING UNITS PROFILE

To select or change engineering units one by one, you must select the unit that you would like to change by clicking the drop down menu box you intend to change. When this occurs you will be presented with a list of alternatives, and you simply click on the units of your choice. For example with Mass/Mole:

Make all of the necessary edits in this manner. When all desired selections have been made, close the dialog box by clicking the [OK] button.

Note: If you click one of the pre-defined profile buttons after you have made changes to individual unit settings, you will lose the changes you made.

CREATE A DEFAULT ENGINEERING UNITS PROFILE

If you would like to create an engineering units profile that you can use in all or some of your other jobs, you may do so in the following manner.
1. Select the **Engineering Units Selection** dialog box as detailed above.

2. Make the appropriate changes to the engineering units using the method described above.

3. Select the **SaveProfile** button to save the profile. You may exit the screen now by pressing the **Save** button.

4. The next time you want to use the profile you created here, you simply go to the **Engineering Units Selection** dialog box, and then select the **LoadDefault** button.

---

**CREATE A USER ENGINEERING UNITS PROFILE**

If you would like to create an engineering units profile that you can use in all or some of your other jobs, you may do so in the following manner.

1. Select the **Engineering Units Selection** dialog box as detailed above.

2. Make the appropriate changes to the engineering units using the method described above.

3. Enter the name of the profile into the field next to the **Save Profile** button.

4. Click the **Save Profile** button to save the profile. The new profile is now saved and available for future use. You may exit the screen now by pressing the **Save** button.

5. The next time you want to use the profile you created here, you simply go to the **Engineering Units Selection** dialog box, enter the name of the profile in the field next to the **Save Profile** button, and then select the **Load Profile** button.

---

**GRAPHICS COMMANDS – AN OVERVIEW**

The CHEMCAD graphics functions are used to:

- Draw flowsheets
- Plot the results of calculations
- Create process flow diagrams

Each of these operations is performed in different types of CHEMCAD windows:

- Flowsheets are drawn in the CHEMCAD window called the **Edit Flowsheet Window** sometimes called the **Edit Flowsheet Mode**.
- Plots are displayed and edited in **Plot Windows**.
- Process flow diagrams are created in the **PFD Window**.

While there are many graphics commands common to all of these windows, each window also has unique commands and facilities specific to its purpose. An overview of each of these windows is provided below. A description of the common graphics commands follows the windows descriptions.

---

**DRAWING FLOWSHEETS IN THE EDIT FLOWSHEET MODE**

The **Edit Flowsheet Mode** is the main CHEMCAD graphics window. This mode is used only for flowsheets. Simulation input, calculation, and reporting is done in the **Simulation Mode** of CHEMCAD.
This section will be concerned only with those graphics commands and features that are used to draw, embellish, and edit the flowsheet.

The main graphics features and concepts of the Edit Flowsheet Mode are:

1. The primary tool for drawing flowsheets is the Main Palette. It contains the UnitOp icons, the stream drawing function, the text function, and several other graphic facilities.

2. To use the Main Palette, you must be in the Edit Flowsheet mode. Being in the Edit Flowsheet mode also activates several other drawing capabilities.

3. Other menu bar commands which are sometimes used in the process of drawing and editing flowsheets are:
   - The Edit command which provides the functions Redraw, Undo, Redo, Cut, Copy, Paste, Delete, Select All, Create DXF, Metafile to Clipboard, and Symbol Builder.
   - The View command, which provides the functions, Zoom, Toolbar, Status Bar, Main Palette, Grid Visible, Change Grid Size, Show Page Bounds, and Stretch Proportionately.
   - The Format command containing Bring to Front, Send to Back, Fill Pattern, Pen Style, Arrowheads, Color, Font, Align, and Import Bitmap.

4. Object oriented graphics editing capabilities are accessed using the Edit Object menu. You open this menu by right clicking on the object to be edited.

GRAPHICS FEATURES OF THE PLOT WINDOW

You enter a plot window from the Simulation Window using the Plot command. This means you never enter an empty plot window. There is always a display present and the purpose of the Plot Window is to enable us to view and edit the plot.

The main features of the Plot Window are:

1. The menu bar offers the following graphics commands:
   - The Edit command, which provides the functions Undo, Cut, Copy, and Paste.
   - The View command, which enables the user to toggle the Toolbar, and the Status Bar on and off.
   - The Graph command which contains the Edit, Zoom Out, log Y, log X, linear Y, linear X, Data to EXCEL CSV file, Data to EXCEL (; delimiter), Hide data points, Show data points, and Edit titles commands.

2. Zooming is done differently in the Plot Window. Please refer to the section on How to create a plot to learn how to use this feature.

3. Plot editing, other than changing labels and titles, is done using the Chart Explorer which is accessed via the Graph command on the menu bar. The Chart title, x axis title, and y axis title may be changed using the Graph|Edit titles command.

USING THE PFD WINDOW

The PFD Window is used to create process flow diagrams.

The main features of the PFD Window are:
1. The process flow diagram always starts with the flowsheet just as it is in the *Simulation Window*.

2. The flowsheet in the *PFD Window* is treated as a collection of objects, not as a single object as in past versions of CHEMCAD. This means that the objects may be individually moved, stretched, and rotated just as in other windows.

3. Special functions are provided to enable the user to quickly and easily place customized stream data boxes and UnitOp data boxes on the drawing. These functions are found under the *Format* command on the menu bar when the *Main PFD* option is selected from the *Output* menu.

4. A special *PFD Palette* is provided to enable the user to draw and place text on the PFD. This palette is accessed when the *Main PFD* option is selected from the *Output* menu.

5. The *Edit* command on the menu bar provides the *Redraw, Undo, Redo, Cut, Copy, Paste, and Delete* functions.

6. Right clicking an object in the *PFD Window* calls the same *Edit Object menu* used in the *Run Edit Flowsheet mode* of the *Simulation Window*.

---

**THE EDIT FLOWSHEET MODE**

To draw a flowsheet you must be in the *Edit flowsheet mode* of the *Simulation Window*. Whenever you start a new job, you are automatically placed in this mode. You will know you are in the *Edit flowsheet mode* by the following:

1. If the fifth command (from the left) on the menu bar is the *Run Simulation* command, then you are in the *Edit flowsheet mode* (you click the *Run Simulation* command to switch to the *Run Simulation mode*).

2. If the *Main Palette* is present, you are in the *Edit flowsheet mode*. However, if the *Main Palette* is not present, you may still be in the *Edit flowsheet mode*. Commands are available to hide it while still drawing the flowsheet.

While in this mode, certain commands and functions will be available which are unique to drawing flowsheets. These are:

1. The *Edit Object menu* (obtained by right clicking an object), presents a different set of commands. *Edit Object* commands in the *Edit Flowsheet mode* are strictly graphics oriented, while these same commands in the *Run Simulation mode* are strictly simulation oriented.

2. More *Edit* commands are available in the *Edit Flowsheet mode*.

3. The *ThermoPhysical, Specifications, Run, Results, Plot, Output, Sizing*, and *Tools* commands are restricted in the *Edit Flowsheet mode*.

---

**THE MAIN PALETTE**

The graphics palette is used to select unit operation icons, draw streams, create objects, put text on the drawing, and generally perform the creation of the flowsheet. The *Main Palette* is displayed only when you are in *Edit Flowsheet Mode*. 
The *Main Palette* consists of a set of squares arranged contiguously in a block. Each square contains a symbol indicating its function. Most are UnitOp icons, but others enable the user to:

- Draw streams
- Place text on the drawing
- Draw objects (rectangles, circles, lines, etc.)
- Rotate objects already on the drawing; and
- Re-invoke the arrow cursor

These functions are indicated below:

![Main Palette Diagram]

In addition, you should note the following about the *Main Palette*:

- Pointing to a box with the cursor will cause a small descriptive label to appear which will indicate to you what each box represents.
- Pointing to a box and clicking with the left button of the mouse will activate the corresponding function. For instance, to place a heat exchanger UnitOp icon on the flowsheet, you start by clicking on the heat exchanger square.
• Pointing to a box and clicking with the right button of the mouse will cause a sub-palette of icon options to be displayed. Right clicking again (on the same master palette box) will cause the sub-palette to disappear.

• The master palette may be switched on and off using the View/Main Palette command, or by switching to Run Simulation mode.

• The size and shape of the main palette can be controlled using the View/Palette Settings command.

• On the icon display, inlets are indicated by small blue squares and outlets by small red squares.

**SUB-PALETTES**

Since each unit operation can be represented by more than one icon, each unit operation square on the Main Palette has one or more sub-palettes from which the icon options can be selected. Sub-palettes are called by right clicking on the appropriate square on the Main Palette. Therefore, to view all of the available heat exchanger icons, you would first point with the cursor to the heat exchanger square on the Main Palette, then press the right mouse button. Then all available heat exchanger sub-palettes will appear.

![Heat Exchanger Sub-palette](image)

The heat exchanger sub-palette will open:
If user added icons exist, then they will appear in a second sub-palette and both sub-palettes will appear. The desired UnitOp icon is selected by left clicking on the appropriate square of the sub-palette.

It is possible to have sub-palettes from different unit operations displayed at the same time. There is no limit to the number of sub-palettes, which may be simultaneously displayed.

The sub-palette(s) disappears when:

- A selection is made from it; or
- The user right clicks on the same square or the Main Palette, which made the sub-palette appear.

Sometimes the icon displayed on the **Main Palette** is the icon the user wants to use. In this case it is not necessary to call the sub-palette(s). Simply left click the desired square and place the icon on the flowsheet.

THE SIZE AND SHAPE OF THE PALETTES

The user may specify the size and shape of the main and sub palettes by following this procedure:

1. Click the **View** command on the menu bar.
2. The **View Menu** appears, select the **Palette Settings** option;
3. The **Palette Settings dialog box** will appear like so:

   ![Palette Settings dialog box]

   Using these options, the user can make the palettes square or thin, small or large, etc.

HIDING AND CALLING THE PALETTES

The **Graphics Palette** can be switched on and off in four ways. These are:

1. By switching in and out of the **Edit Flowsheet Mode** using the **Edit Flowsheet/Run Simulation** command on the menu bar. If the command **Run Simulation** is currently displayed, then the program is in the **Edit Flowsheet Mode**. Clicking on the **Run Simulation** command will switch the program into the **Run Simulation Mode**. When this occurs the **Run Simulation** command will disappear from the menu bar and the **Edit Flowsheet** command will appear in its place.
2. By switching in and out of the *Edit Flowsheet Mode* using the *S/G button* on the toolbar. If the command *Run Simulation* is currently displayed on the menu bar, then the program is in the *Edit Flowsheet Mode*. Clicking on the *S/G button* will switch the program into the *Run Simulation Mode*. When this occurs, the *Run Simulation* command will disappear from the menu bar and the *Edit Flowsheet* command will appear in its place.

3. The palette can be switched on and off while remaining in the *Edit Flowsheet Mode* using the *Component Palettes button* on the toolbar.

4. The palette can be switched on and off while remaining in the *Edit Flowsheet Mode* using the *View/Main Palette*, that is:
   - Click the *View* command on the menu bar. The *View menu* will appear.
   - Toggle the palette on and off by clicking on the *Main Palette* option. The presence of a check mark by the *Main Palette* option indicates that the palette is “on”, i.e., to be displayed. If the check mark is absent, then the palette is to be hidden even while in the *Edit Flowsheet Mode*.

**MOVING THE PALETTES**

Palettes in CHEMCAD can be moved like a Windows dialog box. Specifically; to move a palette,

1. Point to the solid bar across the top of the palette,
2. While holding down the left mouse button, drag the palette to the new position.

**DRAWING WITH THE PALETTE**

The palette provides facilities for drawing any of the following:

- **Line** For drawing straight lines segments
- **Rectangle** For drawing rectangles
- **Ellipse** Draws ellipses and ellipse segments
- **Polyline** Draws a series of connected lines
- **Polygon** Draws multi-sided objects
- **Text** Puts text strings on the drawing
- **Symbol** Places previously prepared symbols and icons on the drawing

**DRAWING LINES**

Procedure:

1. Open the graphics palette.
2. Click on the **Line** square on the palette. The palette will close and the drawing cursor will appear.
3. Point to the starting point of the line segment.
4. While holding down the left mouse button, drag the cursor to the end point of the line.
5. Release the mouse button. The line will be complete and the palette will reopen.

**DRAWING RECTANGLES**

Procedure:
1. Open the graphics palette.
2. Click on the *Rectangle* square on palette. The drawing cursor will appear and the palette will close.
3. Point to one corner of the rectangle.
4. While holding down the left mouse button, drag the cursor to the opposite corner of the rectangle.
5. Release the mouse button. The rectangle will be complete and the palette will reopen.

**DRAWING ELLIPSES**

Procedure:
1. Open the graphics palette.
2. Click on the *Ellipse* square on palette. The drawing cursor will appear and the palette will close.
3. Point to the location of one end of the ellipse or ellipse segment.
4. While holding down the left button on the mouse, move the mouse around until the ellipse is the size and shape desired.
5. Release the mouse button. The ellipse will be complete and the palette will reopen.

**DRAWING POLYLINES**

Procedure:
1. Open the graphics palette.
2. Click on the *Multiline* square of the palette. The drawing cursor will appear and the palette will close.
3. Point to the starting point of the first line segment and click one time.
4. Move the cursor to the end point of the first line segment and click one time. The first line segment will be complete.
5. Move the cursor to the end point of the second line segment and click one time. The second line segment will be complete.
6. Repeat step 5 for all but the last segment.
7. For the last line segment, point to the end point and double click. The polyline will be complete and the palette will reopen.

**DRAWING POLYGONS**

Procedure:
1. Open the graphics palette.
2. Click on the **Polygon** square of the palette. The drawing cursor will appear and the palette will close.

3. Point to the starting point of the first line segment of the polygon and click one time.

4. Move the cursor to the end point of the first line segment and click one time. The first line segment will be complete.

5. Move the cursor to the end point of the second line segment and click one time. The second line segment will be complete and a line will appear between the end point of the second segment and the starting point of the first segment.

6. Repeat step 5 for all but the last segment.

7. For the last line segment, point to the end point and double click. The polygon will be complete and the palette will reopen.

---

**TEXT**

Refer to the section “**How to place text on a drawing**”.

---

**HOW TO PUT TEXT ON A DRAWING**

Text may be placed on a flowsheet or PFD using the text facility on the graphics palette.

To place text on a graphic:

1. Select the **text** tile from the palette. The palette will disappear and the text cursor will appear.

2. Identify the left-hand location for the text by pointing and clicking with the cursor.

3. Type in the desired text. The text may be as long and as many lines as desired.

4. When finished typing the text, double click on some unoccupied spot on the drawing. The palette will reappear.

The text font size and style is controlled using the **Format Command**.
THE FORMAT COMMAND

The **Format** command is used to specify the style and color of certain graphics objects used in CHEMCAD. It is also used to import bitmaps into CHEMCAD drawings. Selecting the **Format** command will open the **Format** menu that offers the following graphics features:

- **Bring to Front**
  Places an object in the foreground.

- **Send to Back**
  Places an object in the background.

- **Fill pattern**
  When a closed object is drawn, the internal area of that object can have a user selected fill pattern. This command is used for that purpose.

- **Pen style**
  For selecting the pattern(s) to be used to create text and draw lines, circles, etc.

- **Arrowheads**
  User drawn lines may have arrowheads attached to them in a variety of ways. This command enables the user to specify which arrowhead method is to be used.

- **Color**
  Controls the color of text, lines, foreground and background.

- **Font**
  Controls text font (style) selection.

- **Align**
  Helps position UnitOp symbols on the screen.

- **Import bitmap**
  For using externally created graphics objects within CHEMCAD. This is useful for importing logos, title blocks, etc.

- **Add Stream Box**
  For putting a table of selected stream compositions, flows, and/or properties on a PDF.

- **Add UnitOp Box**
  For putting a table of parameters and calculated values associated with a unit operation on the PDF.

- **Add TP Box**
  For putting boxes containing temperature, pressure, and/or flowrate on the streams of a PDF.

The **Format Menu** commands **Engineering Units**, **Add Stream Box**, **Add UnitOp Box**, **Add TP Box** are discussed elsewhere because they do not apply to drawing a flowsheet.

**BRING TO FRONT**

When an object is in the "front", it will be superimposed over any other objects occupying the same space.

**SEND TO BACK**

When an object is in the "back", it will be covered up if any other object occupies the same space on the screen.
FILL PATTERN

The internal area of a closed drawn object may be filled with a hatching pattern of the user’s choice. The user may choose from any of the following options:

- solid
- horizontal
- FDiagonal
- cross
- hollow
- vertical
- BDiagonal
- diag cross

Changing fill patterns does not change the fill pattern of those objects, which have already been drawn. It only specifies the fill pattern to be used when drawing new objects.

PEN STYLE

Lines, circles, squares, etc. are drawn with a pen or line style, which the user can control. Options are:

- solid1
- hollow
- dashdot
- dashdotdot

ARROWHEADS

Lines, circles, etc. may be drawn with any of the following user specified arrowheads:

- -------
- ------→
- ----→
- →→→

COLOR

Selecting this command calls the Color menu. This menu allows the user to:

- Select the pen color: The pen color is the primary line color. Since all filled objects are drawn with a line, the pen color is also the primary color of the line forming the border of closed objects. The word “primary” is used because where lines are not solid (i.e., where they are made of dashes and dots), the pen color is the color of the dots and dashes themselves, and the fill color is the color of the spaces between the dots and dashes.

The available pen colors are presented in a standard Windows Color Selection dialog box. The user makes his/her selection by clicking on the desired color. A dashed line around the active (selected) color indicates color selections. Use of custom colors is also possible.
• **Select the Foreground Fill Color:** The foreground fill color defines the internal color of solid closed objects. The available fill colors are presented in a dialog box similar to that described above for pen colors.

• **Select the Background Fill Pattern:** The background fill color defines the color of all areas not bound as solid closed objects or lines such as text, lines, semi-circles, etc. The available fill colors are presented in a dialog box similar to that described above for pen colors.

**THE PEN/TEXT COLOR**

Selecting this option calls the **Color** dialog box. This dialog box displays the basic colors to serve as a starting point for the creation of a custom color. The procedure is as follows:

1. The Basic Colors area shows more colors than are available in **Colors** dialog box. If you find a suitable color in the grid, click on it to select it and then click on [OK] to close the dialog box. The chosen color replaces the previously selected color.

2. If none of the basic colors is acceptable, click on the **Define Custom Colors >>** button. The dialog box expands to show a color-editing area.

3. In the large color-editing area, drag the crosshair cursor to choose the desired color (it appears in the smaller area below). It may be easier to select a basic hue in the color-editing area and then use the slider bar at the far right to adjust to the desired color.

4. When satisfied, click on the **Add to Custom Colors** button. The new color appears in the area for custom colors. Clicking the [OK] will retain the color in its custom color box, for future use. Note that changes do not affect the colors of existing objects.

A custom color set remains active only with the current picture. When you open a different picture, CHEMCAD uses the color set that was active when the picture was last saved. If you start a new picture, CHEMCAD restores the standard, or default, color set.

**THE FOREGROUND FILL COLOR**

The **Fill Foreground** command operates exactly the same way as the **Pen/Text** color command. Please refer to the above section for instructions.

**THE BACKGROUND FILL COLOR**

The **Fill Background** command operates exactly the same way as the **Pen/Text** color command. Please refer to the above section for instructions.

**FONT**

The user may select from any of the standard Windows fonts for the text. Selecting the **Font** command will call the Windows **Font Selection** dialog box.

**ALIGN**

This command is used to align UnitOp symbols relative to each other. It only works before the UnitOps have been connected by streams. After a stream has been added to the flowsheet, the **Align** command is inoperative.

**IMPORT BITMAP**

Bit maps may be placed on a drawing using the **Format** command on the menu bar. The procedure is as follows:
1. Click on the **Format** command on the menu bar. The **Format** menu will open.
2. Select the **Import Bitmap** option on the **Format** menu. The **Open** dialog box will open.
3. Identify the bit map file that is to be imported.
4. When the file name is displayed in the **File name:** field of the **Open** dialog box, click on the **[Open]** button. The dialog box will close and the bit map object will be placed just to the right of the existing flowsheet.
5. Click on the area just to the right of the flowsheet. The four object selection boxes will appear at the corners of the bit map. The bit map is now an object within CHEMCAD and can be manipulated like any other object.

## HOW TO ROTATE AN OBJECT USING THE PALETTE

Certain objects within CHEMCAD can be rotated through any angle using the **Rotate** function on the palette. All CHEMCAD objects can be so rotated except for streams and text. Imported objects such as bit maps cannot be rotated.

The procedure for rotating an object is:

1. Click on the **Rotate square** on the palette. The palette will close and the **rotate cursor** will appear.
2. Point to the object that is to be rotated and hold down the left mouse button. A dotted rectangle will appear around the periphery of the object and the four selection boxes will appear at its corners.
3. Keeping the left mouse button depressed, move the mouse around. The dotted rectangle will rotate to indicate the new position of the objects.
4. When the final angle of rotation has been identified, release the mouse button. The object will rotate to its new position. All streams attached to it will also rotate.

## HOW TO MOVE, MODIFY, DELETE, OR FLIP OBJECTS

### MOVING A SINGLE OBJECT

To move an object:

- Place the mouse arrow in the object
- Hold down the left button on the mouse. The four **object boxes** will appear
- With the left mouse button held down, roll the mouse and move the object to its new location, then release the left button of the mouse. The object position will be changed.

### MOVING MULTIPLE OBJECTS

To move multiple objects simultaneously:
Select the objects to be moved. Refer to “Selecting Objects” to learn how to select multiple objects.

Move the cursor to a position over one of the selected objects.

Keeping the left mouse button depressed, move the mouse around. The selected objects will move with it, while the rest of the objects remain in place.

When the objects are in their final positions, release the mouse button.

**PANNING THE FLOWSHEET**

There are two ways to pan the flowsheet:

1. Select all the objects in the flowsheet then move them as described above.
2. Click the **Pan overview** button on the toolbar. A small window will open in the upper right hand corner of the window. This window will contain a miniature copy of the flowsheet. Click and drag this miniature flowsheet around the window. The flowsheet will move with it. When the final position has been achieved, release the mouse button.

**RESIZING**

To resize an object; left click the object to select the object. The four corner object boxes will appear. Place the arrow on one of the boxes. Hold down the left button of the mouse; and roll the mouse. The object will change size.

**DELETING**

There are two ways to delete an object: right click the object with the mouse to open the **Edit Object** menu and then select the **Delete** option, or by pressing the **D** key.

**FLIPPING AN OBJECT’S Y-AXIS**

To flip an object’s y-axis means to rotate it about the x-axis as shown:

![Original and Flipped Objects]

To do this, open the **Edit Object** menu by right clicking that object with the mouse. Then select the **Flip Vertical Y** axis option by clicking it with the mouse or by pressing the **[V]** key. Immediately upon selection, the object will flip.

**HOW TO COPY TO THE CLIPBOARD**

**USING THE METAFILE**
The metafile will copy the entire flowsheet to the clipboard. The procedure is:

1. Click on the **Edit** command on the menu bar. The **Edit** menu will open.

2. Select the **MetaFile to clipboard** option from the **Edit** menu. The flowsheet will be copied to the clipboard.

**USING THE COPY COMMAND**

The copy command will copy selected objects to the clipboard. To use the copy command:

1. Select the objects to be copied. Refer to the “Selecting Objects” section of this Users Guide if you do not know how to select multiple objects.

2. Click on the **Edit** command on the menu bar. The **Edit** menu will open.

3. Select the **Copy** command from the **Edit** menu. The selected objects will be copied to the clipboard.

**HOW TO GENERATE A DXF FILE**

To generate a DXF file:

1. Select the **Edit** command from the menu bar. The **Edit** menu will open.

2. Select the **Create DXF file** option from the **Edit** menu. The DXF file will be written to the job subdirectory and will have the name <Jobname>.DXF.

**HOW TO DRAW A FLOWSHEET**

Flowsheet creation involves placing unit operations on the screen and connecting them with streams. The flowsheet specifies the equipment equations to be solved and what order they are to be solved.

Drawing a flowsheet involves the following steps:

1. Enter the **Edit Flowsheet** mode.

2. Place UnitOps on the flowsheet.

3. Connect the UnitOps with Streams.

4. Place text and symbols on the drawing (optional)

**STEP 1: ENTER THE EDIT FLOWSHEET MODE**

The **Edit Flowsheet** mode is the CHEMCAD graphics-editing facility specifically designed for drawing flowsheets. If you are starting a new flowsheet, you will automatically be in the **Edit Flowsheet** mode when you start a new job. If you are adding to an existing flowsheet, you may have to switch to this mode by clicking the **Edit Flowsheet** command or the **S/G** button. Either way, whenever you enter the **Edit Flowsheet** mode the **Main Palette** will appear.
Each tile contains a symbol that indicates its function. Most of them represent unit operation icons, but others enable the user to:

- Draw streams
- Place text on the drawing
- Draw objects (rectangles, circles, lines, etc.)
- Rotate objects already on the drawing and
- Re-invoke the arrow cursor

In addition to the palette you will also be using the View command whenever you are drawing flowsheet. The View command is located on the menu bar and enables you to control a wide range of graphics functions.

When you click the View command, a menu with the following options will open:

- **Zoom** Options—To zoom in and out on the flowsheet.
- **Toolbar** — To switch the toolbar on and off.
- **Status bar** — To switch the status bar on and off.
- **Main Palette** — To switch all open palettes on and off while remaining in the Edit Flowsheet mode.
- **Palette Settings** — To specify the size and dimensions of the palettes.
- **Grid Visible** — To turn the drawing grid on and off.
- **Change Grid Size** — To specify the grid size.
- **Show Page Bounds** — Turns the page boundaries on and off.
- **Adjust Page Size** — Adjust the size of the total available drawing area.
• **Stretch Symbol Proportionately** – Forces CHEMCAD to stretch the height and width by the same percentage amount whenever an object is resized.

• **Refresh Data Boxes** – Updates the Stream, UnitOp, and TP boxes.

• **TP Box Visible** – Switches the TP boxes on and off.

The details of these commands are explained elsewhere in this guide.

Also available are the following toolbar buttons (from left to right across the toolbar):

- **New** Closes the existing flowsheet and starts a new one.
- **Open** Closes the existing flowsheet and opens another one.
- **Save** Saves the flowsheet and all information associated with it.
- **Cut** Deletes selected objects and places them on the clipboard.
- **Copy** Copies selected objects to the clipboard.
- **Paste** This power button is currently inoperative.
- **Print** Print the flowsheet.
- **Zoom %** Zoom in (or out) a specified percent on (or from) the drawing center.
- **Zoom In** To zoom in on a specific area of the flowsheet.
- **Zoom out** To zoom out a previous view or to 50% of the current view.
- **Zoom to Fit** Zooms so that the entire flowsheet exactly fits on the screen.
- **Zoom In at a Point** Zoom in a fixed percent at a specified location on the flowsheet.
- **Zoom Out at a Point** Zoom out a fixed percent from a specified location on the flowsheet.
- **Zoom Rectangle** Zoom in on the area enclosed in a user drawn rectangle.
- **Pan Overview** Pan the entire flowsheet
- **Graphics Palette** Turns the palette(s) on and off even when you are in **Edit Flowsheet** mode.
- **S/G** Closes the **Edit Flowsheet** mode and returns to the **Simulation** mode.

These are the tools available to create, edit, review, and print a flowsheet.

**STEP 2: PLACE UNITOPS ON THE FLOWSHEET**

Each unit operations model is represented on the flowsheet by one or more UnitOp icons. The CHEMCAD Suite supplies a set of “standard” UnitOp icons, but users can create their own. All available UnitOp icons are given a name, attached to a specific Unit Operations model, and included in the main palette. This palette is called using the commands and buttons mentioned above.

Once a UnitOp icon is placed on the flowsheet, it becomes an object. All objects can be moved and modified using standard Windows conventions.
When a UnitOp is placed on the flowsheet, CHEMCAD automatically assigns it an ID number and a label. ID numbers are numbered sequentially from 1 and are set inside a small circle that is always placed just to the upper left of the icon. Labels, which may be up to 12 characters, are blank in the default condition, and are placed just above the UnitOp number circle. ID numbers and labels are objects themselves and can be moved and edited independently of their UnitOp icon and of each other. However, ID number and label positions are considered by CHEMCAD to be relative to the UnitOp icon itself. Therefore, moving a UnitOp icon also moves its ID number and label so as to maintain their positions relative to the UnitOp.

For procedural details on adding UnitOps to a flowsheet, see:

- "How to Add UnitOps to the Flowsheet"
- "How to Move, Modify, Delete, or Duplicate Objects"
- "How to Create User Defined UnitOp Icons"

**STEP 3: CONNECTING UNITOPS WITH STREAMS**

A “Stream” in a process simulator is a list of numbers representing temperature, pressure, vapor fraction, enthalpy and the molar flowrates of each of the components. They serve the following purposes:

1. They store some of the input and output for a unit operations module.
2. They connect one UnitOp to another in a particular order. In other words, the outlet stream from one UnitOp becomes the inlet stream to another.
3. The pattern of their connectivity establishes the calculation order for the simulation.

Drawing streams on a flowsheet provides an "object" around which these functions can be organized.

In order to understand how streams are drawn in the CHEMCAD Suite, you should first understand that every UnitOp icon consists of some combination of primitives plus “inlet” points and “outlet” points. All streams going into a UnitOp must go to an inlet point. All streams leaving a UnitOp must come from an outlet point. The position of these points is fixed by whoever builds the UnitOp icon. The CHEMCAD Suite knows where these points are, which of them are inlets, and which are outlets. It will always snap streams to one of these positions.

For convenience, the CHEMCAD Suites identifies inlet positions with blue dots and outlet points with red dots on the UnitOps icon. When you look at the UnitOp icon on the main palette or the sub-palettes, you will see these dots. When you place a UnitOp on the flowsheet, these dots will disappear because they would look bad on a flowsheet drawing. Therefore, to help you find them when you are drawing a stream, the cursor will switch a UnitOp’s dots on and will switch from a cross to a black arrow whenever you are close to one of these inlet or outlet points. Clicking the left mouse button causes the end of the stream to snap to the closest “lit” position.

When drawing streams, you may go from an inlet point to and outlet point or from and outlet point to an inlet point. In both cases you begin the stream by clicking on the desired position when the black arrow appears. To complete the stream you move the cursor (the black arrow) to an “opposite” position (if you started the stream at an outlet point, then an inlet is an opposite position and vice versa). When you are close to one, a label will appear describing the position. To finish the stream click the left mouse button when this label appears. The stream will snap to this position and an ID number will be assigned to the
stream. This ID number can be overridden if desired by right clicking on the stream and using the *Edit ID* command on the menu, which appears.

To draw a stream:

1. Click the *Stream* button on the main palette. The palette will disappear and a small cross will appear as the cursor.

2. Point to the desired position on the UnitOp. When the black arrow appears at the desired position, press the left mouse button. The cursor will snap to this position.

3. Draw the stream over to the destination UnitOp. If multiple turns are necessary, click the left mouse button to fix horizontal and vertical anchors points.

4. Point to the position on the UnitOp icon that you want the stream to go to. When the descriptive label appears at the desired position, click the left mouse button. The stream will snap to this position.

5. The stream is now drawn, but the *Stream* cursor is still active. Therefore, draw any additional streams required using steps 1 – 4 above.

6. When finished drawing streams, press double click on an unoccupied part of the flowsheet. The main palette will reappear.

Once a stream is placed on the flowsheet, it becomes an object. All objects can be moved and modified using standard Windows conventions. For additional information about drawing streams, see:

- "Drawing Streams"

### STEP 4: MODIFYING AND ADDING TO THE FLOWSHEET

Beyond just placing UnitOps and connecting them with streams, it is possible to add to and change the flowsheet in the following ways:

1. Place primitives, including text, on the screen.

2. Create and add symbols (groups of primitives) to the flowsheet.

3. Move, stretch, modify, and/or delete any object.

4. Select color and fill schemes.

5. Select line patterns.

See also:

- "How to Move, Modify, Duplicate and Delete Objects"
- "How to Put Text on a Drawing or Plot"

### HOW TO ADD UNITOPS TO THE FLOWSHEET

To add UnitOps to the flowsheet you must be in the *Edit Flowsheet* mode. If the *Main Palette* is displayed, then you are in the *Edit Flowsheet* mode. If you are not in the *Edit Flowsheet* mode, you
can get there by click the **Edit Flowsheet** option on the menu bar or by clicking the **S/G** button on the toolbar.

Once the **Main Palette** is displayed, you must:

- Select a UnitOp icon from the palette, and
- Place the UnitOp icon on the flowsheet.

**BRIEFLY**

Call the **Main Palette** by switching to the **Edit Flowsheet** mode as explained above. Whenever you start a new flowsheet, you will automatically be placed in this mode.

Point and click on the desired UnitOp square on the palette. The palette will disappear and a small, square cursor will appear. This cursor is for the placement of the UnitOp icon on the flowsheet as indicated by the one-line help at the bottom of the window.

Position the tip of the cursor where you want the icon to appear, and then click once.

**DETAILS**

Please note the following:

Since each unit operation can be represented by more than one icon, each unit operation square on the **Main Palette** has one or more sub-palettes from which the icon options can be selected.

Sub-palettes are called by right clicking on the appropriate square on the **Main Palette**. Therefore, for instance, to view all of the available heat exchanger icons, you would first point with the cursor to the heat exchanger square on the **Main Palette**, and then press the right mouse button. Then all available heat exchanger sub-palettes will appear.

If user added icons exist, then they will appear in a second sub-palette and both sub-palettes will appear. The desired UnitOp icon is selected by left clicking on the appropriate square of the sub-palette.

It is possible to have sub-palettes from different unit operations displayed at the same time. Right clicking on one UnitOp square, say a mixer square, and then right clicking on a different UnitOp square, say a pump square, will cause both the mixer and pump sub-palettes to appear. There is no limit to the number of sub-palettes, which may be simultaneously displayed.

The sub-palette disappears whenever a selection is made from it, or when the user right click on the corresponding main palette tile again.

Sometimes the icon displayed on the **Main Palette** is what the user wants to use. In this case it is not necessary to call the sub-palette. Simply left click the desired square and place the icon on the flowsheet.

When the icon has been selected, the palette will disappear and the **Add UnitOp** cursor (a small square) will appear.
DRAWING STREAMS

To place streams on the flowsheet click the Streams tile on the Main Palette.

There are a few general rules to remember when drawing streams on the flowsheet:

Each stream goes from a source unit to a destination unit.

Each unit has inlet and outlet positions. These are established when the symbol is created. The program always snaps streams to these positions. During the simulation a process stream always "flows" from an outlet position on a source unit to an inlet position on a destination unit. When drawing the flowsheet, a stream may be drawn in any direction: from an inlet position to an outlet position as well as from an outlet position to an inlet position.

When starting a stream, the cursor will be a small cross. When the cursor get near an inlet or outlet position, this cursor will convert to a black arrow. At the same time the UnitOp inlet and outlet points will be deployed. When this occurs, you should left click the mouse to start the stream if that is the position you desire.

When completing the stream, the cursor will remain as a black arrow. When the cursor is near a proper inlet or outlet position, the UnitOp inlet and outlet points will appear and a label will appear. Obviously, if a stream was started at an inlet point, it must be connected to an outlet point.

Once the desired position has been located (as indicated by the appearance of the label), you should left click the mouse to complete the stream.

While drawing a stream, the palette will disappear. It will reappear only when you left click somewhere on the flowsheet, which is not a UnitOp inlet or outlet point. You are not required to click the stream (link) icon square each time you begin a stream.
You can alternate between placing UnitOps on the screen and connecting them with streams as long as the above rules are followed.

The first time you change directions of a stream; CHEMCAD will let you do so without any problem. Every additional time you change directions, you must first press the left button on the mouse to identify the longitude or latitude through which you want the stream to pass. Doing this will create an anchor point to fix the longitude or latitude on the screen.

**DRAWING SIMPLE STREAMS (ONE OR LESS DIRECTION CHANGE)**

To draw a simple stream with one or less direction changes, that is, a stream that does not require anchor points, use the following procedure:

Click the *Streams* icon box on the palette. The palette will disappear and the crosshairs cursor will appear.

Move the cursor close to either an inlet point or an outlet point on a unit operation icon. When the cursor switches to a black arrow, press the left button on the mouse.

Draw the stream over to an opposite point on another unit operation icon. In other words, if you started with an inlet point on the starting unit operation, draw the stream over to an outlet point on the destination unit operation icon, and vice versa. When the label for the desired point appears, press the left button on the mouse. CHEMCAD will draw the stream directly to that point and will place a stream ID number on the flowsheet.

CHEMCAD issues ID numbers sequentially. You may change it using the *Edit Stream* menu (right click the stream) if you would like to do so.

**DRAWING COMPLEX STREAMS (MULTIPLE DIRECTION CHANGES)**

To draw streams that change direction more than once, use the following procedure.

Click the *Streams* icon box on the palette. The palette will disappear and the crosshairs cursor will appear.

Move the cursor close to either an inlet point or an outlet point on a unit operation icon. When the cursor switches to a black arrow, press the left button on the mouse.

Draw the stream as you normally would, but before you make your second turn, move the cursor to the longitude or latitude at which you wish to force the stream to pass through. Then click the left button on the mouse. A small circle will appear indicating the position of the anchor point.

Repeat step 3 for each additional change in direction.

When desired, move the cursor close to the desired destination inlet or outlet point. When the label appears, left click the mouse. The stream will then be complete.

**HOW TO SELECT COMPONENTS FOR THE COMPONENT LIST**

In order to select components for the component list, you must first call the *Component Selection dialog box*, and then use that dialog box to select the components from those stored in any of the
available CHEMCAD physical properties databanks. To call the **Component Selection** dialog box, you must select it from the **ThermoPhysical menu** or click on the **Define Components** button on the tool bar.

### CALLING THE COMPONENT LIST DIALOG BOX

**From the main menu bar:**

1. Select the **ThermoPhysical** command on the main menu bar. You can do this two ways.
   - Point and click **ThermoPhysical** with the mouse, or
   - Press **[ALT + L]** on the keyboard.

   The **ThermoPhysical menu** will open up like so:

2. Select the **Component List** option from the menu. This can be done in two ways:
   - Point and click **Component List** with the mouse, or
   - Press the **[L]** key (Note: press **[L]** not **[ALT + L]**.)

**From the Tool Bar:**

Click on the **Define Components** button 🏗️

### USING THE COMPONENT LIST DIALOG BOX

The **Component Selection** dialog box looks like this:
BRIEFLY

To select components from the component databank list in the right-hand window of the dialog box you should:

1. Locate the desired component by scrolling through the list. You can scroll by using:
   - the elevator bar
   - the arrow keys
   - the [PgUp] and [PgDn] keys
   - the Search field in the lower center of the dialog box

2. Select the component by:
   - highlighting it and clicking the Add button
   - highlighting it and hitting the [Enter] key
   - double clicking on the component

DETAILS

There are six (6) functional parts to this dialog box. These are:

1. The Selected Components area in the upper left portion of the dialog box. This area will display the components that have already been selected (if any). This area is normally dormant, but it can be activated by clicking anywhere on it. When active, a highlight will appear over one of the components. The Selected Components area is activated only when you want to insert or delete components.

2. The Component Databank area is in the upper right hand portion of the dialog box. This displays a list of all the components in any of the databases, which are currently accessible to CHEMCAD. The actual component selections are made from here either by double clicking on the component desired or by highlighting it and pressing the Add button.
The highlight can be moved by single clicking the mouse on the desired component; by using the elevator bar; by using the arrow, [PgUp], or [PgDn] keys; or by typing in an identifying string in the Search Component field described below.

Components with ID numbers between 1 and 5,000 are from the CHEMCAD Suite database. Components 6,001 – 8,000 are from the corporate pool database. Components from 8,001 – 9,999 are from the local user database. Components 5,001 – 6,000 are for pseudo-components.

3. The Search Component option is in the lower right portion of the dialog box. Typing in this field causes the program to scroll through the Component Databank list to find the alphanumeric string you typed. Some strings are embedded in more than one component (e.g., "ethanol" is in methanol and ethanol, as well as others). If the first component that the program finds is not the one you want, you can then press the Next button to try the next component found. Continue until you find the correct component.

4. The Add (Add new components) button is in the lower left-hand portion of the dialog box. This option allows the user to add components to the bottom of the current job component list. You can invoke this option by highlighting the desired component, then clicking the Add button with the mouse or by pressing the alternate [A] key. Of course, an alternate way to add components to the component list is to double click on the desired component.

5. The Insert button is in the lower left-hand portion of the dialog box just above the Search Component field. This option allows the user to insert components from the database anywhere in the current component list. To use this option, follow the procedure given below.
   - Identify the position in the component list where you want the new component inserted. Do this by highlighting the component which currently occupies that position.
   - Select the new component from the Component Databank list.
   - Click the Insert button. The new component will appear, highlighted, in the component list. All components below the inserted component will move down one position.

6. The Delete button is in the lower left-hand portion of the dialog box. This option allows the user to delete components from the component list. To use this option, follow the procedures given below:
   - Highlight the component to be deleted.
   - Click the Delete button or press the [Alt + D] key.

7. The Clear button simply deletes all of the components in the list at once.

When finished making selections, press the [OK] button to save your work or [Cancel] to cancel your changes.

---

**HOW TO SELECT K-VALUE OPTIONS**

To make K-value model selections, you must call the K-value Options dialog box.
BRIEFLY

1. Click the **K-Value Power Button** on the Tool Bar.

2. The **K-value Options** dialog box will appear.

3. Open the **Global K-value Option** list in the upper left by clicking on the field.

4. Scroll this list until the desired K-value model is displayed.

5. Select the desired model by clicking it with the mouse.

6. Make any supplementary selections (presented in the rest of the dialog box).

7. Close the **K-value Options** dialog box by clicking [OK].

8. You will be asked if you want to reinitialize all of the streams. If you are unsure, click [YES].

DETAILS

1. The **K-value Option** dialog box is called in this way:

   From the main menu bar, select the **ThermoPhysical** command by clicking it with the mouse, or pressing the [ALT + L] keys.

   The **ThermoPhysical** menu will appear. From the **ThermoPhysical** menu, select the **K-values** option by clicking it with the mouse, or pressing the [K] key.

   The **K-value Options** dialog box will appear.

2. Description of the **K-value Options** dialog box options.
**Global K-value Options:** This field provides a list of all the K-values models offered in the CHEMCAD Suite. A selection from this list becomes the basic, global (i.e., applied to all UnitOps in the simulation) K-value model for the active flowsheet. Certain options within the basic selection can be invoked using the fields described below.

**Procedure:**

- To open the K-value models list, click on it with the mouse.
- The list is scrollable using the elevator bar, the [PgUp] and [PgDn] keys, and the arrow keys. Scroll the list until the desired model is displayed.
- Select the desired model by clicking it with mouse, or by highlighting it, then pressing the [ENTER] or [TAB] keys.

The following K-value dialog box options are choice boxes. Click the appropriate selection. (For a description of how to use choice boxes in CHEMCAD, please refer to Using dialog boxes/Making choice box selections.)

**Ethane/Ethylene, Propane/Propylene**

Allows you to select whether you want to use standard BIPs or specially fitted BIPs for the ethane/ethylene and propane/propylene pairs when using the SRK or Peng-Robinson equations of state. Typically, the special BIPs will give the best results near the critical points.

**Vapor Phase Association**

Certain compounds, especially carboxylic acids, have the tendency to dimerize or even polymerize in the vapor phase. You can ask CHEMCAD to take this effect into account by activating this option.

**Vapor Fugacity/Poynting Correction**

When using a liquid activity coefficient K-Value method, you may treat the vapor phase as an ideal solution or as a regular solution. The latter requires use of the vapor fugacity Poynting correction. In the default condition, CHEMCAD assumes the vapor phase is an ideal solution. This is the No Correction option. If you want the Poynting correction included in the calculation, you must select the Correction option. In such cases, the vapor fugacity will be calculated using the SRK equation of state. Typically, it is safe to ignore this correction at lower operating pressures.

**Alpha Function**

For SRK and Peng-Robinson EOS models, you are allowed to choose either the standard alpha function or the newer Boston-Mathias alpha function. The default is the standard alpha function.

### HOW TO SELECT ENTHALPY OPTIONS

To make enthalpy model selections, you must call the Enthalpy Options dialog box.

**BRIEFLY**

1. Click the **Enthalpy button** on the toolbar.
2. The **enthalpy options** dialog box will appear.

3. Open the **Global Enthalpy Option**: field in the upper left by clicking on it. It should open up a list.

4. Select the desired model by clicking it with the mouse.

5. Make any supplementary selections (presented in the rest of the dialog box).

6. Close the **enthalpy options** dialog box by clicking **[OK]**.

7. Upon exiting this dialog box, you will be asked if you want to reinitialize all of the streams (if any exist). If you are unsure about this, click **[YES]**.

**Details**

1. The **enthalpy option dialog box** is called:

   - **From the toolbar** by clicking on the **enthalpy button**, or
   - **From the main menu bar** select the **ThermoPhysical** command by:
     - Clicking it with the mouse, or
     - Pressing the **[ALT + L]** keys.

   The **ThermoPhysical** menu will appear.

   From the **ThermoPhysical menu**, select the **enthalpy** option by clicking it with the mouse, or by pressing the **[E]** key.

   The **enthalpy options dialog box** will appear.

2. The **enthalpy options** dialog box options.

   **Procedure:**
   - To open the **Global Enthalpy Options** list, click on it with the mouse.
   - Select the desired model by clicking it with mouse, or highlighting it, then pressing the **[ENTER]** or **[TAB]** keys.
**Global Enthalpy Options:** The **Global Enthalpy option** is a combo box. This field provides a list of all the enthalpy models offered in CHEMCAD. A selection from this list becomes the basic, global (i.e., applied to all UnitOps in the simulation) enthalpy model for the active flowsheet. Certain options within the basic selection can be invoked using the fields described below.

Click the appropriate selection. (For a description of how to use combo boxes in CHEMCAD, please refer to **Using dialog boxes**).

**Ideal Gas Heat Capacity:**
Choose between two equation forms (Polynomial or DIPPR) for calculation of ideal gas heat capacity. A description of these forms is given in the on-line manual.

The remaining entries in **Enthalpy Options dialog box** are optional.

**Use Heat of Solution File?**
If you have a file that contains heats of solution data, then you must click on this field to inform the program to look for the file with the HTS extension.

**Use electrolyte enthalpy:**
The electrolytes model contains an enthalpy model to compensate for heat of dissociation. This check box allows the user to turn off enthalpy effects of dissociation if an electrolytes model is in use. This setting has no effect on non-electrolytes models.

**Clear all Local H Model?**
A checkmark in this field will reset all local enthalpy models back to the global setting.

**Specify Local H Model?**
Allows you to select different enthalpy models for different unit operations in the flowsheet. A checkmark in this field will allow you to pick individual equipment on the flowsheet and set specific enthalpy models for each one.

**Heat of Mixing by Gamma?**
This option includes the heat of mixing in the heat balance. The heat of mixing is computed from activity coefficient.

**Compressed water pressure correction for steam table** at very high pressure the enthalpy of water requires some correction to the normal IFC equation which is normally used to calculate water enthalpies. Under these conditions, this correction can cause a significant difference in the enthalpy of a water stream.

---

**HOW TO DEFINE THE FEED STREAMS**

**BRIEFLY…**

1. Double-click on the desired stream (not the stream number 10 box). The **Edit Streams dialog box** will appear.
2. Complete the dialog box as required.

3. Save the data by clicking [OK].

DETAILS...

1. The Edit Streams dialog box can be called in ways:
   - By double-clicking the appropriate stream on the flowsheet.
   - By clicking the Edit feed streams button on the toolbar.
   - By using the Specifications command on the main menu bar.
   - By right clicking on the stream.

Double clicking the appropriate stream on the flowsheet will immediately call the Edit Streams dialog box for the stream selected. 

Clicking the Edit feed streams button on the toolbar will immediately call the Edit Streams dialog box for every feed stream on the flowsheet.

Right clicking the streams a menu will appear. Select the “Edit Stream” option on the menu.

Using the Specifications command on the main menu bar to call the Edit Streams dialog box is done by following the procedure given below:

Global Phase Option
The default, vapor/liquid/solid, does not account for the possibility that two liquid phases may be present. If you want CHEMCAD to check for the formation of a second liquid phase, then the vapor/liquid/liquid/solid option should be used. A K-value method that can predict two liquid phases must be used in this case.

Water/Hydrocarbon Solubility
In the default condition, water will be treated as immiscible for K-value options SRK, PR, API SRK, ESSO, and Grayson-Streed. In this case, the K-values for all the hydrocarbons present will be calculated by the method selected, but the K-value of water will be calculated by a special routine
that accounts for the solubility of water in the hydrocarbons. For all other methods, water is considered to be miscible.

Salt Position for Wilson Model
Enter the position in the component list of the compound designated as the salt if using the Wilson Salt Effect K-value option.

No. of BIP Sets
CHEMCAD allows you to have up to ten (10) sets of BIPs for each activity coefficient method. This gives you the flexibility of using one set of BIPs in one section of a flowsheet and a different set in another. A typical use of this would be when you know that two liquid phases exist in the condenser of a distillation column. You can choose to use NRTL LLE BIPs in the condenser and NRTL VLE for the rest of the column.

Default BIP Set
Defines the set to be used globally by the program.

Clear Local K Model?
Click on this field if you wish to reset ALL local K-value models back to the global K-value model.

Set Local K/BIP Model?
If you click on this field, the program will then go into an equipment selection mode when you close the K-value Options dialog box. The user can then define what K-value model or BIP set is applicable to the particular unit operation.

Set Tray BIP?
If the user clicks on this field, upon exiting the K-value dialog box, the program will go into selection mode and allow you to choose one or more distillation towers from the flowsheet. It will then present you with an input screen where you can enter a range of tray numbers and the BIP set that applies to that range.

Set Henry’s Components
When using an activity coefficient model, the K-value for super critical components is calculated using the SRK EOS (default) or the Henry’s Gas Law equation. Selecting this option allows the user to identify which super critical components are to be handled by the Henry’s equation instead of by SRK.

If this option is selected, a special dialog box will appear upon exiting the K-value Options.

- Select the Specifications on the menu bar command by:
  - Clicking on it, or
  - Pressing [ALT + S] on the keyboard.

The Specifications menu will appear.

- From the Specifications menu select either the Feed streams or the Select streams option by clicking or by pressing the underlined letter.

Selecting the Feed streams option will immediately call the Edit Streams dialog box for every feed stream on the flowsheet.
Selecting the **Select streams** option will cause the **Select Streams dialog box** to appear. This dialog box is used to identify the feed streams. This can be done either by using the mouse to click on the desired streams, or by typing the stream ID numbers (separated by spaces) of the flowsheet feed streams. If you use the mouse, the stream number will appear in the dialog box field as you click each stream. When all the required streams have been selected, click the **[OK]** button in the dialog box. The **Edit Streams dialog box** will appear.

2. Complete the dialog box:

   Note the following points about this dialog box.

   - The first field, called **Stream Name** allows you to enter a stream label or name.  
     
     **Note:** Entering and/or editing such stream labels can also be done a number of other ways.

   - The next four fields; temperature, pressure, vapor fraction, and enthalpy are the **thermodynamic properties** of the stream. According to the Gibbs phase rule, once the composition is given, specifying any two of the four thermodynamic properties of a mixture will define the other two. Thus, defining the composition, temperature, and pressure uniquely defines the vapor fraction and enthalpy (again, this is for a mixture only). Alternately, defining the composition, pressure, and enthalpy will uniquely define temperature and vapor fraction.

   CHEMCAD, however, by convention, does not permit this much freedom. Since enthalpies are calculated relative to a datum, the calculation of any given stream enthalpy is an involved process which is prone to errors. For this reason, CHEMCAD does not permit you to enter stream enthalpy. (There is one exception to this rule; when the total component flowrate of a stream is zero, entering an enthalpy in a stream may serve as an alternative way of adding a heat duty to a unit.)

   Therefore, to uniquely define any stream in the CHEMCAD Suite, the user must define the composition of that stream, and any two of temperature, pressure, and vapor fraction. This is for a mixture. For pure components, all three thermodynamic properties are sometimes required.

   - The fields **Total Flowrate Units** and **Component Flow Units** work together to provide the user with a variety of ways to define stream compositions. If the **Component Flow Units** are set to mole, mass, or volume fraction (which can be done globally or locally) then the **Total Flowrate Units** menu will become available.

     If **Component Flow Units** is set as a flow or amount option, then the total flowrate becomes the sum of the component flowrates and the **Total Flowrate Units** menu will “gray out” and therefore be unavailable for editing. In this situation, as the component flowrate values are entered, they are automatically summed and the current sum is displayed in the field labeled **Total Flowrate**.

   - In the top left of the dialog box is the **[Flash] button**. Clicking this button at anytime will cause the program to perform a flash calculation using the currently specified composition and thermodynamic properties. This allows quick flash calculations to be made without exiting the dialog box.
- Fractions that do not sum to 1.0 are automatically normalized upon flashing or exiting the dialog box.

3. Click the [OK] button. This will close the dialog box and simultaneously save the data. CHEMCAD will automatically perform a flash calculation on the stream before saving the data.

**HOW TO SPECIFY UNIT OPERATIONS**

For each UnitOp in the CHEMCAD library, there is a corresponding, unique dialog box for specifying its operation. These dialog boxes are the means by which:

1. The user provides the specifications necessary to match the degrees of freedom present in the flowsheet. This step is necessary for a unique solution to exist.

2. Certain options, which are not essential to a unique solution, are exercised.

Therefore, before running a simulation, it is necessary that the relevant UnitOp dialog boxes be completed properly.

For a description of each item of each UnitOp dialog box, please refer to the Help system.

**CALLING A UNITOP DIALOG BOX**

UnitOp dialog boxes may be called in the following ways:

1. Double-click the UnitOp icon itself on the flowsheet, or

2. Right click on the UnitOp and select the “Edit Unit Op Data” option from the menu that appears.

3. From the main menu bar:
   - Select Specifications from the menu bar. The Specifications menu will open.
   - Select the Select Unit option from the Specifications menu. The Select UnitOp(s) dialog box and cursor will appear.
   - Identify which UnitOp dialog boxes are to be called by clicking the UnitOp icons or by typing the UnitOp ID number in the dialog box.

After all desired UnitOps have been identified, click [OK]. The first UnitOp dialog box will appear. Other selected UnitOp dialog boxes will appear as the prior dialog boxes are closed. Appearance will be in the order of selection.

**RULES FOR COMPLETING THE UNITOP DIALOG BOXES**

The rules for using UnitOp dialog boxes are described in the section “Using Dialog Boxes” of this manual.

**DEGREES OF FREEDOM AND UNITOP DIALOG BOXES**

Generally speaking, each time a unit operation is added to the flowsheet, it adds one or more degrees of freedom to the simulation. The number of degrees of freedom created depends upon the UnitOp itself. Most UnitOps will create one, but many will add more. For each degree of freedom created, one specification must be made for a unique solution to exist*. 
Since CHEMCAD is a modular sequential simulator, the specification must be made at the UnitOp that created the degree-of-freedom. For example, a two-outlet distillation column with a condenser and reboiler creates two degrees of freedom when added to the flowsheet. Therefore, two specifications must be made in the column dialog box.

If the user provides either too many or too few specifications, CHEMCAD will issue an error message to that effect when exiting the dialog box. Errors such as these must be corrected before the simulation can be run.

As a guideline dialog boxes in the CHEMCAD Suite show critical data for UnitOps in green.

* These specifications must be other than pressure. Equilibrium based simulators such as CHEMCAD assume the pressure is always known. Exceptions can and are made but these are not the rule and must be uniquely handled.

### HOW TO RUN SIMULATIONS IN THE CHEMCAD SUITE

There are four “categories” of simulation runs in the CHEMCAD Suite. These are steady state simulation, optimization, sensitivity analysis, and dynamics simulation. All four are run from the **Run** command on the menu bar.

- CC-STEADY STATE, CC-SAFETY NET, CC-THERM, CC-FLASH and CC-BATCH simulations are run using the steady state run commands.
- CC-DYNAMICS (CC-ReACS and CC-DCOLUMN) simulations are run using the dynamics run menu.
- Optimization will minimize or maximize an objective function.
- Sensitivity analysis will run parametric studies.

### RUNNING STEADY STATE SIMULATIONS

To run the simulation, point and click on the **Run** command on the top-level menu or press the [ALT + R] keys. This will cause the **Run** menu to open. This menu has the following options:

- Convergence
- Run **A**ll
- Run selected **U**nits
- **R**ecycles
- **C**alc sequence
- **O**ptimization
- **S**ensitivity
- **D**ynamics
The commands **Optimization**, **Sensitivity**, and **Dynamics** are described elsewhere. The remaining commands **Run All**, **Run selected Units**, **Recycles**, and **Calculating Sequence** are concerned with steady state simulation and are described below.

**Run All**  This option will run the entire flowsheet.

**Run Select UnitOps**  This option will permit you to specify which units are to be run. The units are simulated in the order specified by the user.

**Recycle**  This option permits the user to identify the calculation order of recycle flowsheets.

**Calc Sequence**  This option allows the user to specify his/her own calculation sequences.

Whenever you click one of the “run” commands, the following sequence of events is executed:

1. The program will immediately check the data and list any errors and/or warnings on the screen in a message box. Errors are fatal and therefore indicate conditions which must be corrected before the calculation can start. Failure to completely specify a unit operation is an example of an error. Warning messages are not fatal and indicate conditions of which the user should be aware, but which will not keep the simulation from proceeding. Failure to specify cut stream initial estimates is an example of a condition, which will generate a warning message.

2. If the **Display trace window** option has not been activated, the program will proceed straight to the calculations and when finished will display convergence or completion messages in a message window or on the bottom line of the main CHEMCAD window. If the **Display trace window** option has been activated on the **Convergence** dialog box, the **CHEMCAD Trace Window** will open next. The **CHEMCAD Trace Window**, despite its name, is a dialog box, not a window. Its’ purpose is two fold

   • To display runtime messages
   • To provide a means of stopping, starting, and pausing the simulation

The **CHEMCAD Trace Window** looks like this:
You will notice that there are three buttons at the bottom of this dialog box. These are:

- The **Go** button starts and restarts the simulation calculations.
- The **Stop** button stops or **pauses** the simulation. Clicking this button will suspend the simulation calculations. Once stopped, the simulation may be restarted by clicking the **Go** button, or terminated by clicking the **Close** button. Whenever a simulation is restarted, it picks up where it left off. It does not begin all over again.
- The **Close** button terminates the calculation (if it is in progress) and closes the **CHEMCAD Trace Window**.

During the simulation, as the program moves from one unit to the next, messages will be displayed in the **CHEMCAD Trace Window**. While the simulation is in progress, a steady stream of messages will appear in this "window".

When the simulation is finished, the message "Run finished" will appear on the bottom line of the **CHEMCAD Trace Window** dialog box. The dialog box will not close automatically, but will remain open so that you can scroll and browse the runtime messages. After browsing, if you want to proceed, you must click the **Close** button.

### HOW TO REVIEW STREAM COMPOSITIONS

The overall procedure for viewing stream compositions (on the screen) is:

1. Select the **Results** command on the menu bar. The **Results** menu will appear.
2. Set the flow rate engineering units to be used to display the compositions. Clicking the **Set Flow Units** option on the **Results** menu does this. The **View Flow Rate Unit** dialog box will appear. This dialog box will display a list of options. Only one of these can be active at a time. The active option will have a dot in the circle next to it. To change it, click on the circle for the desired option, then close the dialog box.
3. Reopen the **Results** menu and highlight the **Stream Compositions** option. The **Stream Compositions** menu will open.
4. Select one of the five options on the **Stream Compositions** menu. Each option is a unique way to select the streams to be displayed, and each is executed a little differently. Details are provided below under “**Selecting Streams**”.
5. Once the streams have been selected, their compositions will be displayed in a Wordpad window. In this window, the results may be scrolled, printed, edited, or filed using Wordpad commands.

When ready close the Wordpad window by clicking the **Close** button.

### SELECTING STREAMS

As item 4 above mentions, there are five options for selecting streams in the **Results** command:

- **Select Streams**
- **All Streams**
• Feed Streams
• Product Streams
• UnitOp Streams

These options operate as described below.

1. **Select Streams**
   Choosing this command invokes the *Select Stream(s)* dialog box. This dialog box contains a blank field where the stream ID numbers are to be entered either by typing or by clicking the streams on the flowsheet. Once the desired streams have been selected, the dialog box is closed.

2. **All Streams**
   Selecting this option immediately displays the compositions of all the streams on the flowsheet. These are displayed in a Wordpad window.

3. **Feed Streams**
   This option automatically displays the compositions of all the feed streams of the flowsheet. These are displayed in a Wordpad window.

4. **Product Streams**
   This option automatically displays the compositions of all the product streams on the flowsheet. These are displayed in a Wordpad window.

5. **Unit Streams**
   This option displays the compositions of all the inlet and outlet streams of a certain UnitOp. The user must identify which UnitOp. When the *Unit Streams* option is selected, the *Select UnitOp* dialog box appears. This dialog box contains a blank field where the UnitOp ID numbers are to be entered either by typing or by clicking the UnitOps on the flowsheet. Once the desired UnitOps have been selected, the dialog box is closed.

   Clicking on the desired UnitOp with this cursor will cause the associated stream compositions to be displayed in a Wordpad window.

---

**HOW TO SET FLOW UNITS FOR RESULTS AND REPORTS**

It is possible to view stream compositions and include stream compositions in reports using flowrate units, which are different from those set for the simulation. The procedure for this is:

1. Select **Results** from the main menu bar.

2. The first item on the menu will be Set Flow Units. Select this command. The View Flow Rate Unit dialog box will open.

3. Find the desired units on the list displayed.

4. Select the option by clicking on it or its radio button, then press **[OK]**.
HOW TO VIEW STREAM PROPERTIES USING THE RESULTS COMMAND

The overall procedure for viewing stream properties (on the screen) is:

1. Select the **Results** command on the main menu bar. The **Results** menu will appear.

2. Highlight the **Stream Properties** option of the **Results** menu. The **Stream Properties** menu will open.

3. Select the **Select Properties** option from the **Stream Properties** menu. The **View Property Options** dialog box will appear.

4. Select the desired properties and close the dialog box (see "Using the View Property Options dialog box"). You will be returned to the main window.

5. Return to the **Stream Properties** menu and choose one of the five available options for choosing streams. Each option is a unique way to select the streams to be displayed, and each is executed a little differently. Details are provided above under "Selecting Streams".

6. Once the streams have been selected, their properties will be displayed as a report in a Wordpad document. In this window, the results may be viewed, edited, printed, or filed. Operation of this window is described elsewhere.

7. When ready, clicking the [Close] button closes the Wordpad document, and you are returned to the CHEMCAD main window.

USING THE PROPERTIES OPTION DIALOG BOX

Selecting the **Stream Properties** options calls the **View Property Options** dialog box.

This dialog box offers two pages of property options. Default options are already checked. Turn on and off the check mark in the box next to each option. This can be done by:

1. Moving the focus to the desired option then pressing the [SPACE BAR]. The focus is a dashed box around the option label. It may be moved by the [TAB] key or the [ENTER] key.

2. Clicking the option with the cursor.

Once all selections have been made, click [OK].

**COMPOSITION OPTION:**
The **Composition Option** prints stream composition with the stream properties. This is in addition to the stream property output selected above. You may choose the flow units to be used in this printout by opening the combo box and selecting an appropriate option.

HOW TO PLOT

CHEMCAD allows you to create a wide range of plots. These plots are initially displayed on the screen where they can be reviewed and edited before a hardcopy is printed. There are sixteen (16) plot dialog boxes. Each is specific to the type of plot being generated, and each offers options defining exactly what and how information is to be displayed.
Procedure:

1. Select the **Plot** command from the main menu bar. The **Plot** menu will appear. The **Plot** menu offers the sixteen categories of plots mentioned above. These are described below under "Plot Menu Options".

2. Select the appropriate option by clicking it, pressing the underscored letter key, or by moving the highlight (with the [**UP**] or [**DOWN**] arrow keys) and pressing [**ENTER**].

3. Where applicable, you will be asked by a dialog box to identify the stream(s) or UnitOp(s) pertinent to this plot by clicking it or typing its ID number. When this is finished, click [**OK**]. The selected dialog box will appear.

4. Complete the dialog box as required. When finished, click [**OK**]. The plot will appear inside a new window. In some cases, a Wordpad document with tabular data used for the plot will appear first. You can browse this data if necessary, or you can simply close the window to see the plot window.

   This window is similar to other graphics windows in CHEMCAD, and has the following commands available:

   - **File**  
     For printing, windows control and various bar selections
   - **Edit**  
     For cutting and pasting, etc
   - **View**  
     For turning on and off toolbars and status bars
   - **Graph**  
     For editing graph style and information
   - **Window**  
     For arranging windows, etc
   - **Help**  
     For accessing CHEMCAD help

5. Modify the plot as desired, and generate any necessary hard copies. For more specific instructions on how to use the graphics commands included in the plot edit window, see also:

   - "How to Use the Chart Explorer".

   A hardcopy of the plot can be obtained by pressing [**CTRL + P**], clicking the **Print** button, or by going through the **File** command on the menu bar. (See “How to Print”.)

6. When finished, close the **Plot** window by clicking the **Close** button. For certain plots, a new window will appear containing a tabulation of the numerical values used to create the plot. These results may be browsed and printed, but not modified. Close this window by clicking the **Close** button. You will be returned to the **Simulate Flowsheet Window**.

**PLOT MENU OPTIONS**

From this menu, you can plot data ranging from stream properties to tower composition profiles and from vapor liquid equilibrium diagrams to heat exchanger heat curves.
<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tower Profiles</td>
<td>Plots compositions, temperature, and flow profiles for distillation modules in either an XY or bar chart format.</td>
</tr>
<tr>
<td>TPXY</td>
<td>Temperature, pressure, and composition equilibrium plot. It will optionally plot experimental data points.</td>
</tr>
<tr>
<td>Residue Curve Map</td>
<td>Generates and plots a residue curve map. A residue curve map is a graphical display of distillation zones, azeotropes, and residue curves associated with a user specified ternary (3 component liquid mixture).</td>
</tr>
<tr>
<td>Binodal Plot</td>
<td>Generates a triangular plot useful for visualizing equilibrium of ternary systems.</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Plots a phase envelope for a given stream. Highlights the critical point of the mixture and can include plots at vapor fractions other than zero (bubble point curve) and one (dew point curve).</td>
</tr>
<tr>
<td>Heat Curves</td>
<td>Plots heating or cooling curves for heat exchangers.</td>
</tr>
<tr>
<td>Composite Curves</td>
<td>Plots composite heat curves for the flowsheet.</td>
</tr>
<tr>
<td>Properties</td>
<td>Allows you to generate plots of properties for a given stream.</td>
</tr>
<tr>
<td>Distillation Curves</td>
<td>Displays a plot of one or more distillation curves for a stream.</td>
</tr>
<tr>
<td>Plug Flow Reactor Profile</td>
<td>Plots the temperature or composition profiles along the axial length of a kinetic plug flow reactor.</td>
</tr>
<tr>
<td>Controller Convergence</td>
<td>Plots the convergence error of a controller as a function of the iteration number.</td>
</tr>
<tr>
<td>Batch Reactor/DVSL History</td>
<td>Plots the histories of a batch reactor or a dynamic vessel history.</td>
</tr>
<tr>
<td>Batch Column History</td>
<td>Plots Batch Column value history.</td>
</tr>
<tr>
<td>Dynamic Column History</td>
<td>Plots Dynamic Column value history.</td>
</tr>
<tr>
<td>Dynamic Stream History</td>
<td>Plots dynamic stream value history.</td>
</tr>
</tbody>
</table>
Dynamic UnitOp History
Plots dynamic unit operation value history.

Stream Recorder History
Plots the data tracked by the stream recorder as a function of time (or iterations).

User Specified File
Plots data from a user designated file.

1. Tower Profiles
This command plots profiles for distillation columns. The column may be either a batch distillation column or one of the rigorous steady state models. The main difference between the two is that when you select a batch column the program will ask you to specify which operating step (the end of) is to be plotted. The steady state models will not ask this question. In either case, the user is presented with the Profile Options dialog box.

   • Temperature Profile
   Clicking on this box will generate a plot of temperature versus stage number.

   • Total Flow
   Total Vapor Flow? Total Liquid Flow?
   Click next to either one (or both) of these boxes will cause the item to be included in the plot.

   • Phase Option
   Decide which phase you wish to access when you ask for a composition versus stage number plot. Click on the field to open the pull down list. The last two options only apply when there are two liquid phases present. Options are:
   - Liquid Phase
   - Vapor Phase
   - Light Liquid Phase
Heavy Liquid Phase

- **Flow Units**
  Choose the flow units for the plot when displaying component flowrates. Options are:
  - Mole Rates
  - Mass Rates
  - Mole Fraction
  - Mass Fraction

- **Base Component**
  Enter in this field the component position for the base component if you want to get a plot of relative volatilities. CHEMCAD compares the volatility of the components listed below to that of this base component.

- **Components to be Plotted**
  Select the component(s) you wish to plot using the combo box provided for each field. You must specify these whenever you want to plot compositions or relative volatilities. Enter the position in the component list.

- **Plot Controls**
  Allows you to set defaults for the plot. You can change these in the Plot Edit Window.
  - **Scale** – To choose whether you want the plot to be displayed in linear or logarithmic scale.
  - **Axis** – To pick whether you want the stage number to go on the X or Y-axis.
  - **Stage No.** – To choose whether the stage numbers should be ordered from minimum to maximum or vice versa.
  - **Type** – To decide if you want the plot to be in x-y format or a bar graph.

2. **TPXY**
   Plots a TPXY (temperature, pressure, and composition) equilibrium curve. This command is very useful to analyze interactions between components and to validate regressed equilibrium data.
• **Enter Component**
  Select the components to be plotted using the list provided.

• **Mode**
  TPXY plots are at fixed temperature or fixed pressure. You must indicate which. Fixed pressure is the default.

• **Spec.**
  Enter either the temperature or pressure, depending on what was selected in the Mode field above. Default = 1 atm.

• **Estimation**
  In extreme cases, it is necessary to enter an initial estimate for the specification. This option is normally left blank.

• **No. of Points**
  Enter the number of points to plot. Default = 20.

• **X mol frac. from/to**
  Enter the range to plot for the liquid mole fraction. You may choose any range desired, provided both values are fractions between zero and 1.0.

• **Plot experimental data**
  A **Yes** in this field superimposes experimental data points over the plot of the calculated values.

• **For a constant amount of a third component**
  These fields are used to define parameters for the “third” component in a ternary mixture.
  - **Third component** – Select the component to be the third component in the ternary system.
  - **Mole Frac** – Specify the mole fraction for the third component ($x_3$). The TPXY plot will be generated at this fixed $x_3$ value.
  - **Show XY as actual composition** – This is the default option. Check this option if you wish to have CHEMCAD show the XY plot with the specified composition for the third component.
  - **Show XY excluding 3rd component** – This option allows you to have CHEMCAD show the XY plot excluding the third component without having to delete your previous optional specifications. Check this option if you wish to have CHEMCAD show the XY plot for the first two components leaving your third component specifications intact.

• **Axis Mode**
  TPXY plots may be in mole fractions [Default] or mass fractions.

3. **Residue Curve Map**
  Generates a triangular plot for ternary distillation calculations.
• **Enter components of interest (First component, Second component, Third component):**
  Select the components to be plotted using the list provided.

• **Specify Pressure**
  Enter pressure for phase equilibrium calculations.

• **Number of lines on each axis**
  Enter the number of residue curve lines per axis which will be drawn on the map. (default = 25; 10 lines total).

• **Axis Mode**
  Select mole fraction or weight fraction units.

• **Step Size**
  Enter Calculation step size in selected engineering units (default = 0.02)

• **Point of interest (X1,X2) (Optional):**
  Enter any specific points that one of the residue curves must pass through.

4. **Binodal Plot**
   Generates a triangular binodal plot for examining ternary liquid/liquid equilibrium data.
1st, 2nd, 3rd Component
Select the three components to be included in the plot by using the combo boxes provided.

Temperature
Enter the temperature for which the plot is to be created.

Step Length
Indicates the step length used in binodal curve construction. Step length is entered in units of mole fraction. [Default = 0.05]

Y1, Y3
It is only possible to generate a binodal plot if the first and the third components are insoluble in each other. Y1 and Y3 are estimates of the mole fractions at which this occurs. Typically, it is not necessary to enter these numbers. However, it may be necessary to enter values if a message stating “the program did not converge” is received.

Plot Experimental Data
Click here to superimpose experimental data points over the plot of the calculated values.

Flow Units
The binodal plot may be displayed in mole percent or weight percent.

Envelope
Generates a plot of the phase envelope for any stream in the flowsheet. To use this option, there must be a stream of known composition in the flowsheet.

The program will ask you to select the stream to be plotted. It will then display the Phase Envelope Options dialog box.
• **Estimations (optional)**
  Initial estimates for the starting bubble point and dew point temperatures, may be entered. Typically, this is only necessary when the program is having difficulty converging.

• **Vapor Fractions (optional)**
  To construct the phase envelope, CHEMCAD calculates bubble point and dew point temperatures while incrementing the pressure. Once it reaches the critical point, it displays the plot. You may force the calculation of envelopes at four additional states of vaporization. Enter the vapor fractions for the intermediate lines.

• **Starting Pressure**
  Defines the starting pressure for the phase envelope (optional).

6. **Heat Curves**

Plots heat release curves for either stand-alone heat exchangers or for reboilers and condensers of distillation columns. When you first select this command, the program will prompt for selection of a heat exchanger or column. A dialog box will appear where you may set the following options.

![Plot Heat Curves dialog box]

- **No. of Points**
  Specifies how many points will be included in the heat curve calculation. [Default = 11]

- **Zone Cut Option**
  Indicates whether the zones are to be based on equal temperature, equal enthalpy increments, or equal enthalpy between the dew and bubble points. [Default = Temp]

- **Plot Option**
  Select one of the following,
  
  **Plot X-axis – DelH, Y-axis = Temp** – The x-axis will be change in enthalpy and the y-axis will be temperature.
  
  **Plot X-axis = % length, Y-axis = Temp** – The x-axis will be percent of tube length and the y-axis will be temperature.
7. Composite Curves

By selecting a group of heat exchangers, you can generate composite heat curves, combining their heat release curves. This allows you to examine the system for potential pinch zones. CC-STEADY STATE first allows you to select up to fifty (50) exchangers to include in the analysis. You are only allowed to select HTXR’s and LNGH’s. You select the equipment either by clicking it with the mouse or by entering their ID numbers in the fields provided on the Composite Heat Curve screen.

Select from flowsheet graphics?
A Yes in this field, permits you to select exchangers using the Select UnitOps dialog box (appears after closing the Composite Heat Curve dialog box).

- Zone cut option
Select whether the zones are to be based on equal temperature or enthalpy increments. [Default = Temp]

- Plot individual heat curve?
A Yes in this field tells the program to plot individual heat curves of the equipment on the same graph along with the composite curves.

- UnitOps IDs
Enter the unit ID numbers for the heat exchangers you wish to include in the analysis. If you select the unit operations graphically, then the program will fill these fields with the unit IDs the next time you visit this screen.
8. Properties

With this command you can obtain plots of ten properties for any stream in the flowsheet. The stream must be fully defined. Selection is made using the Select Streams dialog box. After you select the stream, you get the Properties Options dialog box.

- **Select a property to plot**
  Select one of the following entries on the screen.

- **Temperature Range**
  Enter the lower (Tmin) and upper (Tmax) temperatures for the properties plot.

- **No. of Points**
  Enter the number of points to be generated. [Default = 20]

9. Distillation Curves

Plot distillation curves for one or more streams. You can display up to 30 streams on the same plot. To use this feature, you first select what type of distillation curve you have from the list.
The program will then ask you to select the streams to plot.

10. **Plug Flow Reactor Profile**

This plot option is only available for kinetic reactors (KREA), which have been specified as PFR (Plug Flow) reactors.

- **Plot frequency**
  Specify the number of points to be plotted per number of points recorded. Normally one point is recorded per time step.

- **Composition options**
  Select the desired composition option for the plot. Options are:
  
  - Mole fractions
  - Mass fractions
  - Volume fractions
- **Temperature**  
  Click here if you want the temperature profile to be plotted.

- **Select components to be plotted**  
  Select the components to be plotted and enter the scale (factor) by which that component value is to be multiplied before it is plotted. Leaving the scale field blank sets the scale equal to one.

11. **Controller convergence**  
This option plots controller convergence errors as a function of controller iteration number. There is no dialog box for this plot option other than the one asking the user to identify the relevant controller (if necessary). The controller must have already been run and an iteration history file exist for the program to plot this option.

12. **Batch Reactor/DVSC History**  
**Batch Reactor History**

![Batch Reactor Plot Options](image)

- **Time Unit** – Use the combo box to choose from hours, minutes, or seconds for the x-axis units.

- **Plot frequency** - The number of points plotted per points recorded.

- **Composition Options** – Open this combo box by clicking it. Choose the desired value for the y-axis. Options are listed:
  - % mole fraction
  - % mass fraction
  - % liquid volume fraction
  - moles/volume
  - % conversion
  - rate ratio
  - moles
  - mass
  - liquid volume
  - rate of formation
  - % selectivity
  - Density
- **Components to be plotted** – Select the component and the scale to be plotted.

- **Reactor, Jacket/Coil Options** -- Each of these tabs lists variables, which can be included in the batch reactor plot. Toggling variables on (with a checkmark) will include them in the plot. Up to ten variables may be simultaneously plotted. You must verify that units are consistent for all variables; otherwise the plot will not make sense.

**Dynamic Vessel**

![Dynamic Vessel Plot Options](image)

- **Plot Frequency** The number of points plotted per points recorded.

- **Time Unit** Use the combo box to choose from hours, minutes, or seconds for the x-axis units.

- **Composition Options** Open this combo box by clicking on it. Choose the desired value for the y-axis. Options are as listed:
  - Mole fractions
  - Mass fractions
  - Liquid volume fractions

- **Phase** Choose the phase that the above option, Composition Options, applies to. Available options are as listed below:
  - Total
  - Liquid
  - Vapor
  - Light liquid
  - Heavy liquid

- **Enter the component to be plotted** Select the component(s) to be plotted.

- **Vessel Options** Instead of compositions, the following variable may be plotted:
  - Vessel temperature
13. **Batch Column History**

- **Operation Step**
  Select the operation step for which to make the plot. Enter the number of the individual step you wish to examine. If this field is empty, the program will plot a history for ALL the steps.

- **Variable to be plotted**
  Define the variable to be plotted on the y-axis. Select one from the pull-down list:

  - Mole Fraction
  - Mass Fraction
  - Volume Fraction
  - Mole Flow
  - Mass Flow
  - Pressure
  - Reflux mass rate
  - Reflux Ratio
  - Reboiler Duty
  - Condenser Duty
  - Temperature
  - Volume Flow
  - Reflux mole rate

- **Object to be plotted**
  Select one of the following. This field may not be needed if the variable specified above does not require a location (e.g., Reflux Ratio).
For plots of stages
If a plot for one of the stages in the column is desired, specify the following:

- **Stage No.** – Enter the stage number for which the properties will be plotted.
- **Phase** – Indicate whether you are plotting data for the liquid or vapor phase.

**X-variable**
Decide whether you want time [Default] or fraction distilled as the item plotted on the X-axis.

**Component plotted**
Select the component(s) to be plotted.

14. **Dynamic Column History**

After running a Dynamic Column, you may plot several of the recorded values using this option. Once you click this option, you are asked to select the dynamic column on your flowsheet. Once you click [OK], you will see the following dialog box:

- **Variable to be plotted**
  Define the variable to be plotted on the y-axis. Select one from the pull-down list.

- **Object to be plotted**
  Select one of the following. This field may not be needed if the variable specified above does not require a location (e.g., Reflux Ratio).
  
  Distillate
  Bottom
  Stage

- **For plots of stages**
  If a plot for one of the stages in the column is desired, specify the following:
- **Stage No.** – Enter the stage number for which the properties will be plotted.
- **Phase** – Indicate whether you are plotting data for the liquid or vapor phase.

- **Time Unit / Frequency**
  Specify what time unit you want to use for the x-axis and the frequency you want plotted.

- **Y-axis Min/Max**
  Specify a minimum and maximum for the y-axis of your plot

- **Component plotted**
  Select the component(s) to be plotted.

15. **Dynamic Stream History**

After running a dynamic flowsheet, you can plot stream data versus time, *if you have specified that a stream be recorded in the Dynamics Menu*. Selecting this option will open the following dialog box:

**The General Tab**

- **Stream number**
  Define the stream number to be plotted. If a stream is currently selected, its value will automatically appear in this field. You must have specified that this stream be recorded.

- **Plot Frequency/Time Unit**
  Specify the frequency and time for the stream variables to be plotted.

- **Composition / Components**
  Specify whether or not you desire a composition/time plot and the units you desire (i.e. mole/mass/mass frac/ etc). Also specify which components are to be plotted.
The Plot Stream Properties Tab

Specify which stream variables or properties are to be plotted by using the check boxes next to the variable names.

16. Dynamic UnitOp History

After running a dynamic flowsheet, you can plot unit operation data versus time, *if you have specified that a unit operation be recorded in the Dynamics menu*. When you select this option, you will see the following dialog box:

- Plot Frequency/Time Unit
  Specify the frequency and time for the variables to be plotted.

- Equipment Number
  Specify the equipment number that you would like to plot. You must have specified that this unit be recorded in the Dynamics menu.
• **Variable**
  Select the variable that you would like to plot from the drop down menu or using the check boxes next the variable names. You will see a list of all available variables (differs for each type of unit).

• **Title Specifications (optional)**
  Specify a plot title and y-axis title if you desire.

17. **Stream Recorder**

  Plots recorded data as a function of iterations (which may represent time). This function is especially useful in tracking recycle variables when dealing with a convergence problem.

18. **User Specified File**

  Plots a user-designated file. The file must be in a certain file format as explained in the following message box, which appears when you select this option:

  ![Message Box]

  Clicking **[OK]** displays a dialog box for identifying the location of the file to be plotted.
HOW TO CREATE REPORTS

CHEMCAD will create a formalized, professional quality report. This report is in a more or less standardized format. Formatting options are available and you have extensive control over contents.

To produce a report, use the Output option on the main menu bar. Click Output or press the [ALT + O]. The Output menu will appear, and you will have the following options:

- **Job Note**
  - Enables the user to keep a running set of notes regarding the flowsheet, the process, and their development. The notes are kept in a WordPad file associated with the job.

- **Reports**
  - For generating tabular hardcopy outputs.

- **Main PFD**
  - For producing and editing the primary (first) process flow diagram.

- **New PFD**
  - For producing additional process flow diagrams.

- **Open PFD**
  - Opens a previously created PFD.

To generate a report, select the Report option. The following menu will appear:

![Report Menu](image)

Each of the listed options calls a dialog box to perform specific functions. To create a report:

- Call the desired dialog boxes;
- Complete the dialog boxes as desired, then close them;
- Click Calculate and Give Results
- Click the Print button.
CALCULATE AND GIVE RESULTS

Selecting this option causes the report to be generated and displayed as a Wordpad or Word document (depending on how you configured CHEMCAD). The displayed report may then be printed, filed or discarded.

REPORT FORMATS

Selecting this option causes the program to display the following dialog box:

Flow Rate

Flow rate format

Designates how numbers are to be displayed. Choose from:

- F format
- E format
- G format

No. of digits after the decimal point for fractions

Enter desired value.

Overall Report Format

Choose from:

- Standard (.DOC file)
- Lotus 123 (.PRN file)
- Excel (.CSU file)
- Excel (; delimiter)
SELECT STREAMS

The composition and properties of any stream in the flowsheet may be included in the report. The composition may be expressed in a wide variety of forms (mass flow rates, mole fractions, volumetric flow rates, etc.) and can be reported in multiple ways within a single report. Stream properties may be selected from over 70 options. The same composition and properties options are reported for every stream included in the report. The Select Streams command is used to determine which streams are to be included.

Selecting the Select Streams option will cause the Select Streams dialog box to appear.

This dialog box offers three options:

- Print ALL streams
- Select from flowsheet graphics
- Enter the stream ID’s

PRINT ALL STREAMS:
Selecting this option will cause the composition and properties to be printed for every stream in the flowsheet. Click on the box and then click [OK].

SELECT STREAMS FROM FLOWSHEET GRAPHICS:
This option enables you to graphically select the streams from the flowsheet using the mouse. Click on the box and then click [OK]. The Select Streams dialog box will appear allowing you to select the desired streams either by typing in their ID No. or by clicking on them. Click [OK] when finished.

ENTER THE STREAM ID’S:
This option enables you to type in the ID number for the stream desired.

- Select No next to the Print ALL Streams? and Select from flowsheet graphics? options.
• Move the highlight to the first box under the **Enter the Stream ID’s** label (by clicking or by using the [TAB] or [ENTER] keys.
• Type in the stream ID number.
• Move to another box by clicking or by pressing the [TAB] or [ENTER] keys.
• Type in the next stream ID number.
• After all selections have been made click [Save].

**Select Unit Operations**

The input and output for any UnitOp on the flowsheet can be included in the report. The information reported is context specific and is determined by the program. You, however, may select which UnitOps are to be reported.

Selecting the **Select Unit Operations** option will cause the **Select UnitOps** dialog box to appear.

![Select Unit Operations dialog box](image)

This dialog box offers three options.

- Print ALL unit operations
- Select from flowsheet graphics
- Enter the unit op ID’s

**PRINT ALL UNIT OPERATIONS:**
Selecting this option will cause the composition and properties to be printed for every stream in the flowsheet. Click on the box and then click [OK].
SELECT FROM FLOWSHEET GRAPHICS?
This option enables you to graphically select the UnitOps from the flowsheet using the mouse. Click on the box and then click [OK]. The Select UnitOps dialog box will appear allowing you to select the desired streams either by typing in their ID No. or by clicking on them. Click [OK] when finished.

ENTER THE UNITOP ID’S:
This option enables you to type in the ID number for the UnitOps desired.

- Select No next to the Print ALL unit operations and Select from flowsheet graphics options.
- Move the highlight to the first box under the Enter the UnitOp ID’s: label (by clicking or by using the [TAB] or [ENTER] keys.
- Type in the UnitOp ID number.
- Move to another box by clicking or by pressing the [TAB] or [ENTER] keys.
- Type in the next UnitOp ID number.
- After all selections have been made click [Save].

SELECT STREAM PROPERTIES
Selecting the Stream Properties options calls the Property Options dialog box.

This dialog box offers two pages of property options. Default options are already checked. To make selections, turn the check mark in the box next to each option on and off by clicking on it.

Once all selections have been made, click [Save].

PRINT PROPERTIES RANGE CHECK?
The properties range check reports whether or not the property value was calculated at a temperature (or pressure) outside the recommended range of the data. A check mark here will include the properties range check report.
COMPOSITION OPTION:
The Composition Option prints stream composition with the stream properties. This is in addition to the stream composition output selected above. You may choose the flow units to be used in this printout by opening this combo box and selecting the appropriate option, Select Unit Operations.

STREAM FLOWRATE/COMPOSITION

Stream compositions can be reported in as many flow and/or composition units as desired. Selecting the Stream Flowrate/Composition option calls the Flow/Composition Options dialog box which presents check boxes allowing selection of the desired units. The “check mark” indicates that the option is turned on. It may be toggled on and off.

DISTILLATION SUMMARIES

This option calls the Distillation Options dialog box.

The listed options are toggled on and off with the [SPACE BAR] or by clicking with the mouse. The “check mark” indicates that the option is “turned on”; an empty check box indicates “turned off”.

- **Tray Profile** – Adds the distillation column profile to the report. It includes reflux ratio, temperature, pressure, vapor and liquid molar flow on every stage. It also shows flow and
location of feeds and products. Finally, it gives heat duties and locations of condensers, reboilers, and side exchangers.

- **Tray Properties** – This report includes mass flow and transport properties for every stage in the column.
- **Tray Sizing** – Prints a report of tray sizing calculations.
- **Packed Column Sizing** – Generates a report of column sizing for packed columns.
- **Tray Compositions** – This allows you to select what units to use on the tray-by-tray composition report. If “No Tray Compositions” is specified, this report is omitted.

### HEATING CURVES

This option sets the parameters for heating curves. This involves defining how many points are desired on the curve and whether the cuts should be based on temperature [Default] or enthalpy. Selecting the **Heating Curves** option calls the **Heat Curves** dialog box.

**No. of points:** Enter the number of points used to calculate the heating curve. The number of zones equals the number of points minus one.

**Zone cut option:** Click the desired option (only one permitted).

- **Temperature cut** means points will be at intervals of equal temperature.
- **H cut with dew/bubble points** means that intervals of equal enthalpy are used between the dew and bubble points (if present).
- **Equal H cut** means that the points are at intervals of equal enthalpy. The dew and bubble points are not located or used.

### BATCH/DYNAMIC RESULTS

This option allows you to include time dependent output for batch columns, batch reactors, and dynamic vessels. It calls the **Batch/Dynamic Options** dialog box.
• For batch distillation, you may select print Operation Results (stream compositions and temperatures at the end of each operation step); print History (stream compositions and temperatures at each time increment); or print Final Holdups (stage compositions and temperatures for each time increment).

• For batch reactors, you may print Operations Results and/or Stream and Reactor Mass Histories.

• For dynamic vessels, you may print Operations Results and/or Stream and Vessel Mass Histories.

• For individual streams, you may print the composition and temperature Histories.

• For each piece of equipment, you may print the equipment output Histories.

MISCELLANEOUS
Enables the user to toggle on and off the following sections of the output report:
- Topology summary
- Convergence selections
- Thermodynamics selections
- Line sizing results

In the default condition these items are included in the report.

END REPORT
Exits the report module.
HOW TO CREATE PFD'S

A PFD is a process flow diagram. It usually consists of:

i. The flowsheet drawing

ii. The tabulated heat and material balance and/or stream properties (Stream Box).

iii. Tabulated unit operation information (UnitOp Box).

iv. TP boxes on the streams (TP Box).

v. A title block.

vi. Miscellaneous notes regarding the process.

vii. The company logo.

Item (i) above is created when you draw the flowsheet.

Item (ii) above is called a Stream Databox. CHEMCAD has a special function for creating stream databases. That function is called by selecting the Add Stream Box command located on the Format menu.

Item (iii) above is called a UnitOp databox. CHEMCAD has a special function for creating UnitOp databases. That function is called by selecting the Add UnitOp Box command located on the Format menu.

Item (iv) above allows the user to place small boxes containing the temperature pressure, and/or flowrate of a stream or that stream and/or the flowsheet. This function is called by selecting the Add TP Box command located on the Format Menu.

Item (v) above is a symbol within CHEMCAD. A title block is provided by CHEMCAD, but users may create their own. The title block is stored as a tile on the PFD palette. From there it can be called and placed on the PFD.

Item (vi) above is created using the text function on the PFD Palette.

Item (vii) above is accomplished by using the Import Bitmap function located on Format menu.

Multiple PFD’s can be created for each flowsheet. Instructions on how to create and edit PFD’s are provided below.

CREATING THE MAIN PFD

The Main PFD is the PFD created using the Main PFD command on the Output Menu. The Main PFD is different from all other PFD’s is that, once it is created, it is always displayed even when not in PFD mode. Other PFD’s are displayed only when you are in PFD mode. If you do not want your PFD to always be displayed, you should create it using the New PFD command, not the Main PFD command. Obviously, there can be only one Main PFD per flowsheet, while there can be as many other (non-main) PFD’s as desired.

The general procedure for creating Main PFD’s (process flow diagrams) is:
1. Select the **Output** command on the **Simulate Flowsheet** menu bar. The **Output** menu will appear.

2. Select the **Main PFD** option from this menu. A new palette, the **PFD Palette**, will open and the program will go into “PFD mode”. The **PFD Palette** is a modified graphics-editing palette and, as such, most of its functionality is described in the section “**Drawing with the Palette**”.

3. Create the PFD by:
   - Adding Stream and UnitOp databoxes,
   - Adding TP Boxes,
   - Adding Title Blocks, symbols, and text,
   - Drawing primitives, moving objects, changing colors, etc., as desired.

4. Print the PFD as desired.

5. Exit the **PFD mode** to reopen the simulation mode commands. The main PFD will remain on the screen.

See also:
   - "Adding a Stream Databox on the PFD"
   - "Adding a UnitOp Databox on the PFD"
   - "Adding TP Boxes to the PFD"
   - "How to put text on a drawing"
   - "How to move or modify an object"
   - "Importing Bitmap"

### CREATING SECONDARY PFD’S

A secondary PFD is any PFD, which is not a Main PFD. For any given flowsheet a user may have as many secondary PFD’s as he/she pleases. Secondary PFD’s are not displayed when the program is in **Edit Flowsheet Mode** or **Simulation Mode**. It is not necessary to have a main PFD in order to have secondary PFD’s.

The general procedure for creating Secondary PFD’s (process flow diagram) is:

1. Select the **Output** command on the **Simulate Flowsheet** menu bar. The **Output menu** will appear.

2. Select the **New PFD** option from this menu. The **Open dialog box** will appear.

3. Enter a name for the PFD in the **File name** field of the **Open dialog box**.

4. Close the **Open** dialog box by clicking the [**Open**] button.

   A **New PFD window** will open. This window has the commands for creating PFD’s, but no other commands. In addition, the **PFD Palette**, will open and the program will go into “PFD mode”. The **PFD Palette** is a modified graphics-editing palette and, as such, most of its functionality is described in the section “**Drawing with the Palette**”.
5. Create the PFD by:
   • Adding Stream and UnitOp databoxes,
   • Adding TP Boxes,
   • Adding Title Blocks, Symbols, and text,
   • Drawing primitives, moving objects, changing colors, etc., as desired.

6. Print and Save the PFD as desired.

7. To exit the PFD you must close the **PFD Window**. You do this by clicking the [Close] button in the upper right hand corner of the window.
   • "Adding a Stream Databox on the PFD"
   • "Adding a UnitOp Databox on the PFD"
   • "How to put text on a drawing"
   • "How to move or modify an object"
   • "Importing Bitmap"

**OPENING AND EDITING SECONDARY PFD’S**

To open and edit a secondary PFD you:

1. Select the **Output** command on the **Simulate Flowsheet** menu bar. The **Output menu** will appear.
2. Select the **Open PFD** option from this **Output menu**. The **Open** dialog box will appear. All existing PFD’s for this flowsheet will be listed.
3. Select the PFD you want to open by:
   • Double clicking on it
   • Clicking on it once; the clicking on the [Open] button.

The PFD will open inside a **PFD Window**. The **File, Edit, View, Format, Window**, and **Help** commands will be available for editing the PFD.

**ADDING A STREAM DATABOX TO THE PFD**

Clicking the **Add Stream Box** option on the **Format** menu will initiate a four-step process for placing a customized stream databox on the PFD. These steps are:

• Select the streams to be included in the databox,
• Select the stream information to be included in the databox,
• Select the databox display settings,
• Move and size the databox as desired.
STEP 1: SELECT THE STREAMS TO BE INCLUDED IN THE DATABOX

The Select Streams dialog box looks like this:

Selecting the Print all Streams option will instruct the program to include in the flowsheet in the stream databox.

Selecting the Select Streams from flowsheet option will call the Select Streams dialog box. Streams may then be selected by clicking on them with the cursor, and/or by typing their stream ID No. Only the selected streams will be included in the stream databox.

If neither the Print all streams or the Select streams from flowsheet options are chosen, then streams may be selected by typing the desired stream ID Nos. directly into the fields provided under Enter the Stream ID Nos.

After this dialog box is closed (by clicking [OK]), the Databox Property Options dialog box will appear. 

STEP 2: COMPLETE THE PFD PROPERTIES OPTIONS DIALOG BOX...

The Databox Property Options dialog box looks like this:
This dialog box is an extremely flexible way of specifying exactly what information you want included in the stream databox. Notice that there are two pages to this dialog box.

All options on this dialog box are toggle switches except the maximum number of streams in a row, Composition Option and the Include all components/Select components options (see below) in the lower middle of the dialog box. A checkmark in the box next to the item label indicates that the property will be included in the stream databox. Those properties without a checkmark will not be included.

**Maximum number of streams in a row** – This value specifies how many streams or columns across the stream databox will be. If more streams are selected than this value, then CHEMCAD will "stack" the databox. Twelve is the default.

**Composition Option** – For a given stream databox the material balance may be presented in only one set of composition units (mole, mass, mole fractions, etc.). You may have as many stream databoxes as you like and they may include the same streams, but each individual databox will use only one set of units. To select which is to be used for this databox open the options list by clicking the small triangle to the right of the current selection. A list of available options will open. You can make your selection by clicking on it or by moving the highlight with the arrow keys and pressing the [Enter] key when the desired option is highlighted.

**Include all components/Select components** – Choose from one of these options by clicking the small circle next to the label. If you choose the Include all components option, then all components in the component list for this flowsheet will be included in this stream databox where the heat and material balance is given. If you choose Select components then when you close the Databox Properties Options dialog box, the Select PFD components dialog box will appear to enable you to make your component selections. In the default all of the components are included.

When all selections have been made, click [OK] and the DataBox Settings dialog box will appear.
STEP 3: COMPLETE THE DATABOX SETTINGS DIALOG BOX

The Data Box Settings dialog box looks like this:

![Data Box Settings Dialog Box](image)

When all selections have been made, click the [OK] button to close the dialog box. The specified stream databox will appear on the PFD in the upper left-hand corner. You will now need to move it to the desired location and stretch it to the desired size.

STEP 4: MOVE AND STRETCH THE DATABOX

The stream databox is a Windows object and therefore is moved and stretched like any other Windows object. Therefore,

**To move the databox** move the cursor over the databox and press the left button on the mouse. While holding the left button down, slide the mouse around. The databox will move with the mouse. In this fashion, move the databox to its desired location.

**To stretch the databox** move the cursor over the databox and press the left button on the mouse once. This is called selecting the object (databox) and when you do it four little, black squares will appear, one at each corner of the object (databox). To resize or stretch the databox, move your cursor so that the tip of the arrow (cursor) is directly over one of these little, black squares. Then, while holding down the left button, slide the mouse around. The databox will change size and aspect ratio as you do this. In this fashion enlarge or shrink the databox to the size you want.

ADDING A UNITOP DATABOX TO A PFD

Clicking the UnitOp Box option on the Format menu will initiate a three-step process for placing a customized UnitOp databox on the PFD. These steps are:

- Select the UnitOps for which you want to generate a databox. An individual databox will be generated for each UnitOp selected.
- Select the databox display settings.
- Move and size the databox as desired.
STEP 1: SELECT THE UNITOPS FOR DATABOX GENERATION

The Select Unit Operations dialog box looks like this:

![Select Unit Operations dialog box](image)

Select units from flowsheet - Selecting the Select units from flowsheet option will call the Select UnitOps dialog box. UnitOps may then be selected by clicking on them with the cursor, and/or by typing their ID No. Only the selected UnitOps will be included in the UnitOps databox.

If the Select Units from flowsheet option is not chosen, then streams may be selected by typing the desired UnitOp ID Nos. directly into the fields provided under Enter the Unit ID Nos.

When all of the Wordpad windows have been closed, the program will proceed by opening the Data Box Settings dialog box.

Click [OK] when the desired UnitOps have been identified. The Data Box Settings dialog box will then appear.

STEP 2: COMPLETE THE DATABOX SETTINGS DIALOG BOX

The Data Box Settings dialog box looks like this:
**Font style** – Choose from Regular, Bold, Italic or Italic Bold.

**Size** – Specify the font size. Default is 5.

**Section divider** – Controls placing of horizontal and vertical lines as dividers in the databox.

When all selections have been made, click the [OK] button to close the dialog box. The specified UnitOp databox(s) will appear on the PFD in the upper left-hand corner. You will now need to move it (them) to the desired location(s) and stretch it to the desired size(s). Please note that if more than one databox was generated, initially they will be laid on top of each other. Separate them by dragging the “top” one off the others.

**STEP 3: MOVE AND STRETCH THE DATABOX**

The UnitOps databox is a Windows object and therefore is moved and stretched like any other Windows object. Therefore,

**To move the databox** move the cursor over the databox and press the left button on the mouse. While holding the left button down, slide the mouse around. The databox will move with the mouse. In this fashion, move the databox to its desired location.

**To stretch the databox** move the cursor over the databox and press the left button on the mouse once. This is called selecting the object (databox) and when you do it four little, black squares will appear one at each corner of the object (databox). To resize or stretch the databox, move your cursor so that the tip of the arrow (cursor) is directly over one of these little, black squares. Then, while holding down the left button, slide the mouse around. The databox will change size and aspect ratio as you do this. In this fashion enlarge or shrink the databox to the size you want.

**ADDING A TP BOX TO A PFD**

Clicking the Add TP Box option on the Format menu will initiate the process for placing customized temperature, pressure, and/or flowrate boxes on the flowsheet for selected stream(s). The steps to add a TP box are:

- Decide if you want the TP boxes generated for all streams or selected streams on the flowsheet.
- Select the T, P, and/or F options (and their formats) which you want displayed on the PFD.
- Select streams for TP boxes (unless *generate boxes for all streams* was chosen).
- Move the TPF boxes as desired.

**SELECT OPTIONS TO DISPLAY**
The **TP Box Setting** dialog box is shown below

- **Generate boxes for all streams** (default)
- **Select streams from flowsheet**

If you select *generate boxes for all streams* then the TPF boxes will appear on all streams and step two below will be skipped.

If you click on the second option, then when you close the current dialog box a **Select Stream** dialog box will appear and you can select only those streams on which you want the TPF boxes to appear.

**Display**
Choose from temperature, pressure, mole flowrate, or mass flowrate. The selected option will be displayed in the TP box on the flowsheet.

**Number Format**
Select which format is to be used in the TPF Boxes. Options are Fixed Point, Scientific Notation, or Floating Point.

**Digits**
Specify the number of decimal places to be used in the display of each number.

**Font Style**
Choose from Regular, Bold, Italic, or Italic Bold.

**Font Size**
Specify font size. The default is 6 points.
Display Units

This allows the user to toggle on and off the engineering units in which each value is displayed.

Stream ID’s

Includes the stream ID in the TPF box.

SELECT STREAMS FROM FLOWSHEET

If the options Select Streams… was chosen (above), when the user presses OK a select streams dialog will appear. Left click on the stream lines or type the desired stream numbers and press OK.

MOVE THE TP BOXES AS DESIRED

After the TP box(es) are placed on the flowsheet, they may be dragged and moved as desired.

RUNNING A DYNAMIC SIMULATION

In order to run in the dynamics mode in CHEMCAD, you must own a license for a dynamic unit operation (CC-ReACS or CC-DCOLUMN)

The CHEMCAD Suite contains a library of the following dynamic unit operations:

Batch reactor
Dynamic Column (SCDS, TPLS, TOWR)
Tank
Time switch
Dynamic vessel
Time delay
Control valve
PID controller
Ramp controller

Any CC-STEADY STATE UnitOp can be run in the dynamic mode. Doing this may or may not make sense depending on how you set up the problem. Implicit in using a steady-state UnitOp in a dynamic flowsheet is the assumption that the dynamics of that UnitOp are very fast.

Notes: 1. For a description of the dynamic UnitOps, refer to the on-line manual.
2. Although the batch distillation module performs a dynamic calculation, it is currently set up to run in the steady-state mode only.

THE STEPS FOR SETTING UP A DYNAMIC FLOWSHEET...

For the description given below, no attempt is made to duplicate material covered elsewhere in this manual. Instead, reference is made to other sections for more detailed descriptions whenever possible.

The steps for setting up a dynamic flowsheet are:
1. Start a new job
2. Select engineering units
3. Draw the flowsheet
4. Make sure the “dynamic mode” has been turned on
5. Select components
6. Select thermodynamics options
7. Specify feed streams and initial stream conditions
8. Specify UnitOps
9. Specify runtimes, time steps, and/or stop criteria
10. Run the simulation
11. Review the results with RESULTS and PLOT
12. Re-run the simulation or extend the run from the current simulation time
13. Generate reports

These steps are described below.

**STARTING A NEW JOB**

Refer to sections:

- How to Start a New Job
- CHEMCAD Tutorial for Windows: Starting a New Job
- CC-BATCH Tutorial: Starting a New Job

**SELECTING ENGINEERING UNITS**

Refer to sections:

- How to Select Flowsheet Engineering Units
- CHEMCAD Tutorial for Windows: Selecting Engineering Units
- CC-BATCH Tutorial: Selecting Engineering Units

**DRAW THE FLOWSHEET**

Dynamics flowsheets are drawn exactly the same way that steady-state flowsheets are drawn. Please note however, that not all dynamic UnitOps have to have inlets and outlets. They can accumulate.

For instructions on how to draw flowsheets in CHEMCAD, please refer to sections:

- How to Draw a Flowsheet
- Graphics in CHEMCAD – An Overview
- How to Add UnitOps to the Flowsheet
- Drawing Streams
How to Move, Modify, Delete, or Duplicate Objects

CHEMCAD Tutorial for Windows: Drawing the Flowsheet
CC-BATCH Tutorial: Drawing the Flowsheet

MAKE SURE THE DYNAMICS MODE IS TURNED ON

This is done on the Convergence dialog box under the Run command on the main menu bar. Sometimes the program turns it on automatically based on the presence of certain dynamic UnitOps.

Procedure:

1. Click the Run command on the main menu bar. The following menu will appear:

2. Click the Convergence option at the top of the menu. The Convergence Parameters dialog box will appear:

3. In the lower right-hand corner of this dialog box is a combo box labeled Steady State/Dynamics. Open this box by clicking on it. The options Steady State and Dynamics will appear.

4. Click on the Dynamics option. The combo box will close and the word Dynamics will show.

5. Click the [OK] button to close the dialog box and save the selection.
SELECT COMPONENTS

Refer to sections:
- How to Select Components for the Components List
- CHEMCAD Tutorial for Windows: Selecting Components
- CC-BATCH Tutorial: Selecting Components

SELECT THERMODYNAMIC OPTIONS

Refer to sections:
- How to Select K-Value Options
- How to Select Enthalpy Options
- CHEMCAD Tutorial for Windows: Selecting Thermodynamic Options
- CC-BATCH Tutorial: Selecting Thermodynamic Options

SPECIFY FEED STREAMS AND STREAM INITIAL CONDITIONS

In a dynamic simulation, as in a steady state simulation, all feed streams must be defined. That means that the composition, flowrate, and thermodynamic properties (two of T, P, and VF) must be given. Sometimes the flowrate is reset by a control valve, during the simulation, but some flowrate must be given. As always, the program must know the composition and enthalpy at all times.

In addition to the feed streams, it is sometimes important to know the contents and conditions of the intermediate streams at time zero. You must also give these conditions when necessary.

Input for all streams is provided in the same way. For a description of this input procedure, refer to sections:
- How to Define the Feed Streams
- CHEMCAD Tutorial for Windows: Defining the Feed Stream
- CC-BATCH Tutorial: Defining the Feed Streams

SPECIFYING UNITOPS

Please refer to sections:
- Using Dialog Boxes
- How to Specify UnitOps
- CHEMCAD Tutorial for Windows: Inputting Equipment Parameters
- CC-BATCH Tutorial: Inputting Equipment Parameters

SPECIFYING RUNTIMES, TIME STEPS, AND/OR STOP CRITERIA

This function is performed using either the Dynamic Menu (on the Run Menu or the Set Run Time power button on the Toolbar.

This command is used to set the simulated time of the dynamics run and to specify the time step size (how often the flowsheet equations are integrated). These items must be specified for the calculation to proceed. Clicking this option will cause the following Set Simulation Run Time dialog box to be
displayed. For each operating step, this dialog box will have fields for the duration of the operating step, the number of time steps per operating step, and the stop criteria.

Please take note of the following:

1. More than one operating step can be specified. If a run is made from time zero (i.e., the initial state), all specified operating steps will be run. If the simulation is being run from the current state, then only those operating steps beyond the current time will be run.

   Operating steps can be added at any time, so this feature provides a facility for extending the dynamic simulation indefinitely.

2. The time stepsize is specified in the **Step size** field

3. The criteria for terminating one operating step and moving to the next one can be set by specifying elapsed time or the occurrence of some event in the flowsheet. The overall simulation time is then equal to the sum of the total simulation times for each step.

**RUNNING THE DYNAMIC SIMULATION**

Dynamic simulations are run from the **Dynamics menu**. The **Dynamics menu** is located on the **RUN menu** which is accessed by clicking the **Run** command on the **Top Level Menu Bar** of the **Simulate Flowsheet** window. Therefore, to get to the **Dynamics menu**, do the following:

1. Select the **Run** command from the menu bar. The **Run menu** will appear.

2. Click the **Dynamics** option on **Run menu**. The **Dynamics menu** will appear.

![Dynamics menu](image)

These options are explained below.

**EXIT:**

The **Exit** command is used to close the **Dynamics menu**.

**SET RUN TIME:**

Please refer to the section “Specifying Runtimes, time Steps, and/or Stop Criteria”

**RUN FROM INITIAL STATE:**

Selecting this option will cause the program to return to the initial conditions and rerun the entire simulation. All results from previous simulations will be discarded.
RUN FROM CURRENT:
Selecting this option will continue the simulation from the current state, i.e., from the last calculated result. In order to use this option, time beyond the current state must be scheduled on the Set runtime option above.

RESTORE TO INITIAL STATE:
This option will restore the initial conditions specified. All previous calculations will be discarded. It is necessary to exercise this option in order to change certain flowsheet variables. Once a simulation has taken place, CHEMCAD will not allow you to change any variables which might produce thermodynamic inconsistencies if the simulation is continued. Therefore, the restore command is necessary to enable changes to these variables.

RECORD STREAMS:
Unless specifically requested by the user, the dynamic history of streams is not saved by the program. Unsaved streams cannot be reported or plotted once the simulation is finished. The Record Stream dialog box is used to specify which streams are to be recorded or saved during the simulation. In addition, it is used to specify which streams are to be plotted or the computer screen during the simulation or "run time". The procedure for these specifications is as follows:

1. To specify that a stream is to be recorded, but not plotted during runtime, simply enter the stream 10 number in one of the labeled fields provided for this purpose. Then click the [OK] button.
2. To specify that a stream is to be plotted during runtime do the following:
   • Enter the stream (1) number in one of the fields provided;
   • Click on the Runtimeplot box next to the above field;
   • Click on the [OK] button. The Dynamic Streams Plot Options dialog box will appear.
   • Identify which variable(s) is to be plotted.
   • Click [OK]. If more than one stream is to be plotted during runtime, then another Dynamic Stream Plot Options dialog box will appear. One will appear for each stream requested. When the stream variables for all the requested streams have been selected, the program returns to the Dynamic Menu.

RECORD UNIT OPERATIONS:
Unless otherwise specified by you, CHEMCAD will only record the histories of batch reactors and dynamic columns. For all other UnitOp and streams, only the initial and final variable values are recorded. If you desire to view, plot, or report the historical results of these other UnitOps, then you must instruct the program to do so using the Record Unit Operations dialog box. In addition, this dialog box is used to specify which UnitOps are to be plotted during runtime. This procedure is similar to that described above for streams.

RECORD PROCESS:
This option will allow you to specify that the entire flowsheet be saved at intervals you specify on this screen.
SAVE AS INITIAL STATE:
This option will allow you to specify that the entire flowsheet be saved at current conditions. If you select this option, the original initial state conditions will be lost.

HELP:
This option will open the help facility for the dynamic menu.

Review the answers with the results and Plot commands

USING THE RESULTS COMMAND:
General use of the Results command is described elsewhere in sections listed below. However, notice should be taken of the following points when viewing dynamic results.

1. Clicking on the Results command on the menu bar will cause the Results menu to open. This menu contains a set of options for reviewing program output.

2. The answers for batch reactors can be reviewed using the Batch results and the Dynamic UnitOp History options.

3. Dynamic column results are reviewed using the Dynamic Column History option.

4. The answers for other dynamic unit operations are reviewed using the Dynamic UnitOp History command.

5. Stream histories are obtained using the Dynamic Stream History option.

6. The Unit Operations option can be used to produce a display of the input for a dynamic UnitOp. Certain calculated values, such as final temperature, final level, etc., will also be displayed.

7. The Streams option will display properties and composition of any stream at end of the simulation.

8. A UnitOp and stream histories can be obtained for only for recorded UnitOps and streams.

For explanations of how to use the Results command, please refer to the following sections:
How to Review Stream Properties
How to Review Stream Compositions
How to Set Flow Units for Results displays
CHEMCAD Tutorial for Windows: Reviewing the Results Interactively
CC-BATCH Tutorial: Reviewing the Results Interactively

USING THE PLOT COMMAND:
Stream histories and UnitOp histories are plotted using the Batch Reactor/DVSL History, Dynamic Column History, Dynamic Stream History, and UnitOp History options on the Plot menu. With the exception of batch reactors and dynamic columns, you must indicate to the program that a given stream or UnitOp is to be recorded before the simulation is run, otherwise the data will not be available to plot.

For an explanation of plotting dynamic streams and unit operations, see the section titled:

How to Plot: Plot Menu Options

Multiple variables can be simultaneously plotted, but it is up to you to keep the engineering units straight.

Upon closing the selection dialog box (by clicking [OK]), the plot will be displayed in a Plot Window. Using the editing facilities of this window, the plot can be modified as desired.

Multiple plot windows can be opened and tiled for simultaneous display if desired.

To close a plot, click the close button of the Plot window.

Unlike steady-state plots, tabulations of the numbers used to create the plot are not displayed in WordPad. To obtain these values, you must generate a history report using the OUTPUT/REPORT function, or you can send the plot values to EXCEL using the Graph\Data to EXCEL commands.

See also:

How to Plot
How to Generate a Report
CC-BATCH Tutorial – Plotting the Results

RE-RUNNING AND EXTENDING THE RUN

At the end of any dynamic simulation, CHEMCAD will know the following:

1. All of the numbers at time zero, i.e., the entire initial state.
2. All of the numbers at the ending time of the simulation, i.e., the entire final state.
3. The recorded numbers at each time in-between the initial and final states, i.e., selected portions of the intermediate states.

Dynamic runs can be made only from states or times that are completely known. Therefore, in CHEMCAD, dynamic runs can only be made from time zero or from the current state.

RE-RUNNING FROM TIME ZERO:
To rerun a simulation from time zero:
1. Restore to initial state using the **Restore to initial state** command on the **Dynamics menu** or on the Toolbar.

2. Make any desired changes to the initial state using the usual commands or on the Toolbar.

3. Rerun the simulation by clicking the **Run from Time Zero** command on the **Dynamics menu**.

**RUNNING FROM THE CURRENT TIME:**

To extend the simulation from the current state or time:

1. Open the **Runtime** dialog box by clicking the **Set runtime** command on the **Dynamics menu** or on the Toolbar.

2. Add 1 to the current number shown in the **No. of Operating Steps** field, and enter the result in this field. In other words, increment the number of operating steps by one.

3. Select the tab for the new operating step and complete the screen input in the same manner as previous operating steps.

4. Close the **Runtime** dialog box.

5. Click the option **Run from current time** on the **Dynamics menu** or on the toolbar. The simulation will begin.

You should note that some input changes can be made before extending the run. However, changes made to certain variables after time zero may create thermodynamic inconsistencies. To prevent this, CHEMCAD denies access to these variables unless the initial state has been restored.

Once the initial state has been restored, it is no longer possible to run from the current state.

**HOW TO RUN A SENSITIVITY ANALYSIS**

To run a sensitivity analysis you must call the **Sensitivity Analysis** menu, which looks like this:

![Sensitivity Analysis Menu]

The overall procedure for running a New Sensitivity Analysis is:

1. Select **Run** from the **Simulate Flowsheet** menu bar. The **Run** menu will appear.

2. Select the **Sensitivity** option from the **Run** menu. The **Sensitivity Analysis** menu will appear.

3. Select the **New Analysis** option. The **New Analysis** dialog box will appear.
4. Enter a name for the sensitivity analysis, then click [OK]. The following menu will appear;

5. Specify the parameter(s) to be varied by clicking the **Edit Independent Variable** and (if two independent variables are being used) the **Edit Independent Parameters** option and then completing the **Independent Variables** dialog box.

6. Specify the variables to be recorded by clicking the **Edit Recorded Variables** option and completing the **Recorded Variables** dialog box.

7. Select either the **Run** or the **Run Selected Units** option on the above menu. The normal calculation sequence will be initiated. Therefore, the program will now check the input data and display a message window if any warnings or errors exist.

8. Close the message window. If any errors are present, the calculation sequence will be terminated and you will be returned to the **Sensitivity Analysis** menu. If no errors were present, and you have activated the **Display trace window** on the **Convergence** dialog box, you will proceed to the **CHEMCAD Trace Window** and Step 9 below. If the **Display trace window** option has not been activated, the **CHEMCAD Trace Window** will not be displayed and you will proceed directly to the calculations and step 12 below. (Please note that if no errors or warnings are present, no message window will appear and this step will be skipped altogether).

9. Click the **Go** button. The sensitivity analysis will proceed and runtime messages will be sent to the screen as the calculation proceeds. When the analysis is finished, the message **Run finished** will appear at the bottom of the **CHEMCAD Trace Window**.

10. Using the elevator bar of the **CHEMCAD Trace Window** you may now browse the runtime messages if so desired. Click the **Close** button to close the **CHEMCAD Simulation Window**. You will be returned to the **Sensitivity Analysis** menu.

11. From the **Sensitivity Analysis** menu select **Plot Results**. The **Sensitivity Analysis-XY Plot** dialog box will appear.

12. The fields “**Plot Title**”, “**Title (continued)**”, “**X axis label**” and “**Y axis label**” are text fields providing labels for the plot. The combo-check box in the lower left-hand corner lists all of the dependent variables that were recorded during the sensitivity analysis calculations. The presence of a checkmark in the box next to a variable means it will be included on the plot.
Enter the labels and select the plot variables as desired. Then click [OK]. The plot will appear in a plot window.

13. Edit and print the plot as desired. Refer to:
   - "Using the Graphics Editing Window"
   - "How to Put Text on a Drawing or Plot"
   - "How to Move, Modify, Delete or Duplicate Objects"
   - "How to Print"
   - "Using the Toolbar Buttons"

14. When finished editing and printing, close the plot window (and therefore, the plot as well). You will be returned to the main CHEMCAD window.

COMPLETING THE INDEPENDENT VARIABLE DIALOG BOX

The Independent Variable dialog box allows the user to specify the independent variable, or, in the case where two independent variables exist, the first independent variable. The independent variable(s) will be varied over a range of values in a defined number of steps. Because CHEMCAD can only plot and report in two dimensions, no more than two independent variables are permitted in any given sensitivity analysis.

VARIABLE IDENTIFICATION:
The variable identification convention used throughout CHEMCAD is:

1. Identify if the variable is a stream variable or a UnitOp variable using a choice box.
   Click the appropriate circle to make a selection. The dot inside the circle indicates the current selection.

2. Enter the object ID. The object ID is the ID number of the stream or UnitOp. The object ID for stream number 4 is 4; the object ID for UnitOp number 2 is 2; etc. The object ID must be typed in.

3. Identify the Variable. Each stream or UnitOp has multiple variables associated with it. The user must identify which one is to be varied. Once the stream or UnitOp is identified in steps one and two above, CHEMCAD knows the correct variable list. When you click on the Variable field, this list will be displayed. You can then scroll the list, and select the proper option by clicking on it or by highlighting it and pressing the [Enter] key.

4. Identify the type of engineering units of this independent variable using the Variable Units field. In other words, if the variable is a temperature, you should select “temperature” on the Variable Unit list; if the variable is a pressure, you should select “pressure” from the Variable Unit list; etc. If this identification is not made, the program will assume the variable is in internal CHEMCAD units (ºR, psia, etc.)

5. In some cases the variable identified may involve a component. If so, identify which component in the Comp field. Click on the field. CHEMCAD will display a list of the components for the current job. Select from this list to close the field.

6. Give a Variable name. This step is optional. It provides a label for the plot.
VARY THIS VARIABLE FROM...TO...IN...EQUAL STEPS:
These three fields enable the user to identify how the independent variables are to be varied during a sensitivity analysis. You must specify the following variables:

- **From** the starting value for the x-axis variable.
- **To** the last value for the x-axis variable.
- **Steps** the number of points to be used. Five steps mean four intervals.

COMPLETING THE DEPENDENT VARIABLE DIALOG BOX
Dependent variables are variables whose values are calculated and recorded as the independent variable(s) is changed. Any stream or UnitOp variable can be a dependent variable.

Up to ten dependent variables can be tracked during a sensitivity analysis. To identify a dependent variable, click the appropriate dependent variable tab, and enter the Object, Object ID, variable number and variable engineering units. The procedure for this is outlined in "Variable Identification" in the section above. Then, if desired, make entries for the:

- **Scale Factors** this is a number by which the dependent variable is multiplied when it is plotted. This is normally used to display a given variable more (or less) prominently.
- **Label** this is text. The label is shown in the plot legend to identify the dependent variables.

USING OPTIMIZATION IN CHEMCAD

The **Optimization** option under the **Run** menu allows you to maximize or minimize a stream or unit operation variable (Objective Function) given certain independent variables and constraints.

**IMPORTANT NOTE:** Always make a backup copy of your job before beginning an optimization. This way, if the optimization introduces any instability or causes your flowsheet to stop converging, you still have a fully functional version of your job available.

When you first select the **Optimization** option, you will see the following screen:

The options on this screen are as follows:

**Exit** – leaves this menu and returns to CHEMCAD without performing an optimization.
Define Objective Function – this option allows you to specify which stream or unit operation variable you would like to minimize or maximize, and it brings up the following screen:

![Objective Function Screen]

The options on this screen are as follows:

- **Title** – give your function a title for plotting, etc.
- **Type** – specify whether the variable is for a stream or unit operation (Equipment)
- **Equip/Stream ID** – specify either the stream number or equipment number from the flowsheet
- **Variable No.** – specify the variable number that corresponds to the variable you wish to maximize or minimize. Obviously, this number is different for different pieces of equipment. Consult the online help in CHEMCAD to find the correct variable number
- **Variable Unit** – you must select the units that correspond to the variable you have selected
- **Object name** – give your objective function (variable) a name for plotting, etc.
- **Min/Max** – specify whether you want the function to be maximized or minimized
- **Scale** – specify a scale to be applied to your variable value, default = 1

Independent Variables – this option allows you to specify which variables CHEMCAD’s optimization can adjust to try to minimize or maximize your objective function. The following screen appears when this option is selected:
The options on this screen are as follows:

- **Page 1/Page 2/.../Page 5** – these options allow you to specify up to 10 independent variables (2 per page)

- **Type** – specify whether the variable is for a piece of equipment or a stream

- **Equip/Stream ID** – specify the stream or equipment number from the flowsheet

- **Variable No.** – specify the variable number that corresponds to the independent variable you wish to have CHEMCAD adjust. See CHEMCAD’s online help system for help finding the correct number(s)

- **Variable Unit** – specify from the drop down box what engineering units correspond to the variable specified

- **Initial Value** – specify the value to be used as the optimization begins

- **Perturb. Size** – specify the step size for the independent variable (used for calculating the next value of the objective function)

- **Variable name** – give your variable a name used for reporting, plotting, etc.

- **Variable range /Value 1/Value 2** – You have the following options here:
  i. **Unconstrained** – no constraints to the value of this variable
  ii. **Value 1 <= X <= Value 2** – the variable must stay greater than or equal to Value 1, but less than or equal to Value 2
iii. $X \leq \text{Value 1}$ – the variable must be less than or equal to Value 1  
iv. $X \geq \text{Value 1}$ – the variable must be greater than or equal to Value 1  
v. $X = \text{Value 1}$ – use this option to fix the variable at Value 1

**Constraints** – this allows you to specify that up to 10 dependent variables to be constrained. When you select this option, the following screen appears:

![Dependent Variable Constraints Screen](image)

The options on this screen are as follows:

- **Page 1/Page 2/.../Page 5** – these options allow you to specify up to 10 dependent variable constraints (2 per page)
- **Type** – specify whether the variable is for a piece of equipment or a stream
- **Equip/Stream ID** – specify the stream or equipment number from the flowsheet
- **Variable No.** – specify the variable number that corresponds to the dependent variable you wish to constrain. See CHEMCAD’s online help system for help finding the correct number(s)
- **Variable Unit** – specify from the drop down box what engineering units correspond to the variable specified
- **Variable name** – give your variable a name used for reporting, plotting, etc.
- **Variable range /Value 1/Value 2** – You have the following options here:
  i. **Unconstrained** – no constraints to the value of this variable  
  ii. $\text{Value 1} \leq X \leq \text{Value 2}$ – the variable must stay greater than or equal to Value 1, but less than or equal to Value 2
iii.  \( X \leq \text{Value 1} \) – the variable must be less than or equal to Value 1
iv.  \( X \geq \text{Value 1} \) – the variable must be greater than or equal to Value 1
v.  \( X = \text{Value 1} \) – use this option to fix the variable at Value 1

**Settings** – This option allows you to specify miscellaneous optimization options. The following screen appears when you select this option:

![Control Parameters](image)

The options on this screen are as follows:

- **Print level** – you may specify the level of detail generated in the report. With no entry, the default is 0, but you may enter a number 0 to 4, 4 being the highest level of detail.
- **Iterations** – Enter the highest number of iterations for CHEMCAD to try before stopping.
- **Tolerance** – Enter the tolerance for the objective function solution.
- **Derivatives** – you have the following options here
  - **Forward differences** – When calculating the slope of the function, you may have CHEMCAD use forward differences (calculate one forward point, then use the slope of the line between it and the current point)
  - **Central differences** – Alternatively, CHEMCAD can use one forward point and one backward point, and then use the slope of the line between those two points. This method is obviously slightly slower, but can be more accurate.

**Define Calculation Sequence** – This option allows the user to specify his/her own calculation sequences to be performed during the optimization.

**Perform Optimization** – Select this option when you have specified all of the information in the above screens and are ready to have CC-STEADY STATE perform the optimization. Once CC-STEADY STATE has found a solution or has reached the number of iterations you specified without a solution, a report will be generated and sent to Wordpad.
HOW TO BUILD USER ADDED SYMBOLS AND ICONS

CHEMCAD provides a utility called Symbol-Builder, which is used to build and save user added symbols and icons. Symbol-Builder is called by clicking on the Edit command on the menu bar. The Edit Menu will appear. At the bottom of the menu is the Symbol Builder command. Click on it and the following window will open:

There are nine commands on the menu bar. These are:

- **File** – For file management and printing.
- **Edit** – Provides the Undo, Redo, Cut, Copy, Paste and Select All commands. Also provides object manipulation commands.
- **View** – Turns the Toolbar, Status Bar, and Palette on and off. Also provides commands for controlling the grid, page bounds and zoom features.
- **Structure** – Groups and ungroup objects, and sends objects forward and back.
- **Align** – Provides a wide range of object alignment options.
• **Graphics** – Allows settings of fill patterns, pen size, arrow direction, etc.

• **Palette** – Opens, creates, and saves UnitOp and symbol palettes. Also controls the dimensions of the **CC-Build** palette.

• **Window** – Controls the display of open windows.

• **Help** – Provides access to the CHEMCAD help system.

These commands along with the palette provide the tools from building and saving icons and symbols.

**SYMBOL BUILDER PALETTE**

The CC-Build palette is the primary tool for the creation of icons and symbols. The palette has eleven squares each of which provides a graphics or icon creation function. These functions are:

- The rotation function will rotate any graphics object through any angle.
- The rectangle function draws rectangles and squares.
- The ellipse function draws circles and ellipses.
- The multiline function draws a series of connected lines.
- The polygon function draws single segment lines.
- The inlet function creates stream inlet points on UnitOp icons. Stream inlet points are the locations of inlet streams.
- The outlet function creates stream outlet points on UnitOp icons. Stream outlet points are the locations of outlet streams.
- The text function puts lines of text on the icon or symbol.

Use of the rotation, rectangle, ellipse, line, multiline, polygon, and text functions are described in the following sections of this User’s Guide:

- “Drawing with the Palette”
- “How to rotate an object using the Palette”
- “How to place text on a drawing”
- “The Main Palette”

Use of the inlet, outlet, and link commands are in the next section.
PROCEDURE FOR BUILDING AND SAVING UNITOP ICONS

The following procedure describes how to build UnitOp icons:

1. **Open Symbol Builder**
   
   To open CC5 Symbol Builder; click the **Symbol Builder** command on the **Edit Menu**.

2. **Start with the symbol from CHEMCAD** (If you wish to start from scratch, skip to #3):
   
   If you want to start with one of our “Standard” icons here’s how. Using the File->Open menu option, open up the symbols directory. The symbols directory is located in the CC5\Import directory. So if CHEMCAD is installed on your **C:** drive, the path will be **C:\CC5\import\symbols**.

   Once you have the symbol open, save it to your cc5data directory (**C:\CC5DATA** usually)

   Now you can make changes to the symbol.

3. **Draw or edit the symbol for the unit operation.**
   
   Using the rotation, rectangle, ellipse, line, multiline, polygon and text functions on the palette, create the graphics portion of the icon. Other commands from the menu bar are also for this purpose.

   These commands include:

   - The **Fill Pattern**, **Pen Style**, **Arrowheads**, **Color**, **Font**, and **Import Bitmap** commands located on the **Graphics menu**. Click the **Graphics** command on the menu bar to access them. A description of these commands is provided in **“The Format Command”** section of this User’s Guide.
   
   - The **Align** command is useful for properly positioning objects.
   
   - The **Flip Horizontal**, **Flip Vertical**, **90 Clockwise**, and **90 Counter-clockwise** commands located on the **Edit menu** are also useful for positioning and orienting objects. A description of these commands is given in the **“How to Move, Modify, Delete and Flip Objects”** section of this User’s Guide.

   - The **Grid Visible** and **Snap to Grid** commands on the **View menu** assist in positioning objects.
   
   - The **Bring to Front** and **Send to Back** commands on the **Structure menu** enable you to properly lay one object on top of another.

4. **Position the stream inlet and outlet points on the boundaries of the icon.**

   To place a stream inlet on the icon:

   - Click on the inlet square on the palette.
   
   - Point to the desired inlet location.
   
   - Press the left mouse button once.

   The inlet symbol will appear at the designated location and an “inlet number” will be assigned to it. Numbers are assigned in the order of inlet placement starting from one.

   Outlet points are placed in a similar way.
5. Group the individual objects into a single object.

The UnitOp icon is created by grouping the individual circles, lines, squares, inlets, outlets, etc., into a single object. To do this:

- Select all of the objects to be included in the icon by drawing a rectangle around it. To do this, first point to one corner of the rectangle. Then, while keeping the left mouse button depressed, move the cursor to the opposite corner of the rectangle. Finally, release the mouse button. All objects within the rectangle will be selected. This will be indicated by the presence of small, black selection boxes at the corners of each selected object.
- Click on the Structure command on the menu bar. The Structure menu will open.
- Click on the Group command on the Structure menu. The original selection boxes (around the individual objects) will disappear and four new selection boxes will appear at the corners of the grouped object. The UnitOp icon has been created.

6. Save the icon as a symbol (sym) file.

The icon must be saved as a symbol file before it can be inserted into the palette. The save procedure is:

- Click the File command on the menu bar. The File menu will open.
- Select the Save as… option from the File menu. The Save As dialog box will open.
- Choose a name for the icon. This name must have a .sym extension. Type this name into the File name: field of the dialog box.
- Click the [Save] button. The dialog box will close and a file called <filename>.sym will be saved.

7. Save the symbol to a UnitOp [sub]palette.

The procedure for this is:

- Click on the Palette command on the menu bar. The Palette menu will open.
- Select the Insert as CHEMCAD palette command on the Palette menu. The Select Unit Operation type dialog box will appear.
- Select the unit operation type for this icon and click [OK]. The user added sub-palette for this Unit Operation will be displayed; the symbol you created will be on this palette. The icon is assigned the mathematical model for the unitop that you chose in this step.

The UnitOp is now a part of the CHEMCAD Suite. The next time you call the sub-palette for this UnitOp, your icon will appear.
### USER ADDED PALETTE NAMES

<table>
<thead>
<tr>
<th>1. controller</th>
<th>ucontroller_01.dis</th>
<th>Small palette</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ucontroller_02.dis</td>
<td>medium palette</td>
</tr>
<tr>
<td></td>
<td>ucontroller_03.dis</td>
<td>large palette</td>
</tr>
<tr>
<td>2. compressor</td>
<td>ucompressor_01.dis</td>
<td>small palette</td>
</tr>
<tr>
<td></td>
<td>ucompressor_02.dis</td>
<td>medium palette</td>
</tr>
<tr>
<td></td>
<td>ucompressor_03.dis</td>
<td>large palette</td>
</tr>
<tr>
<td>3. divider</td>
<td>udivider_01.dis</td>
<td>small palette</td>
</tr>
<tr>
<td></td>
<td>udivider_02.dis</td>
<td>medium palette</td>
</tr>
<tr>
<td></td>
<td>udivider_03.dis</td>
<td>large palette</td>
</tr>
<tr>
<td>4. extractor</td>
<td>uextractor_01.dis</td>
<td>small palette</td>
</tr>
<tr>
<td></td>
<td>uextractor_02.dis</td>
<td>medium palette</td>
</tr>
<tr>
<td></td>
<td>uextractor_03.dis</td>
<td>large palette</td>
</tr>
<tr>
<td>5. feed</td>
<td>ufeed_01.dis</td>
<td>small palette</td>
</tr>
<tr>
<td></td>
<td>ufeed_02.dis</td>
<td>medium palette</td>
</tr>
<tr>
<td></td>
<td>ufeed_03.dis</td>
<td>large palette</td>
</tr>
<tr>
<td>6. fired_heater</td>
<td>ufired_heater_01.dis</td>
<td>small palette</td>
</tr>
<tr>
<td></td>
<td>ufired_heater_02.dis</td>
<td>medium palette</td>
</tr>
<tr>
<td></td>
<td>ufired_heater_03.dis</td>
<td>large palette</td>
</tr>
<tr>
<td>7. flash</td>
<td>uflash_01.dis</td>
<td>small palette</td>
</tr>
<tr>
<td></td>
<td>uflash_02.dis</td>
<td>medium palette</td>
</tr>
<tr>
<td></td>
<td>uflash_03.ds</td>
<td>large palette</td>
</tr>
<tr>
<td>8. gibs_reactor</td>
<td>ugibs_reactor_01.dis</td>
<td>small palette</td>
</tr>
<tr>
<td></td>
<td>ugibs_reactor_02.dis</td>
<td>medium palette</td>
</tr>
<tr>
<td></td>
<td>ugibs_reactor_03.dis</td>
<td>large palette</td>
</tr>
<tr>
<td>9. heat_exchanger</td>
<td>uheat_exchanger_01.dis</td>
<td>small palette</td>
</tr>
<tr>
<td></td>
<td>uheat_exchanger_02.dis</td>
<td>medium palette</td>
</tr>
<tr>
<td></td>
<td>uheat_exchanger_03.dis</td>
<td>large palette</td>
</tr>
<tr>
<td>10. kinetic_reactor</td>
<td>ukinetic_reactor_01.dis</td>
<td>small palette</td>
</tr>
<tr>
<td></td>
<td>ukinetic_reactor_02.dis</td>
<td>medium palette</td>
</tr>
<tr>
<td></td>
<td>ukinetic_reactor_03.dis</td>
<td>large palette</td>
</tr>
<tr>
<td>11. mixer</td>
<td>umixer_01.dis</td>
<td>small palette</td>
</tr>
<tr>
<td></td>
<td>umixer_02.dis</td>
<td>medium palette</td>
</tr>
<tr>
<td></td>
<td>umixer_03.dis</td>
<td>large palette</td>
</tr>
<tr>
<td>12. pid_controller</td>
<td>upid_controller_01.dis</td>
<td>small palette</td>
</tr>
<tr>
<td></td>
<td>upid_controller_02.dis</td>
<td>medium palette</td>
</tr>
</tbody>
</table>
13. product
| upid_controller_03.dis | large palette |
| upproduct_01.dis | small palette |
| upproduct_02.dis | medium palette |
| upproduct_03.dis | large palette |

14. pump
| upump_01.dis | small palette |
| upump_02.dis | medium palette |
| upump_03.dis | large palette |

15. scds_column
| uscds_column_01.dis | small palette |
| uscds_column_02.dis | medium palette |
| uscds_column_03.dis | large palette |

16. solid_washer
| usolid_washer_01.dis | small palette |
| usolid_washer_02.dis | medium palette |
| usolid_washer_03.dis | large palette |

17. stoichimetric
| ustoichimetric_01.dis | small palette |
| ustoichimetric_02.dis | medium palette |
| ustoichimetric_03.dis | large palette |

18. stream_reference
| ustream_reference_01.dis | small palette |
| ustream_reference_02.dis | medium palette |
| ustream_reference_03.dis | large palette |

19. tower
| utower_01.dis | small palette |
| utower_02.dis | medium palette |
| utower_03.dis | large palette |

20. vacuum_filter
| uvacuum_filter_01.dis | small palette |
| uvacuum_filter_02.dis | medium palette |
| uvacuum_filter_03.dis | large palette |

21. valve
| uvalve_01.dis | small palette |
| uvalve_02.dis | medium palette |
| uvalve_03.dis | large palette |

22. vessel
| uvessel_01.dis | small palette |
| uvessel_02.dis | medium palette |
| uvessel_03.dis | large palette |

23. component_separator
| ucomponent_separator_01.dis | small palette |
| ucomponent_separator_02.dis | medium palette |
| ucomponent_separator_03.dis | large palette |

24. tower_plus
<p>| utower_plus_01.dis | small palette |
| utower_plus_02.dis | medium palette |
| utower_plus_03.dis | large palette |</p>
<table>
<thead>
<tr>
<th>Number</th>
<th>Object Name</th>
<th>Small Palette File</th>
<th>Medium Palette File</th>
<th>Large Palette File</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>dynamic_vessel</td>
<td>udynamic_vessel_01.dis</td>
<td>udynamic_vessel_02.dis</td>
<td>udynamic_vessel_03.dis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>small palette</td>
<td>medium palette</td>
<td>large palette</td>
</tr>
<tr>
<td>26</td>
<td>baghouse_filter</td>
<td>ubaghouse_filter_01.dis</td>
<td>ubaghouse_filter_02.dis</td>
<td>ubaghouse_filter_03.dis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>small palette</td>
<td>medium palette</td>
<td>large palette</td>
</tr>
<tr>
<td>27</td>
<td>batch_column</td>
<td>ubatch_column_01.dis</td>
<td>ubatch_column_02.dis</td>
<td>ubatch_column_03.dis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>small palette</td>
<td>medium palette</td>
<td>large palette</td>
</tr>
<tr>
<td>28</td>
<td>batch_reactor</td>
<td>ubatch_reactor_01.dis</td>
<td>ubatch_reactor_02.dis</td>
<td>ubatch_reactor_03.dis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>small palette</td>
<td>medium palette</td>
<td>large palette</td>
</tr>
<tr>
<td>29</td>
<td>calculator</td>
<td>ucalculator_01.dis</td>
<td>ucalculator_02.dis</td>
<td>ucalculator_03.dis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>small palette</td>
<td>medium palette</td>
<td>large palette</td>
</tr>
<tr>
<td>30</td>
<td>centrifuge</td>
<td>ucentrifuge_01.dis</td>
<td>ucentrifuge_02.dis</td>
<td>ucentrifuge_03.dis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>small palette</td>
<td>medium palette</td>
<td>large palette</td>
</tr>
<tr>
<td>31</td>
<td>control valve</td>
<td>Ucontrol_valve_01.dis</td>
<td>Ucontrol_vavle_02.dis</td>
<td>Ucontrol_vavle_03.dis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>small palette</td>
<td>medium palette</td>
<td>large palette</td>
</tr>
<tr>
<td>32</td>
<td>crusher_grinder</td>
<td>ucrusher_grinder_01.dis</td>
<td>ucrusher_grinder_02.dis</td>
<td>ucrusher_grinder_03.dis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>small palette</td>
<td>medium palette</td>
<td>large palette</td>
</tr>
<tr>
<td>33</td>
<td>crystallizer</td>
<td>ucrysallizer_01.dis</td>
<td>ucrysallizer_02.dis</td>
<td>ucrysallizer_03.dis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>small palette</td>
<td>medium palette</td>
<td>large palette</td>
</tr>
<tr>
<td>34</td>
<td>cyclone</td>
<td>ucyclone_01.dis</td>
<td>ucyclone_02.dis</td>
<td>ucyclone_03.dis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>small palette</td>
<td>medium palette</td>
<td>large palette</td>
</tr>
<tr>
<td>35</td>
<td>electro_precipitator</td>
<td>uelectro_precipitator_01.dis</td>
<td>uelectro_precipitator_02.dis</td>
<td>uelectro_precipitator_03.dis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>small palette</td>
<td>medium palette</td>
<td>large palette</td>
</tr>
<tr>
<td>36</td>
<td>equilibrium</td>
<td>uequilibrium_01.dis</td>
<td>uequilibrium_02.dis</td>
<td>uequilibrium_03.dis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>small palette</td>
<td>medium palette</td>
<td>large palette</td>
</tr>
<tr>
<td>37</td>
<td>expander</td>
<td>uexpander_01.dis</td>
<td>uexpander_02.dis</td>
<td>uexpander_03.dis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>small palette</td>
<td>medium palette</td>
<td>large palette</td>
</tr>
<tr>
<td>ID</td>
<td>Component</td>
<td>File Name</td>
<td>Palette</td>
<td></td>
</tr>
<tr>
<td>----</td>
<td>--------------------</td>
<td>---------------------------</td>
<td>---------------</td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>hydrocyclone</td>
<td>uhydrocyclone_01.dis</td>
<td>small palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>uhydrocyclone_02.dis</td>
<td>medium palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>uhydrocyclone_03.dis</td>
<td>large palette</td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>LLV_flash</td>
<td>ullv_flash_01.dis</td>
<td>small palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ullv_flash_02.dis</td>
<td>medium palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ullv_flash_03.dis</td>
<td>large palette</td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>LNGH</td>
<td>ulng_01.dis</td>
<td>small palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ulng_02.dis</td>
<td>medium palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ulng_03.dis</td>
<td>large palette</td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>loop</td>
<td>uloop_01.dis</td>
<td>small palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>uloop_02.dis</td>
<td>medium palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>uloop_03.dis</td>
<td>large palette</td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>phase_generator</td>
<td>uphase_generator_01.dis</td>
<td>small palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>uphase_generator_02.dis</td>
<td>medium palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>uphase_generator_03.dis</td>
<td>large palette</td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>pipe</td>
<td>upipe_01.dis</td>
<td>small palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>upipe_02.dis</td>
<td>medium palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>upipe_03.dis</td>
<td>large palette</td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>ramp_control</td>
<td>uramp_control_01.dis</td>
<td>small palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>uramp_control_02.dis</td>
<td>medium palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>uramp_control_03.dis</td>
<td>large palette</td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>recorder</td>
<td>urecorder_01.dis</td>
<td>small palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>urecorder_02.dis</td>
<td>medium palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>urecorder_03.dis</td>
<td>large palette</td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>screen</td>
<td>uscreen_01.dis</td>
<td>small palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>uscreen_02.dis</td>
<td>medium palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>uscreen_03.dis</td>
<td>large palette</td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>sedimentator</td>
<td>usedimentator_01.dis</td>
<td>small palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>usedimentator_02.dis</td>
<td>medium palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>usedimentator_03.dis</td>
<td>large palette</td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>shortcut_column</td>
<td>ushortcut_column_01.dis</td>
<td>small palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ushortcut_column_02.dis</td>
<td>medium palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ushortcut_column_03.dis</td>
<td>large palette</td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>solids_dryer</td>
<td>usolids_dryer_01.dis</td>
<td>small palette</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>usolids_dryer_02.dis</td>
<td>medium palette</td>
<td></td>
</tr>
</tbody>
</table>
50. tank
usolids_dryer_03.dis  large palette
utank_01.dis  small palette
utank_02.dis  medium palette
utank_03.dis  large palette

51. time_delay
utime_delay_01.dis  small palette
utime_delay_02.dis  medium palette
utime_delay_03.dis  large palette

52. time_switch
utime_switch_01.dis  small palette
utime_Switch_02.dis  medium palette
utime_switch_03.dis  large palette

53. venturi_scrubber
uventuri_scrubber_01.dis  small palette
uventuri_scrubber_02.dis  medium palette
uventuri_scrubber_03.dis  large palette

54. addx
uaddx_01.dis  small palette
uaddx_02.dis  medium palette
uaddx_03.dis  large palette